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About This Guide
SUPPORT AND INFORMATION

For assistance, please contact us via any of these methods:

Internet Web Site: www.telestream.net

Technical Support: support@telestream.net

Licensing. license@telestream.net
Sales and Marketing: info@telestream.net

USA Telephone Main: 1 530 470-1300

USA Customer Support: (530) 470-1336

Support Services. (877) 257-6245 from 6 am to 6 pm weekdays, 
excluding U. S. holidays. Terms and times of support services vary, based 
on the terms of your current service contract with Telestream.

Mail Telestream, Inc. 
Suite 1
848 Gold Flat Road-Suite 1
Nevada City, CA. USA 95959

International See our Web site for your regional authorized Telestream distributor.

HOW TO USE THIS GUIDE

This guide is intended for digital media professionals who manage Media 
Application Platform in their organization, or who configure, manage and 
monitor MAP services and programs or use MAP to produce, store, and 
access media in a media production environment.
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You may view or print this guide with Adobe Acrobat Reader, available 
on Adobe's Web site at www.adobe.com. Online Help is available in each 
MAP program by clicking the Help icon on the program's toolbar.

In addition to a table of figures and tables, glossary and index, this guide 
contains the following sections:

Chapter 1, Introduction
This chapter introduces Telestream’s Media Application Platform and its 
products, and provides a high level view of MAP functionality and the 
main MAP services and clients. This chapter also describes each 
component of MAP and how MAP can be used by third-party programs.

Chapter 2, Up & Running
If you have purchased a pre-installed MAPreview system, you can use 
this chapter to configure the hardware for your network and configure 
MAPreview to get it up and running quickly.

Chapter 3, Installing MAP Services, Clients, & Utilities
This chapter provides installation procedures for installing MAP services, 
management consoles, and client programs in a single- or multi-server 
installation, including attaching a MAP dongle. This chapter also 
provides installation procedures for MAP utilities.

Chapter 4, MAP Services Configuration & Administration
This chapter helps you perform basic up and running configuration and 
administrative tasks, including initial configuration of each MAP service.

Chapter 5, MAP Administration
This chapter provides step-by-step instructions for performing ongoing 
MAP configuration and administrative tasks.

Chapter 6, Web Access, HyperLaunch Receive Server, 
Gateway
This chapter provides MAP administrators step-by-step instructions for 
configuring MAP for publishing MAP media via IIS, Windows Media 
Server and SharePoint, and for configuring and managing HyperLaunch 
Receive Server and Gateway.MAP.

Chapter 7, MAP System Planning Guide
This chapter provides the information you need to plan and implement a 
multi-server MAP installation. In this chapter, you'll also review the 
hardware and software platform requirements for MAP services and 
client programs, so that you can audit your servers and upgrade or 
purchase properly configured servers for your system.
About-2 May 2008
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Chapter 8, Upgrading, Repairing, and Uninstalling MAP
This chapter provides step-by-step instructions for upgrading, repairing, 
and uninstalling MAP.

Appendix A, Troubleshooting MAP
Use this appendix to identify likely causes for problems you may 
encounter when using MAP services and client programs.

Appendix B, Application Notes
This appendix provides application notes for MAP in a variety of 
operational environments.

Appendix C, Metadata Tools
This appendix describes metadata analysis and extraction tools.

Appendix B, Media Formats
This appendix specifies each media format supported by MAP, including 
movie, audio and video codec specifications, and application notes.

Appendix C, Destinations
This appendix describes destinations to which you can deliver media from 
MAP, via a variety of network protocols.

NOTATIONAL CONVENTIONS

The following sections describe notational conventions used to make the 
guide more readable.

Notes, Tips, and 
Cautions

Note paragraphs are set in italic type to draw your attention to special 
circumstances: 

Note
Text associated with this graphic highlights important information 
about the topic you’re studying. Be sure to read this information before 
continuing.
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Tip paragraphs provide helpful information you may not be aware of, or 
that may make using MAP easier: 

Caution paragraphs are set in bold type to draw your attention to 
situations that may cause permanent changes to your operating system or 
cause data loss.

TYPOGRAPHICAL CONVENTIONS

Certain typographical conventions are used as visual clues in this guide. 
Sample information, or a specific format to be entered by you is shown in 
italics, or in a courier-style font.

For example: 
Type your domain (mydomain.com) in the domain field.
Type import FileName where FileName is the fully qualified path.

WE'D LIKE TO HEAR FROM YOU!

If you have comments or suggestions about improving this document, 
other Telestream documents, or our Web site – or if you've discovered an 
error or omission, please email us at support@telestream.net.

Tip
Tips are bits of information you might not be aware of, or that make 
using MAP easier.

Caution
A caution paragraph indicates an action that may cause potential 
loss of data, or other permanent changes to MAP or your media 
assets. Be sure you have backups, and are aware of the 
consequences of your action before proceeding.
About-4 May 2008
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Introduction
Telestream’s media capture, processing, and publication workflow automation 
solution – Media Application Platform (MAP) – provides media organizations 
the convenience and power of multi-channel media recording, organization, and 
indexing for fast processing and consumption via client MAP applications. MAP 
is a valuable system for any workflow where media producers capture, organize, 
and view live feeds or previously-aired content.
Figure 1–1.  Typical MAP system configuration

Topics Introduction on page 1-2
MAP Editions on page 1-2
Roles in MAP on page 1-2
MAP Services Architecture and Inter-Operation on page 1-3
MAP Components on page 1-10
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INTRODUCTION

Because MAP utilizes powerful Microsoft technologies, XML and standard file 
transfer methods, it is cost effective and highly scalable. MAP is integrated with 
Microsoft technologies to provide simple plug-and-play compatibility with a 
broad range of third-party systems and programs. For instance, MAP is 
integrated with Windows Speech API so that customers can plug in their favorite 
speech-to-text engine. MAP also integrates the Removable Storage Manager 
(RSM), allowing removable media libraries to be attached easily. 
MAP may be installed entirely on a single computer or on a server for access by 
distributed clients. For high-volume and high-performance requirements, MAP 
services may be distributed as a cluster.
MAP may be configured to create different versions of media, automatically 
decoding and encoding source media into a wide variety of streaming and 
broadcast formats, and deliver the encoded media to destinations you specify. 
Destinations can include media servers, network folders or SAN pools, FTP sites, 
or other Internet-accessible storage devices.

MAP EDITIONS

MAP is provided in two configurations to meet media professionals’ needs.

MAPreview MAPreview provides multi-feed media capture based on preset schedules. You 
simply search and play. MAPreview is ideal for conducting high-volume, multi-
channel real-time media capture for competitive news analysis, broadcast 
compliance logging, ad-run verification, lectures and distance learning, review of 
military events, legislative session recording, and digital surveillance.

MAP MAP simplifies import and organization of rich media files and has all of the 
functionality of MAPreview except for live, real-time capture of media. This 
workgroup organizer is ideal for media owners and producers who want to 
organize media files in a meaningful way, making it easier to find, re-purpose, 
and share media with colleagues.

ROLES IN MAP
MAP users can generally be categorized as administrators, producers, and 
consumers, and may play one or more roles – especially in small or medium-
sized organizations. For example, an associate producer may play the role of 
producer for part of a day, and consumer at other times.
In larger organizations, the administrative and production role is often the 
responsibility of several individuals. 
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Administrators MAP administrators are typically network engineers, IT professionals or senior 
media professionals who are responsible for setting up and configuring Windows 
servers, and maintaining networks. Often they are responsible for network 
security – controlling user names and passwords and granting access to corporate 
systems and assets.
The role of a MAP administrator typically includes specifying hardware 
purchases, installing MAP software, setting up authentication and access rights, 
and specifying where media is stored. Administrators are usually responsible for 
setting up capture cards, although the producer may take on the role of managing 
capture cards, as well as setting up media folder settings and destinations.
MAP administrators usually configure services with the management console.

Producers Producers are personnel who are associated with the production and management 
of media. They may be responsible for creating media folders, setting folder 
properties including determining who has access, ingesting media into the MAP 
media database (via drag-n-drop, 3rd party applications or live capture) and 
determining what versions are created and where they are stored. Typically, a 
producer is also responsible for managing metadata related to the media they are 
producing.
Producers typically configure MAP via MAP’s Windows Explorer.

Consumers In the context of MAP, consumers are MAP users who utilize media and 
metadata in the course of their daily tasks. Typically, consumers primarily use 
MAP Explorer, MAP Player, MAP Quick Review, or MAP Search to browse 
media folders, search for media (by name, date and time, or the contents of 
metadata associated with the media they are seeking), and play media. They also 
may review metadata, and copy it into other applications.

MAP SERVICES ARCHITECTURE AND INTER-OPERATION

It is important that all MAP services and clients have proper access to all shared 
media locations, both physical and virtual. A physical location in MAP is the 
address of the server and directory path where the media files are stored, in 
Windows or UNC path notation. For example, C:\MediaStore – a local physical 
location, or \\MAPServer\MediaStore – a network physical location.
A virtual location in MAP is a URL, which identifies the virtual directory on the 
IIS Web server or the publishing point on a Windows Media server which 
contains the physical location of the media store itself. For example, http://
MyWebServer/Streaming/.
It is also important to open and enable all communications ports and protocols to 
enable MAP services and clients to communicate and inter-operate. 
Work with your IT staff to determine the level of authentication required to 
access shared storage locations and to assure that the required communications 
ports and methods are open on your network. 
A MAP system consists of three Windows services. Each service performs a 
specific function. 
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Capture.MAP (used with MAPreview) performs the function of recording 
live feeds based on automatic or pre-determined schedules, extracting track 
and label metadata, and registers the captured media file with associated 
metadata into the MAP Content database. Generally, the media captured by 
Capture.MAP are stored locally in shared network locations on the MAP 
Capture server's internal storage. To assure that this service has full authority 
to the network shares, you must log in with appropriate credentials.
The heart of MAP is the MAP Content database. The Content database is 
controlled by Content.MAP. Content.MAP keeps track of media, metadata 
and other files associated with each MAP media asset in a virtual hierarchal 
media folder structure. Each media folder in a Content database has an 
associated group of data (Parent media asset, transcoded child media assets, 
track and label metadata, documents files and their respective network 
locations), collectively known as a MAP Binder. MAP Binders are indexed 
to provide searching for any element that is associated with its Parent asset. 
Content.MAP creates new MAP folders and binders on demand (from end 
users, Capture.MAP, and Factory.MAP), and provides client access to 
existing media folders and binders. Content.MAP’s media folders contain 
properties governing their behavior. These properties consist of: 
authentication rules, user success rules, storage depot locations, metadata 
rules, notification plugins and binder expiration rules. 
Media folder properties may be inherited by sub folder, or they vary from 
folder to folder allowing for different behavior based on organizational 
needs. The Content service requires access to the all local and network 
storage locations containing media that is associated with a MAP binder, 
whether they are established through the Capture service or Content service. 
To assure that Content.MAP has full authority to the network shares, log 
Content.MAP in with the appropriate credentials.
Factory.MAP provides media transcoding (flipping), media delivery, media 
analysis, and metadata extraction. Factory.MAP must also have adequate 
authority to read from all MAP network media storage locations. To assure 
that this service has full authority to the network locations log Factory.MAP 
in with the appropriate credentials.

MAP 
Communication 
Ports

A MAP system's services can reside on a single server, or they can be distributed 
across several servers on a LAN, and MAP clients may be LAN or WAN-based.
A variety of communication ports are used by MAP services and client 
applications to communicate among MAP services, and also to communicate 
with MAP clients. These ports are required to be open between MAPreview 
servers and computers running MAP clients. These ports may be blocked by 
corporate firewalls, network firewalls, personal firewalls, or other applications. 
Consult with your network administrator for details.

Note
Assure that the following TCP ports are opened and unrestricted between 
servers and clients on your MAP System's network.
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WebDAV
WebDAV is a set of extensions to the HTTP protocol which allows for common 
file system communications. WebDAV protocol is built into Windows, for use 
by Windows applications for file system tasks. MAP uses WebDAV when MAP 
clients including MAP Explorer, MAP Quick Review, and MAP Player 
communicate with Content.MAP to display and utilize media folders.
The default port is 80 and should not be changed. If other services, such as an IIS 
Web Server, are using port 80, IIS should be set to another port in order to 
accommodate MAP system requirements.

HyperLaunch
Telestream’s HyperLaunch protocol uses UDP and defaults to port 69. This port 
can be changed to another port as required, based on the destination’s UDP port – 
a MAP Content server or HyperLaunch Receive Server.

Gateway
The Gateway application uses TCP port 21 and 23 for FTP and email 
respectively.

EventReader
The EventReader application uses TCP 23 for communications with an email 
server in order to send email alerts when MAP errors or failures are selected.

Accessing MAP 
Media from Clients

There are three methods that MAP clients use to access MAP media via LAN or 
WAN from MAP client programs on distributed PCs.

HTTP WebDAV Redirector through Content.MAP
• Requires a MAP client to be installed

Table 1–1. MAP Services and Applications Ports

MAP Service/Application Port #

Content Service 8085

Capture Service 8086

Factory Service 8087

Archive Service 8088

Console Applet 8089

Receive Service 8090

Launch clients 8091

IIS Port 8000
May 2008 1-5



Introduction 74-0053-01
• Progressive downloads – not good for multiple concurrent streams
• Does not support direct access to the time line until fully downloaded
• Authentication is performed through the MAP Content service
• If a MAP client cannot access media files directly from the physical location 

or through an aliased location this method will be used.

Accessing Media Directly from Physical Storage
This method is used when accessing media on a Content server, Capture server or 
other physical network storage location.
• Authentication is performed through the client computer
• Requires each client to have read access to the physical storage locations
• Allows direct timeline access and multi-stream support. This method is very 

efficient but requires more care in setting up proper network access permis-
sion.

• The MAP Player will always default to the physical location if it can be 
accessed 

Accessing Media Aliased via a Virtual Store
When media is accessed from servers such as IIS or other Web server, or a media 
server including Windows Media Services or Helix Media Server, it is accessed 
via a virtual storage location.
• Provides the most efficient access to the media
• Authentication is performed through the Web server virtual directory or 

Media Server publishing point
• MAP Player uses this method if access to the physical location isn’t available. 

Streaming and Timeline Characteristics
If media is aliased through a Web servers virtual directory:
• Streams use progressive download techniques
• Does not support direct timeline access until entire file has been downloaded 

to the client computer
• Does not support an efficient interface for multiple stream access through the 

MAP Player due to the nature of progressive download.
• Works well for simple media file viewing when accessed via MAP Search or 

SharePoint Web Parts.
If media is aliased through a Media Server publishing point (from servers 
including Windows Media Services or Helix Media Servers)
• Can support direct time line access to any location in the stream.
• Most efficient method of multi-stream access through the MAP Player
• Allows for easy access across LAN or WAN using MAP Search or Share-

Point Web portals.

Choosing the Best 
Method for your MAP 
System

The method you choose depends on the architecture of your network, the method 
you use to view the media, and the client used in access the media.
Use the factors above and the in-depth descriptions following, to determine how 
to set up your MAP system for the most efficient access to media files.
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Client Access to 
Media Files

Generally, client program access to media files in MAP requires read 
permissions to all network MAP media storage locations; however, access to 
media files can be aliased via Web virtual directories or media server publishing 
points. In these cases the Web or Media server requires the proper permissions 
established in order to access the physical storage locations. If a Web or media 
server will be used to stream media files, make sure the appropriate ports/
protocols are opened (HTTP, RTSP, MMS, UDP, TCP, etc.). 

Streaming Media 
Delivery 
Considerations

MAP enables live capture streams and media files to contain a virtual alias URL. 
This virtual alias URL provides a method of accessing media files through Web 
Server virtual directories or Media Server publishing points. The following list of 
common protocols used by Web and Media Servers can help you determine 
protocol settings you’ll need to make when implementing MAP. Consult your 
network administrator for more details.

Web Server
Web virtual directories use HTTP over TCP. Default port: 80.

Media Server Streaming Protocols
RTSP (Real Time Stream Protocol). TCP 554 (In/Out), UDP 5004 (out), 
UDP 5005 (In/Out)
MMS (Microsoft Media Server). TCP 1755 (In/Out), UDP 1755 (In/Out), 
UDP 1024-5000 (Out)
HTTP. TCP 80 (In/Out)

MAP Player Access to 
Media Files

When MAP Player plays media contained in a MAP binder, it accesses media 
from locations contained in a binder's storage location object. This object 
contains the physical address (and an alias URL, if it was populated within the 
media folder properties). The first attempt to access the media file directly is 
from the physical storage depot through the UNC associated with it's physical 
location. If access is denied and an alias URL exists, the media will be stream 
from the alias URL. If there is no alias URL, MAP Player will play the media file 
by accessing the MAP binder through the MAP Explorer name space extensions 
using WebDAV (due to the nature of WebDAV the file may be progressively 
downloaded to the MAP Player instead of directly streamed).

Note
If your Web Server will be running on a server also running MAP Content 
service, it must be set to a port other than port 80.
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Be aware that certain MAP Player functions only work when the media is 
accessed directly from the physical storage location (see Note below). Keep this 
in mind when setting up storage access for MAP clients. 

All browser-based access uses the alias URL to play a media file contained in a 
MAP binder. The alias URL property must exist in order for media to be played 
via browser-based MAP access.

Physical & Alias 
Locations for 
Storage Depots

There are four important details to consider regarding a MAP storage depot:
1. There are two locations associated with each storage depot: a physical 

storage location and a virtual alias location.
2. The physical storage location is used to store media files to a local or network 

location.
3. The alias location is a secondary network location that may be an FTP 

address, a Web server virtual directory, or a media server publishing point. 
4. In order for MAP Content to associate the physical location of media 

captured by MAP Capture with an alias location, the physical storage 
location and alias need to be added to the Content storage depot list. In 
addition, the Read-Only box must to be checked to prevent the Content 
service from using this physical location.

When accessing media files via their physical or alias locations, consider these 
three factors:
1. From MAP Player, media files are accessed directly from their physical 

location if the client has read permissions to this location. If MAP Player does 
not have read permission to the physical location AND an alias location 
exists, the alias will be used. If no alias location is available, the media will be 
accessed via HTTP through MAP's .NET WebDAV re-director.

2. MAP Player’s media trim feature (allowing the creation of a new WMV file 
derived from mark-in and mark-out points) requires that MAP Player have 
read permissions directly to the physical media storage location. Otherwise, 
only reference playlist files can be generated based on the aliased or 
WebDAV locations.

3. From a browser-based interface, a media file is always accessed via the alias 
location. If no alias exists, media access will fail.

Web Server vs. 
Streaming Media 
Server

If you browse the Internet, then you are already familiar with Web servers such 
as IIS. However, you may not realize that when you stream audio and video 
content over the Internet, the content is most likely delivered from a streaming 
media server, such as Windows Media Server and Helix.
A streaming media server differs from a Web server in several ways:

Note
The MAP Player’s Step function (one frame forward or backward) and 
Trim (allowing the creation of a new WMV file derived from mark-in and 
mark-out points) requires that the MAP Player have read permissions 
directly to the physical media storage location. Otherwise only reference 
playlist files can be generated based on the aliased or WebDAV locations.
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• Web server delivers data as quickly as possible with no end-user control. In 
contrast, a streaming media server maintains a constant connection, regulat-
ing the data being sent to the client based on feedback from the player. 

• Web servers do not use advanced protocols that enhance playback, and pro-
gressively download media to the client system. Streaming media servers 
stream playback control options such as fast forward, rewind, jump directly to 
a search result or to a specific time code. You can also start, stop, or pause the 
stream at any time, just as you can when watching a movie with your VCR.

• Web servers do not support live stream. Live streams originate directly from 
a MAP Capture server's encoder(s) which are restricted in the number of con-
current connections and maximum CPU overhead.

Streaming Server 
Concepts

The content your Streaming Media server streams to clients may be either a live 
stream from MAP Capture or preexisting content that is stored in a physical 
MAP storage depot. 
If you are planning to stream live content from your MAP Capture system, a 
Media Streaming server publishing point will need to be created. This publishing 
point connects to the output of the Capture server's encoder on the TCP port 
designated in the Broadcast properties in the Settings tab of each channel. In 
addition, to stream media files stored in a physical MAP storage depot, a 
publishing point needs to be established to that physical location.
To learn more about the basics of streaming using Microsoft's Windows Media 
Services, download the Windows Media Services Help document from http://
go.microsoft.com/fwlink/?LinkId=33119.

Streaming Media Publishing Points
Streaming Media servers use publishing points to provide a common aliased 
URL to media files stored in MAP storage depots or to the live streaming output 
of a MAP Capture encoder. These connections are controlled and managed 
through the Stream Media server.

On-Demand Publishing Point
You will need to establish an On-Demand publishing point for each physical 
MAP Storage depot containing media. (See the Microsoft Windows Media 
Services documentation for details on establishing a publishing point on the 
Streaming Media server – http://go.microsoft.com/fwlink/?LinkId=33119).

Associating a Publishing Point to a MAP Storage Depot
The association of physical storage location to an alias URL (publishing point) is 
done within the media folder Storage property dialog. For every physical location 
storing media in MAP, an entry needs to be made in the media folder Storage 
property.

Live Broadcast Publishing Point
If you will be viewing live streams from MAP, you need to establish a live 
Broadcast publishing point for each MAP Capture channel. (See the Microsoft 
Windows Media Services documentation for details on establishing a publishing 
point on the Streaming Media server – http://go.microsoft.com/fwlink/
?LinkId=33119).
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Associating a Publishing Point to a Live MAP Capture 
Encoder Stream
The association of a live MAP Capture encoder stream to a Streaming Media 
server's Broadcast publishing point is performed within each MAP Capture 
channel’s Broadcast property in the Settings tab (for MAP V2.02 and above).

Server Side Playlist for Broadcast Publishing Point
This is an example of a server side playlist set up for a broadcast publishing 
point.

<?wsx version="1.0" encoding="utf-8"?>
<smil repeatCount="indefinite">
    <media src="http://map-
cap01:10000?WMNoDataTimeout=1000"/>
    <media src="http://map-
cap01:10001?WMNoDataTimeout=1000"/>
</smil>

MAP COMPONENTS

MAP is a collection of software components, each with a specific role in a MAP 
system. Some components are services or administrative applications, 
responsible for tasks including: schedule and capture live media, organize and 
provide access to media and metadata, and automatically transcode new media, 
plus automatic media archiving and restoration, for example. 
Other components are client and utility programs. Client programs such as MAP 
Explorer and MAP Player are powerful extensions to Microsoft technologies, 
which allow users to search and update metadata and play media. MAP is also 
accessible via Web browsers, and a .NET Web Service interface provides 
extensibility and customization for special MAP clients.

MAP Management 
Consoles

MAP management consoles (Figure 1–2) are installed during a services 
installation as a plug-in to Microsoft Management Console on the MAPreview 

Note
When overlap is enabled on a MAP Capture encoder, the TCP port will 
toggle between the Primary and Secondary ports. To accommodate for 
this, develop a Server Side playlist for your Publishing Point by including 
both ports in a failover scheme. This playlist will first attempt to connect to 
the Primary port. If it is not currently active it will connect to the Secondary 
port. Use Repeat Count with the value “indefinite” to loop continuously. In 
this case, the Channel's Primary and Secondary URL entries will be the 
same. See playlist example below.
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server for centralized configuration and management of Content, Capture, and 
Factory services by administrators.
Figure 1–2.  MAP services management console

The management console is very flexible. You can use one or more consoles, and 
manage any combination of services you have installed. 

Capture.MAP Capture.MAP is a service, that is used by producers to capture and digitize base 
band audio/video media – up to 4 live feeds. Capture.MAP controls capture 
devices (often called capture cards) and captures and stores media according to 
the Capture.MAP schedule. Depending on the number of capture cards and 
processor speed, several channels can be simultaneously captured on each 
Capture.MAPreview server.

Capture Cards If you plan to capture live media, you must purchase and install video capture 
cards in your server. MAP supports Osprey 440 cards.
When you purchase capture cards, you should install and configure them 
according to the manufacturer’s instructions.

Content.MAP Content.MAP is the heart of MAP. The Content.MAP service is used by 
producers to organize, manage and display media and associated metadata. It can 
be configured with rules to implement delivery, transcoding, expiration, access 
rights, metadata generation and media indexing. This service processes all the 
textual and track metadata searching.
Content.MAP service can be installed on the Capture.MAPreview server or on a 
separate server. Telestream recommends a separate Content.MAPreview server 
for larger applications; especially those requiring a large number of capture 
services (now or for future expansion) as well as a large number of concurrent 
clients.
Virtual folders in MAP called media folders each have a set of user-configurable 
properties that control how Content.MAP manages the media contained in them. 

Note
Telestream may support additional capture cards. If you are using a 
capture card that is not identified here, contact customer support to 
determine if Telestream should consider qualifying the card.
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These properties (or rules) enable features including delivery, transcoding, 
expiration, access rights, metadata generation, and media indexing. 
Content.MAP maintains all of the media folder properties, media links, and label 
and track metadata in its media database.Content.MAP service also processes all 
the textual and track metadata searching. 

Factory.MAP Factory.MAP is a service which is used to transcode media from one format to 
another, and deliver it to a media folder or an external file system (an on air 
server, for example). Just like Content.MAP service, Factory.MAP may also be 
installed on the Capture.MAPreview server, depending on server CPU utilization 
requirements.
Factory.MAP also includes a console, accessible in the tooltray, for monitoring 
Factory.MAP. The console is installed automatically whenever Factory.MAP is 
installed. 
Figure 1–3.  Factory.MAP operator console

Factory.MAP is not used explicitly by end users. Factory.MAP is activated by 
Content.MAP to create new media versions (based on versioning rules 
established for each media folder), and for transcoding tasks initiated when an 
end user drops media in special folders called media portals. Media portals are 
created in the Factory.MAP management or operator console and then added to 
MAP Explorer using the Add Media Portal Wizard.

Ratings Parser The Ratings Parser is responsible for generating XML files with ratings metadata 
extracted from ratings spreadsheets, based on configuration file generated by the 
Ratings Configurator. When ingested via Capture.MAP on incoming media, the 
ratings are available for viewing in MAP Player and MAP Explorer.

EventReader The EventReader is also automatically installed whenever a service is installed. 
The EventReader is responsible for monitoring MAP services events as they are 
written to event logs, and sending notifications (as configured by the customer) 
when an abnormal condition occurs.

Archive.MAP Archive.MAP is a utility client that provides support for archiving the actual 
media that is referenced in the Content.MAP database. Archival is an ongoing 
process based on the rules set up within media folders in Content.MAP. There is 
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no default device specified for MAP archive. Archive.MAP is installed when you 
install MAP services.
Figure 1–4.  Archive.MAP operator console

Storage devices include local or network folders, CD-R/W drives, DVD-R/W 
drives, and SAN devices. Additional archive automated methods are available 
based on Microsoft’s Removable Storage Manager. In a multi-server 
environment, Telestream recommends that Archive.MAP be installed on the 
same server as Content.MAP (and not on a Capture server), because these 
applications are not time-critical for the operation of the system.
When a user attempts to access media that has been archived to off-line storage, 
Content.MAP requests that a restore be performed to move the media back into 
on-line storage by issuing a restore request to Archive.MAP.
Archive.MAP is not a MAP Content database archiving application. You need to 
provide backup and archive processes for MAP data yourself.

Gateway.MAP Gateway.MAP allows you to ingest media from a ClipMail appliance or from a 
local or network directory (called a monitored folder) directly to a MAP media 
folder. Gateway.MAP is optional, and installed as a separate install process. 
Figure 1–5.  Gateway.MAP operator console

Once you install Gateway.MAP on a server and add accounts with media folders, 
your ClipMail users and other systems can deliver media directly to a media 
folder via the gateway from anywhere in the world.

HyperLaunch 
Receive Server

HyperLaunch is Telestream’s patent-pending high-performance, fault-tolerant 
protocol providing guaranteed, secure delivery of media and related documents 
anywhere in the world from remote or portable locations.
HyperLaunch Receive Server performs three important functions:
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Resume transfers interrupted by network failures
Resume transfers when sender changes locations
Enhance throughput over wireless and other high-loss connections to 
optimize throughput often over 90%.

HyperLaunch builds on TCP/IP to establish sessions between MAP and 
Telestream’s Launch applications (Windows and Macintosh) for high-
performance, guaranteed, secure media delivery.
HyperLaunch Receive Server is automatically installed when MAP services are 
installed.

MAP Explorer Telestream’s MAP Explorer application (Figure 1–6) is an extension of 
Windows Explorer and operates on Windows XP and Windows 2003 computers. 
MAP Explorer communicates with the Content.MAP service and allows MAP 
users to manage media, search for media, and play, trim and view media in MAP 
media folders.
Figure 1–6.  MAP Explorer is integrated in Windows Explorer

MAP Explorer is integrated directly in Windows Explorer and automatically 
displays special frames for media files and associated business documents, and 
metadata tracks and labels for selected media. 
In addition to using MAP Explorer to view and manage media, users can import 
or export media directly from MAP into 3rd party media applications (software 
and hardware), including NLEs, hardware encoders, software transcoders, 
PowerPoint, Microsoft Producer, and other media applications.

MAP Player MAP Player is a specialized, high-performance media player (based on Windows 
Media Player), which can play up to 25 media files at one time – in sync. In 
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addition, users can search for specific occurrences of metadata, create mark-in 
and mark-out points to trim and save new clips.
Figure 1–7.  MAP Player is a powerful, specialized media player

MAP Player makes it easy for producers to review several edits of the same 
scene simultaneously, shots from multiple camera angles or to watch competing 
news broadcasts at the same time, for example. MAP Player is automatically 
installed when Explorer.MAP or Quick Review clients are installed.

MAP Quick Review Quick Review is a client Windows application, which may be installed separately 
on any client computer running Windows XP or Windows 2003.
May 2008 1-15



Introduction 74-0053-01
End users can use MAP Quick Review as an alternative to MAP Explorer when 
they only want to locate and play media. MAP Quick Review is ideal for users 
who are not updating metadata or performing other media management tasks.
Figure 1–8.  Quick Review is a specialized search and play application

You can use MAP Quick Review to easily connect to media folders and search 
for media. Using MAP Quick Review, users can:

Connect to media folders on the local computer or via the network
Search metadata by date, time, and keyword 
Save searches and open them later for re-searching
View details of media hits
Select one or more clips for play in MAP Player.

MAP Search MAP Search is an ASP application can be installed on Windows servers running 
IIS. When installed, users can run MAP Search on any accessible Windows and 
Mac OS X computer to search and play media in your MAP media database 
using a Web browser.
For users who want to search, view or download media, the Web browser is an 
ideal way to provide easy access. When users log on to MAP via MAP Search 
using a URL you provide, they can search and play media directly in a Web 
browser, for example:

http://MAPreview_Server:8000/MAPClient/Search.aspx
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MAP Search is a DLL which communicates between the ASP page and the co-
located Content.MAPreview server, and a Web page which allows you to search 
on metadata and play the media.
Figure 1–9.  MAP Search allows users to use MAP via a Web browser

For MAP users who need only search and play access to media or metadata in the 
MAP media database, MAP extends the power of Microsoft IIS by integrating 
MAP Search. This allows end users to access MAP using only a Web browser. 
MAP users can use the MAP Web site to search and play media anywhere, 
anytime.

Launch Launch is a robust file transfer client for Windows and Mac OS X that improves 
and simplifies delivery of broadcast-quality media via LAN, corporate intranets, 
or wireless Internet, including WiFi connections commonly found at Internet 
cafes, hotels, and event sites, plus 3G wireless broadband where available in 
urban centers – making it easy to deliver media from virtually any location.
Launch connects to HyperLaunch Receive servers via media portals, which end 
users set up to transcode, optionally add other documents and metadata, and 
deliver the bundle to MAP or other servers.
Figure 1–10.  Launch console displays media portals and portal tasks
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Launch can be installed separately on client computers. Launch is not included in 
the MAP installer. Launch is available separately from Telestream.

Label Designer The Label Designer is automatically installed whenever MAP services are 
installed. Label Designer can be used create custom metadata labels. The Label 
Designer can be accessed from the Management Console or MAP Explorer. 
Figure 1–11.  Use Label Designer to create custom metadata tags for media

The Label Designer allows you to design text metadata labels and allow your end 
users to store the information you need and associate it with the media they are 
capturing, ingesting, and transcoding.
Label Designer is also included with Launch applications.
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Up & Running
If you have purchased a pre-installed MAPreview system, use this chapter to 
configure the hardware for your network and configure MAPreview to get it up 
and running quickly.

Topics MAP Up & Running Overview on page 2-2
Locate and Install the MAPreview server on page 2-2
Power On and Configure for LAN on page 2-3
Checking and Configuring MAP Settings on page 2-4

Caution
Before configuring MAP software, Telestream recommends backing 
up programs and data on your server, and making sure that your 
MAPreview server is included in your ongoing backup/archive 
policy.
Telestream also recommends creating a restore point before 
configuration. To create a restore point, click start > Programs > 
Accessories > System Tools > System Restore. In the System 
Restore dialog, click Create a Restore point and click Next. Name 
this restore point (Before MAP Config, for example) and click Create.
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MAP UP & RUNNING OVERVIEW

To configure a pre-installed MAPreview server to capture and use video in your 
environment, you’ll perform these tasks:
1. Locate and install the MAPreview server (immediately following).
2. Power on the server and configure network settings for your LAN (page 2-3)
3. Plug the MAP dongle into your MAPreview server to operate Capture.MAP 

in production mode. 
4. Restart your servers so that the MAP services begin operating.
5. Optionally install Ratings Parser if you plan to ingest daily show ratings.
6. Configure MAP Web Search if you plan to provide Web browser access to 

MAP media.
7. Optionally install Gateway.MAP.
8. Install MAP clients on client computers (MAP Explorer, MAP Player) for 

your MAP end users.

LOCATE AND INSTALL THE MAPREVIEW SERVER

To prepare servers for MAP services, first confirm that each server meets the 
hardware requirements (following). Then perform the following steps.

Unpack the 
MAPreview server

Unpack the contents of the original shipping container; identify each component 
and determine that they are in satisfactory condition. If any shipping damage is 
visible, note it on your shipping documents and contact your shipping agent and 
Telestream or authorized Telestream distributor.

Environmental and 
Power Operating 
Requirements

Plan adequate space for cable routing from the back of the chassis. Ensure that 
the MAPreview server is in close proximity to your Ethernet and video cables, 
and that cable connectors are not stressed, bent, or crimped.
When installing the MAPreview server, ensure that you install it in a place and 
environment that meets the hardware manufacturer’s venting, atmospheric, 
temperature, and power requirements.

Locate the 
MAPreview server

Ideally, rack-mount your MAPreview server for safety and operational 
efficiency. Alternatively, select a stable and level, smooth, hard surface. Avoid 
carpeted or cloth-covered surfaces which may inhibit airflow or reduce heat 
dissipation, and contribute to overheating. Also, select a safe isolated location 
with network access, proper environment and protection from accidental contact 

Note
Save all packaging materials and store them in a safe place. If you require 
service – or move your MAPreview server – the packaging materials may 
be used for safe shipment.
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with the device, and power and data transmission cables by users that might 
cause a trip hazard, damage the MAPreview server, or cause it to fall.

Connect Power and 
Ethernet Cable

Attach the power cord and Ethernet cable to the MAPreview server. 

Attach MAP Dongle Remove the dongle from its protective packaging and insert it into a USB port 
before powering up the MAPreview server.

Connect Video and 
Audio

With the MAPreview server off, connect up to four composite video in BNC 
cables to channels 1 through 4, routed with the appropriate signal for video 
capture. Also, connect audio cables (RCA jacks) to associated audio input jacks 
on the card. Make sure that each cable is labeled to insure that you know which 
station/source video is on each cable.

POWER ON AND CONFIGURE FOR LAN

Power on the 
MAPreview server

With power, Ethernet and video connected, and the MAP dongle in place, power 
up the MAPreview server. 

System Log In with 
Administrative 
Privileges

When the MAPreview server boots up, log in. using the default user name and 
password. The default user name is mapuser, and the password is also mapuser. 
For security purposes, you may want to change the user name and password. The 
default computer name is MAPreview_Server.
The default user name and password is part of the local administrator’s group. It 
is necessary to maintain a login with administrative privileges for MAP Content, 
MAP Factory, and MAP Capture services.
Changing the Machine Name. If you change the name of the MAPreview 
server, you must modify some of the pre-defined storage paths to reflect the new 
server name. There are two places where you need to change the name. 
The first is Capture Server properties (Capture.MAP Administration on page 
4-19), the second is Media Folders (Setting Media Folder Properties on page 
4-13). You should use UNC paths to identify these locations.

Caution
Telestream recommends connecting computer equipment to AC 
power through an uninterruptible power supply (UPS) with surge 
protection. Fluctuations in commercial supply voltage can 
damage unprotected electronic equipment.
A high-quality surge suppressor may be substituted if a UPS is 
not available, but it may not provide adequate protection.
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Adding the 
MAPreview server to 
a Network

Each MAPreview server is set up at the factory to use DHCP so that it can 
automatically obtain a network address from your DHCP server and operate 
correctly on your network.
If you do not permit DHCP or you want to assign a specific IP Address to this 
computer, power up the MAPreview server and modify the TCP/IP settings now.

CHECKING AND CONFIGURING MAP SETTINGS

MAPreview is set up to capture 4 channels at 1 hour segments 24 hours per day. 
Before beginning capture, review all MAP settings to make sure they meet your 
requirements. For support, contact Telestream (Support and Information on page 
About-1).

MAP Capture The default channel settings are: 320x240 350kb/s @29.97. Audio 48Kbps 
32kHz stereo. To learn about managing and configuring MAP Capture, or to 
change these settings, see Capture.MAP Administration on page 4-19.
All four channels are configured with a schedule to capture 1 hour segments 24 
hours per day. Video is 320 x 240, 350Kbps @ 29.97FPS for NTSC and 25FPS 
for PAL. Audio is 48Kbps 32 kHz stereo. 
Before you start capturing, if you need to make changes, perform the following 
steps: 
1. Name the channels appropriately, based on the input signal to the Osprey440 

capture card (the card is marked 1-4 and corresponds to each of the pre-
configured channels, ch1-4). Channel 1 (ch1) uses source one on the capture 
card, ch2 uses source two, etc.

2. Check the schedule for each channel and adjust it accordingly.
All storage locations for MAP Capture media stores (in Channel Properties) 
should be referencd by machine name, in UNC format.

MAP Player If you plan on using MAP Player to play video you’ve searched for in MAP 
Search, you need to install the MAP Player on each client Windows computer. 
(MAP Player is not available on Mac OS X – use Flip4Mac WMV 
(www.flip4mac.com). To install MAP Player, install MAP Quick Review. See 
Installing MAP Quick Review on page 3-28.

MAP.Content Media 
Folders

All media is stored in the MAPstorage directory. The top level media folder is 
named Live. Media folders are set up to provide closed caption, summary label, 
and key frame extraction. To learn about configuring and managing media 
folders in MAP, see Content.MAP Administration on page 4-11.
Media expiration default is 30, 60 or 90 days (based on drive size and purchase 
options), and may be altered by you at any time.

Note
For detailed information on configuring each MAP service, see MAP 
Services Configuration & Administration on page 3-1.
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All storage locations for MAP Content media stores (in Folder Properties in the 
Storage tab) should also be referencd by machine name, in UNC format.

MAP Search Before users can use MAP Search in a Web browser on their own computer, you 
need to configure the following (Installing MAP Search on page 3-31):
Feature List. Edit the web.config file to enable the features of Search you 
want your users to have. By default, MAP Player is disabled in MAP Search; live 
feeds is enabled. To play media with MAP Player on remote computers, you 
must install MAP Quick Review, which includes MAP Player.
MAPreview server List. Edit the ContentServers.xml file to include the list 
of MAPreview servers users have access to if more than one.
Live Feeds. Edit the LiveFeeds.xml file to display the list of live feeds you 
want users to be able to monitor in MAP Search.
MAP Search URL. You need to form a URL based on your machine name, 
IIS port and provide it to your end users to run the application. 
The default Web Page access and port forms this URL: http://localhost:8000/
MAPClient/search.aspx. (This URL only works when used in the Web browser 
directly on the MAP server.)
For example: http://MAPreview_Server:8000/MAPClient/Search.aspx.
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Installing MAP Services,
Clients, & Utilities
Use this chapter to install MAP services and utility clients, and install MAP 
clients on user’s computers throughout your organization. You'll also use this 
chapter to make sure your servers meet platform requirements and attach a USB 
dongle to the MAPreview server to enable the MAP license.

Topics MAP Installation Overview on page 3-2
MAPreview server Platform and Preparation Requirements on page 3-3
Hardware Requirements on page 3-3
Software Requirements on page 3-4
Windows OS and Network Configuration on page 3-7
MAP Port Configuration on page 3-9
MAP Client Platform OS Requirements on page 3-11
MAP Web Client Platform OS Requirements on page 3-11
Using the MAP Installer Console on page 3-12
Installing MAP Services on page 3-14
Installing Gateway.MAP on page 3-19
Installing MAP Ratings Parser and Configurator on page 3-21
Attaching MAP USB Dongles on page 3-23
Viewing Machine ID and License Information on page 3-23
Updating the MAP Dongle on page 3-24
Installing MAP Explorer on page 3-25
Installing MAP Quick Review on page 3-28
Installing MAP Search on page 3-31
Re-installing ASP.NET for IIS on page 3-35

Caution
Before installing software, Telestream recommends backing up 
programs and data on your server.
Telestream also recommends creating a restore point before 
installation. To create a restore point, click start > Programs > 
Accessories > System Tools > System Restore. In the System 
Restore dialog, click Create a Restore point and click Next. Name 
this restore point (Before MAP Install, for example) and click Create.
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MAP INSTALLATION OVERVIEW

If you are updating MAP to a newer version, be sure to follow the steps 
recommended in Upgrading a MAP System on page 8-2.
If you are installing a multi-server MAP system, Telestream recommends that 
you install MAP on a single server first and take the tours in the MAP Quick 
Start Guide to become familiar with MAP's features.

To install MAP services, clients, and utilities in your environment, you’ll 
perform these tasks:
• Plan which MAP services and utilities to install, and which servers to use.
• Audit and upgrade servers to meet MAP hardware & software requirements.
• Uninstall MAP services if you’re upgrading. You must restart your computer 

before re-installing MAP.
• If you plan to access MAP via Web browsers, install IIS on the server before 

installing MAP services.
• Perform a a MAPreview server install (with EventReader, Label Designer, 

MAP Player, Quick Review, Explorer) and other software components as 
required by the MAP Services Installer Wizard.

• Plug the MAP dongle into your MAPreview server to operate Capture.MAP 
in production mode. 

• Restart your servers so that the MAP services begin operating.
• Optionally install Ratings Parser if you plan to ingest daily show ratings.
• Optionally install MAP Web Search if you plan to provide Web browser 

access to MAP media.
• Optionally install MAP SharePoint Web Parts if you plan to publish MAP 

media via SharePoint
• Optionally install Gateway.MAP.
• Optionally install HyperLaunch Receive Server and Launch clients.
• Install MAP clients on client computers (MAP Explorer, MAP Player, and 

MAP Quick Review) for your MAP end users.

Note
If you are performing a multi-server installation, be sure to complete a 
multi-server installation plan. See Chapter 5, Multi-Server Planning and 
Configuration on page 5-1.

Notes
Don’t plug in a MAP dongle before installing MAP. Windows may not have 
the appropriate driver.
The MAP installer copies several software components to various 
directories on the server. To install all software, you must log on with a 
User ID that has administrative privileges.
Be sure to restart your computer before performing an installation if you 
previously uninstalled MAP Services to repair or upgrade MAP.
Make sure that the Services window (Control Panel > Administrative Tools 
> Services) is NOT open during installation, or MAP services can not be 
installed and registered as a service.
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MAPREVIEW SERVER PLATFORM AND PREPARATION REQUIREMENTS

To prepare servers for MAP services, first confirm that each server meets the 
hardware requirements (following). Then perform the following steps.

Recommended Tasks These tasks are optional, but highly recommended before installing MAP:
1. Create partitions and initialization drives.
2. Perform an operating system installation, plus service packs and upgrades as 

indicated by Microsoft Windows Update Service.
3. Set up and configure Windows OS and network settings to best meet the 

rigorous networking requirements for MAPreview server operation.
4. If MAP will be accessed via a Web browser, activate IIS on a port other than 

80. MAP services use port 80; the recommended port for IIS is 8000.
5. Ensure that no media applications are installed or running on this server, such 

as DVD or VCD decoders, or other media transcoding applications.

Required Tasks These two tasks are required:
1. Audit each server and perform hardware modifications or upgrades necessary 

to qualify the server for the hardware requirements for MAP services, 
including hard drives, CD/DVDs, additional RAM, and capture cards.

2. Download each software component from the Microsoft Web site, and install 
or upgrade each component and configure it as necessary to qualify each 
platform for running MAP services.

Hardware 
Requirements

Drive/partition requirements depend on the amount of data you plan to capture.

Single MAPreview 
server Drive and 
Partition 
Requirements

You should configure a MAPreview server that is intended to run all MAP 
services with at least 2 hard drives, or with a single hard drive or RAID with 2 or 
more partitions. The OS and MAP drive/partition should be at least 50GB, 
allocated exclusively to MAP services and related MAP software, and the MAP 
database.
The other drives or partitions should be sized according to media capture 
requirements and exclusively allocated to captured media.

Capture.MAPreview 
server Drive and 
Partition 
Requirements

You should configure each Capture server with at least 2 hard drives, or with a 
single hard drive or RAID with 2 or more partitions. The OS and MAP drive/
partition should be at least 20GB so that you can install Windows, and also install 
MAP services on the OS/MAP drive. 
The other drives or partitions should be sized according to media capture 
requirements and exclusively allocated to captured media.
May 2008 3-3



Installing MAP Services, Clients, & Utilities 74-0053-01
Content.MAPreview 
server Drive and 
Partition 
Requirements

You should configure each Content server with at least 2 hard drives, or with a 
single hard drive or RAID with 2 or more partitions. The OS-only partition 
should large enough so that you can install Windows. 
Install MAP services on Content.MAPreview servers on a separate drive/
partition. The separate drive/partitions should be 50GB or bigger, and allocated 
exclusively to MAP services and related MAP software, and the MAP database.

Capturing Media If you plan to capture one or two channels of media, store less than 200GB of 
media and connect five or less MAP clients concurrently, you can install and 
operate MAP on a single server. 

A single-server system is designed to support all MAP services and optionally, 
IIS, with up to one medium resolution or two low resolution capture processes, 
and up to 5 client programs simultaneously logged on performing light- to 
moderate-duty tasks.
The server’s CPU speed and drive capacity depends on the amount of media you 
plan to process and transcoding speed you require. Faster and bigger is better.
Likewise, the capture card and slot or port requirements for your installation 
depend on your media capture requirements.

Software 
Requirements

The required operating systems for operating MAP services are Windows XP 
Professional or Windows Server 2003.

Table 3–1. MAPreview server Hardware Requirements

Component Description

Processor Dual Pentium® 4 or Xeon processors, 2.0 GHz or 
higher, with 512KB L2 cache

RAM At least 2,000 MB (2 Gigabytes)

Disk Space 120 GB for media storage, 50 MB for MAP software

Ethernet 100 Mbps Ethernet

Sound Sound card (must be present for production of 
Windows Media files) and playing audio in MAP Player

CD or DVD 4X or higher DVD+RW CD drive for archiving

Table 3–2. MAP Services Required Software Components

Component Description

Microsoft J# .NET Runtime Version 1.1.4322 or later

Microsoft .NET Framework Version 1.1.4322 or later

Windows Media Encoder 9 Required for Capture.MAP

Windows Media Player Version 9.00.00.3008 or later or Version 10
3-4 May 2008



74-0053-01 Installing MAP Services, Clients, & Utilities
Required Subsystems When you install MAP services, the installer determines if J#.NET Runtime, 
Microsoft.NET Framework, Windows Media Player, QuickTime 6, or Windows 
Media Encoder 9 are missing or obsolete, and prompts you to install them as part 
of its installation process.

Windows Media Player
If Windows Media Player is missing or obsolete, the installer prompts you to 
download the installer from the Microsoft Web site and install it.
Install: To download the Windows Media Player installer, go to 
www.microsoft.com/windows/windowsmedia/10 series.
Download and install Windows Media Player 10. (Windows Media Player 9 is no 
longer available for Windows XP, and Windows Media Player is pre-installed on 
Windows 2003.) Alternatively, you can use Windows Media Player 11 on 
Windows XP; it is not available for Windows Server 2003.

QuickTime 6 (optional)
If QuickTime 6 is missing or obsolete, the installer prompts you to install it as 
part of its installation process if you require QuickTime. QuickTime 6 is an 
optional component and QuickTime 7 is not compatible with MAP.

Windows XP Service Packs, Hot fixes, and Updates
Audit: Right-click on My Computer to display the Properties window. In the 
General tab, verify that Service Pack 1 (or later) is installed. 
Update. In the Automatic Updates tab, Telestream recommends that you check 
Automatic Updates and install all recommended updates, or confirm that your 
operating system is current. 

Windows service packs,
hot fixes & other updates

Per Microsoft Windows Updates Service

Windows Internet 
Information Services (IIS)

Install the World Wide Web Service only

Table 3–2. MAP Services Required Software Components

Component Description

Note
If you install Service Pack 2, the Windows firewall is enabled by default. 
For MAP services to operate, disable the firewall. Open the Control Panel 
> Security Center window. Click on Windows Firewall, and in the general 
tab, select Off and click OK.
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MAP Web Search If you plan to use MAP Web Search (or use third-party Web clients or develop 
your own client using MAP SOAP services), the following software is required.

IIS should be installed on the server before you install MAP services and .NET. 
IIS must be configured to use a port other than port 80 (MAP services use port 
80). Telestream recommends using port 8000. 

Audit: To determine if IIS is activated on your server, open Control Panel > Add/
Remove Programs. Click Add/Remove Windows Components in the toolbar to 
launch the Windows Components Wizard and see if the Internet Information 
Services (IIS) checkbox is already selected.
Install: To activate IIS, open the Control Panel and run Add/Remove Programs.
Click the Add/Remove Windows Components icon in the toolbar on the left to 
launch the Windows Components Wizard. 
Check the Internet Information Services (IIS) checkbox and click Next to 
activate IIS. Be sure to change the default port (80) to another number, suggested 
8000. Do not install SMTP or FTP. 
To validate that IIS is running, open Control Panel > Administrative Tools. Click 
on the Internet Services icon to launch the IIS console. 

Table 3–3. MAP Web Search Required Software Components

Component Description

Microsoft Visual J# 
.Redistributable Package

Version 2.0 or later

Microsoft .NET Framework Version 3.5 or later

Windows Internet 
Information Services (IIS)

Install the World Wide Web Service only

Note
The requirement to configure IIS to use a port other than port 80 does not 
apply when IIS is running on a server separate from the MAPreview 
server.

Notes
If you install MAP services before installing IIS, you need to re-register 
ASP.NET for use with IIS. See Re-installing ASP.NET for IIS on page 
3-35.
If IIS is already installed for port 80, change the port in the IIS 
management console. Open the local computer, then open the Web Sites 
folder. Select Properties on the Default Web site, update the port number 
(suggested port: 8000) and click OK. 
Restart IIS to take effect.
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Windows OS and 
Network 
Configuration

For optimum performance and reliability, and to mitigate the change of network 
communications failures that prevent MAP services and clients from connection 
and interoperation, you should configure Windows on each MAPreview server, 
and configure network settings on each MAPreview server as recommended in 
this section.
Create MAP Users. Create two MAP users: one for MAP and IT 
administrators for administration, and one for MAP services to execute with.
Create MAPUSER (or other name you choose) with administrative privileges. 
This user should be used for logging on to install and manage MAP or Windows.
Create MAPSERVICES (or other name you choose), also with administrative 
privileges. This user should be assigned to each MAP service to log in with when 
they run on the server.
If MAP is installed on a domain, the services should be logged in with a domain 
user account with sufficient local administration and network privileges. Usually, 
the IT group will create a MAP domain user with the necessary privileges.
MAPreview server Identity. In Computer Name Changes, set the Computer 
name to one that identifies this server as part of a MAP system (MAP_Content, 
or MAP_Factory1, MAP_Factory2, MAP_Capture, etc.). Set the Domain or 
Workgroup name as required. All MAPreview servers should be in the same 
domain/workgroup. To display Computer Name changes dialog, right-click My 
Computer. In System Properties > Computer name tab, click Change.
Figure 3–1.  Computer Name Changes dialog

Telestream recommends placing multiple MAPreview servers on the same 
switch for optimal network communication, and recommends against the use of a 
hub.
Assign Network Adapter Parameters. Implement static IP addresses for 
each MAPreview server. Because MAPreview servers must maintain constant 
communication to interoperate, use static IP addresses to reduce the likelihood of 
inter-service communication failure. Do not use DHCP to provide an IP address 
that can change without notice and cause MAP system failure.
Also provide appropriate subnet mask values, default gateway, DNS entries. 
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Consult with your IT administrator for other NIC configuration requirements for 
your system.
Add MAP Services to HOSTS File. Add the server names and IP addresses 
of each MAPreview server to the HOSTS file on each MAPreview server to 
protect against the loss of MAPreview server name/address pairing. 
Figure 3–2.  Sample MAPreview server HOSTS file (with scrambled IP 
addresses)

The HOSTS file is at C:\WINDOWS\SYSTEM32\DRIVERS\ETC.
Windows loads the HOSTS file at startup and checks the entries before querying 
any DNS servers, thus ensuring that MAP services can communicate with each 
other even if DNS service has failed.

Set MAPreview servers to NTP Time. Configure all MAPreview server’s 
Windows Time Service to use the same NTP (Network Time Protocol) server to 
assure accurate synchronization, or use another time sync method. You can use 
your own NTP server, or point to time.nist.gov.
Disable Automatic Virus Scans on Capture Server. Telestream 
recommends running virus scans manually or scheduling them to run when 
Capture service is not capturing segments. A virus scan impairs operation of your 
Capture server because it increases CPU utilization. If virus scanning is set to 
automatic, monitor CPU utilization to make sure it does not rise above 85%.
If you decide not to run virus software on your Capture server, consider isolating 
the Capture server from the corporate network or firewall the server from the 
Internet to reduce risk of virus infection.
Disable Advanced Power Management. Disable Windows (Control Panel 
> Power Options) and vendor-specific advanced power management options that 

Add MAPreview server IP address / 
Name pairs here to improve 

Tip
HOSTS file entries can also be used to block Internet access to 
unwanted Web sites, and prevent unwanted programs (spyware, 
adware and other unwelcome programs) from returning information to 
their host site if listed, thus increasing security of your servers.
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might cause the server to automatically sleep, hibernate, shut down, or log off 
during periods of inactivity, for example.
Auto-start Indexing and Windows Image Acquisition Services. Set 
Indexing Service and Windows Image Acquisition Services (right-click My 
Computer > Manage > Services and Applications > Services window) to start 
automatically when a MAPreview server starts or restarts. Both services are 
required for proper operation of MAP.
Disable System Sounds. Set Windows so that no Windows-generated sounds 
are allowed (Control Panel > Sounds and Audio Devices > Sounds tab). In the 
Sound tab, set Sounds scheme to No Sounds.
Disable Windows Software Updates. Telestream recommends disabling 
automatic updates (Control Panel > Automatic Updates), or scheduling updates 
when media recording is idle. File downloads that occur during software updates 
can push CPU utilization above the recommended 85% limit on Capture servers, 
and may cause an automatic system reboot or other unintended OS change that 
renders a MAP service inoperative and lead to media loss.

MAP Port 
Configuration

MAP services may be distributed across several servers on a LAN, and MAP 
clients may be LAN or WAN-based.
The following ports are required to be open between MAPreview servers and 
computers running certain MAP clients. These ports may be blocked by 
corporate firewalls, network firewalls, personal firewalls, or other applications.

Caution
Making changes to MAPreview server IP address, computer names, 
or user’s log in names or passwords assigned to MAP services can 
adversely affect MAP operation and client connections to media.

Note
Assure that the following TCP ports are opened and unrestricted between 
servers and clients on your MAP System's network.

Table 3–4. MAP Services and Applications Ports

MAP Service/Application Port #

Content Service 8085

Capture Service 8086

Factory Service 8087

Archive Service 8088

Console Applet 8089
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WebDAV
MAP uses WebDAV for MAP clients: MAP Explorer, MAP Quick Review, and 
MAP Player.
The default port is 80 and should not be changed. If other services, such as an IIS 
Web Server, are using port 80, IIS should be set to another port.

HyperLaunch
Telestream’s HyperLaunch protocol uses UDP and defaults to port 69. This port 
can be changed to another port as required, based on the destination’s UDP port – 
a MAP Content server or HyperLaunch Receive Server.

Gateway
MAP Gateway uses TCP port 21 and 23 for FTP and email, respectively.

EventReader
EventReader uses TCP 23 for communications with an email server to send 
email alerts when MAP errors or failures are selected.

Client Access to 
Media Files

If a Web or media server will be used to stream media files, open the appropriate 
ports/protocols (HTTP, RTSP, MMS, UDP, TCP, etc.).

Web Server
Web virtual directories use HTTP over TCP. Default port: 80.

Media Server Streaming Protocols
RTSP (Real Time Stream Protocol). TCP 554 (In/Out), UDP 5004 (out), 
UDP 5005 (In/Out)
MMS (Microsoft Media Server). TCP 1755 (In/Out), UDP 1755 (In/Out), 
UDP 1024-5000 (Out)
HTTP. TCP 80 (In/Out)

Receive Service 8090

Launch clients 8091

IIS Web Client Access 8000

Table 3–4. MAP Services and Applications Ports

MAP Service/Application Port #

Note
If your Web Server will be running on a server also running MAP Content 
service, it must be set to a port other than port 80.
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MAP CLIENT PLATFORM OS REQUIREMENTS

The recommended operating system for computers running MAP client programs 
is Windows XP Professional, with current service packs and all other updates 
(per Microsoft Windows Update Service).
The following list details the other software that must be installed.

.NET Framework Version 1.1 or later
J# .NET Runtime Version 1.1
Windows Media Player 9 or 10
Windows Media Encoder (9 series)
Service packs, other updates (Per Microsoft Windows Updates Service)

These components are available on the MAP Installer CD. Updated versions of 
these components may be available on the Microsoft Web site.

MAP WEB CLIENT PLATFORM OS REQUIREMENTS

The recommended operating system for computers running MAP Search, a Web 
client program (or others written by you) is Windows XP Professional, with 
current service packs and all other updates (per Microsoft Windows Update 
Service) or Mac OS X.
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USING THE MAP INSTALLER CONSOLE

MAP installers are accessed via the MAP Installer Console, below. 
When you insert the MAP Installer CD, the console starts automatically. (If the 
Installer doesn't start, open the CD and run startup.exe.)
Figure 3–3.  MAP Installer console

The console is organized in three groups: Server installation, Clients installation, 
and Utilities installation. When you click on these buttons, the Console displays 
installation options for your selection.

Server Installation Click Server to display a list of installation choices. 
Figure 3–4.  MAPreview server installation options

Choose from these installations:
— Installing MAP Services (page 3-14)
— Installing Gateway.MAP (page 2-15)
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Clients Installation Click Clients to display a list of installation choices. 
Figure 3–5.  MAP client installation options

Choose from these installations:
— Installing MAP Explorer on page 3-25
— Installing MAP Quick Review on page 3-28
— Installing MAP Search on page 3-31

Utilities 
Installation

Click Utilities to display a list of installation choices.
Figure 3–6.  MAP utilities installation options

Choose from these installations:
— Installing HyperLaunch Receive Server. See HyperLaunch Receive 

Server Installation, Configuration, and Management Guide – click 
User Guides.

— Installing MAP Ratings Parser and Configurator on page 3-21
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INSTALLING MAP SERVICES

A MAP Services installation installs or updates the following software:
• Microsoft .NET Framework
• Microsoft J# .NET Runtime
• Microsoft Windows Media Player
• Microsoft Windows Media Encoder 9 Series
• Archive.MAP
• Capture.MAP service
• Content.MAP service
• Factory.MAP service
• Services Management Consoles
• Ratings Parser
• EventReader
• HyperLaunch Receive Server (as part of Content.MAP)
• MAP Player
• MAP Explorer
• MAP Quick Review
• Label Designer

To perform a complete MAP services installation on your MAPreview server, 
you should have the MAP Installer CD and a MAP USB dongle. 
If you are planning to use MAP Web clients for your users, be sure that you have 
IIS installed and running before performing this installation.
Before performing a multi-system installation, develop your installation plan 
(MAP System Planning Guide on page 7-1). 

Note
If you uninstall MAP services, you must restart your computer before 
performing re-installation. Also, make sure that the Services window 
(Control Panel > Administrative Tools > Services) is not open during 
installation because this prevents MAP services from being registered.

Note
You can not install a single MAP service. After installation, you can disable 
services you do not plan to use (Capture.MAP for example) on this server. 
Right-click My Computer > Manage. In the Management window, open 
Services and Applications > Services. In Services, right-click the target 
service and select Properties. Set Startup Type to Disabled and click OK.

Caution
Do not install MAP services on a server when the MAP dongle is in 
place. If you are updating MAP, remove the dongle before 
uninstalling and re-install it when the upgrade is complete.
If you are installing MAP services on a server for the first time, install 
the dongle after installation is complete.
Do not install MAP until your MAPreview server is in compliance with 
the hardware and operating system requirements.
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Start the Installer To begin installation, start the server and log on with a user ID that has 
administrative privileges. (The installer will not run if you log on with a user ID 
that does not have administrative privileges). 
Before you start, make sure no programs are running, virus-checking software is 
off, and the dongle is disconnected from the server.

Step 1 Insert the MAP Installer CD to start the MAP Installer Console.

Figure 3–7.  MAP Installer main console

Step 2 On the main console window, click the Services tab.

Figure 3–8.  MAPreview server installer options

Step 3 On the Server tab, click Install MAP Services to launch the MAP Setup Wizard 
and begin a complete MAP services installation.

If all of the supporting software is already installed, the MAP Setup Wizard will 
display the welcome panel (page 2-13) immediately.

Tip
If you are performing a multi-server installation or installing MAP clients on 
several computers, you can copy the installer to a server directory and 
launch it over the network.
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The Wizard checks for each required component, and if necessary, installs it for 
you. If the required component is already installed, it proceeds to the next 
component check without notification.

Install Microsoft .NET 
Framework

The MAP Setup Wizard first determines if you need to install the current version 
of the .NET Framework and displays the following dialog:

Step 4 Click Yes to install the .NET Framework and follow the installation instructions.

Step 5 When the .NET Framework is installed, click Install MAP Services in the MAP 
Installer Console again to continue installation.

The MAP Setup Wizard next determines if you need to install the current version 
of the J# .NET Runtime component and displays the following dialog:

Step 6 Click Yes to install the J# .NET Runtime and follow the installation instructions.

Step 7 When installation of the J# .NET Redistributable Package is complete, click 
Install MAP Services again to continue installation.

Install Windows 
Media Encoder (9 
Series)

The MAP Setup Wizard determines if you need to install the current version of 
Microsoft Windows Media Encoder 9 Series and displays the following dialog:

Step 8 Click Yes to install Windows Media 9 Encoder and follow the instructions.

Step 9 When Windows Media 9 Encoder is installed, click Install MAP Services in the 
MAP Installer Console again to continue installation.

Install Windows 
Media Player

If Windows Media Player is missing or obsolete, the Setup Wizard prompts you 
to download the installer from the Microsoft Web site and install it. 

Step 10 Install: When you click Yes, the Windows Media Player 9 page displays. Click 
the link to download and install Windows Media Player 10 on this page. 
(Windows Media Player 9 is no longer available for Windows XP, and Windows 
Media Player is pre-installed on Windows 2003.).

Step 11 Click Install MAP Services in the MAP Installer Console again to continue.
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Install MAP Services, 
Consoles, and Clients

The MAP Setup Wizard displays the Welcome panel.
Figure 3–9.  MAP Setup Wizard Welcome panel

Step 12 Click Next to view the Telestream license agreement.

Step 13 Telestream License Agreement Panel. After reading the terms of the 
agreement, click I Agree if you agree, and click Next to continue.
The MAP Setup Wizard displays the Content Server Port panel.

Step 14 Content Server Port Panel. Port 80 is the port that Content.MAP uses for 
inter-service communication. Do not change it. If you are using IIS to provide 
Web browser access to MAP, IIS must be configured with an IP port other than 
80. Telestream recommends port 8000.

Step 15 Click Next to continue. The MAP Setup Wizard displays the Select Installation 
Folder panel.

Step 16 Installation Folder and Security Options Panel. Select the installation 
directory path and permissions using these options:

Step 17 Browse to locate and select the folder where you want MAP services installed, or 
accept the default directory. See MAP System Planning Guide on page 7-1 for 
specific drive/partition requirements for Capture and Content services.

Step 18 Disk Cost. Click to view details about available disks.
Check Everyone (default) or Just Me to install MAP with proper permissions.

Step 19 Click Next to continue to display the Confirm Installation panel.
Step 20 Install Confirmation Panel. Click Next to install the software. Click Back 

to review settings.
Step 21 When you click Next, the wizard installs the MAP services and client software, 

and provides a progress bar to note progress. (Click Cancel to immediately 
terminate installation.)

Step 22 Installation Progress Panel. The MAP installer also installs a USB dongle 
driver, and displays a Driver Installation panel you can dismiss. When 
installation is complete, the wizard displays the Installation Complete panel.

Note
Checking Everyone is recommended. To change this setting after 
installation, you must uninstall and re-install MAP.
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Install QuickTime 6 If QuickTime is missing or obsolete, the Setup Wizard prompts you to install it. 

Step 23 If you click Yes, the QuickTime 6.5.1 installer runs. Follow the instructions (you 
can skip registration details).

Step 24 When installation of QuickTime is complete, display the installer window where 
installation continues to completion.

Step 25 Installation Complete Panel. Click Close to terminate the MAP Setup 
Wizard. Eject the MAP CD to perform installations on other computers, or store 
it in a safe place when installation is complete.

Step 26 Update Services Properties. For each MAP service, display the properties 
dialog. In the Management window, open Services and Applications > Services. 
In Services, right-click the target service and select Properties.
On the Log On Tab, check This account and assign the local or domain user 
account MAPSERVICES (or other name you created earlier) and the correct 
password as the user account for this service to log on. 
If this service is not going to run on this server (for example, this is a Capture 
server, you can disable Content and Factory services), click the General tab and 
set the Startup type to Disabled. Click OK to update and close.
Click the Recovery tab and select Restart Services for first and second failures, 
and Restart Computer for subsequent failures.

Step 27 Restart the computer to start MAP services, which are set to automatically start.

Note
After restarting your server, you should disable MAP services you do not 
intend to run on this server to improve performance. For example, if you 
are creating a Capture server, disable Content.MAP and Factory.MAP. 
Right-click My Computer > Manage. In the Management window, open 
Services and Applications > Services. In Services, right-click the target 
service and select Properties. Set Startup Type to Disabled and click OK.
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INSTALLING GATEWAY.MAP
You can install Gateway on any MAP services server (even if all services are 
disabled). Gateway.MAP enables ClipMails to deliver media files to MAP, or to 
monitor local folders or network shares for ingesting media into MAP.
When Gateway.MAP is installed, an icon is placed in the tooltray. Before you 
can use Gateway.MAP to deliver media from a ClipMail appliance, you must 
create and configure an account on the ClipMail.

Start the Installer Start the server and log on with a user account with administrative privileges. 
Make sure no other programs are running, virus-checking software has been 
turned off, and you have the MAP Installer CD-ROM.

Step 1 Insert the MAP Installer CD to start the MAP Installer Console.
Figure 3–10.  MAP Installer console’s main window

Step 2 On the main console window, click the Server installation button.
Figure 3–11.  MAPreview server installation options

Tip
Configuring and monitoring Gateway.MAP is described in Using the 
Gateway.MAP Console on page 6-16.
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Step 3 On the Server window, click the Install Gateway button to run the Gateway.MAP 
Setup Wizard and display the Welcome panel:
Figure 3–12.  Gateway.MAP Setup Wizard Welcome window

Step 4 Click Next to view the Telestream MAP license agreement:
Step 5 Telestream License Agreement Panel. After reading the terms of the 

agreement, click I Agree if you agree, and click Next to continue installation.
Step 6 Installation Folder Panel. Select an installation folder. By default, 

Gateway.MAP is installed in the Program Files > Telestream > MAP directory. 
Step 7 To restrict use of Gateway.MAP to the user ID that performed the installation, 

click Just Me. Otherwise, click Everyone.

Step 8 Disk Cost (optional). Click to view details about available disks. Click Next to 
continue to display the Confirm Installation panel.

Step 9 Installation Confirmation Panel. Click Next to install the software. Click 
Back to review settings.
When you click Next the wizard installs the software, and provides a progress bar 
to note installation progress. (Click Cancel to terminate installation.)

Step 10 Installation Progress Panel. As installation progresses, the wizard displays 
the Installation Progress panel. When installation is complete, the Wizard 
displays the Installation Complete panel.

Step 11 Installation Complete Panel. Click Close to terminate Setup Wizard.
You may need to restart the computer for Gateway.MAP to start and operate 
properly. If so, the Setup Wizard displays this dialog:
Figure 3–13.  Click Yes to restart your server

Step 12 Click Yes to restart your server. Gateway.MAP won’t start until you reboot.

Note
When Gateway.MAP is installed, an icon is placed in the toolbar. Use this 
icon to configure and monitor Gateway.MAP. See Using the 
Gateway.MAP Console on page 6-16.
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INSTALLING MAP RATINGS PARSER AND CONFIGURATOR

You install the MAP Ratings Parser and Ratings Configurator to set up and 
process ratings obtained from a provider. The Ratings Parser generates XML 
files with ratings metadata based on configuration file generated by the Ratings 
Configurator, and are available for viewing in MAP Player and MAP Explorer.
MAP Ratings Parser is a Windows service, and may be installed on any 
MAPreview server – usually not the Capture service or Content service server. 
Consider installing the Ratings Parser on a MAP administrative server or 
workstation that is associated with the ratings spreadsheets, that runs continually.
When you run the ratings installer, both the Ratings Parser and the Ratings 
Configurator program are installed. Before you can use the Ratings Parser to 
process metadata, you must create and configure the ratings INI file and set up 
the channel to capture the ratings data.

Run the Installer To begin, start the computer and log on with a user ID that has administrative 
privileges. Make sure no other programs are running, virus-checking software 
has been turned off, and you have the MAP Installer CD-ROM.

Step 1 Insert the MAP Installer CD to start the MAP Installer Console.
Figure 3–14.  MAP Installer console’s main window

Step 2 On the main console window, click the Utilities button.
Figure 3–15.  MAP Utilities installation options
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Step 3 Click the Install Ratings Parser button to launch the Ratings Setup Wizard and 
display the Welcome panel:
Figure 3–16.  Ratings Setup Wizard Welcome window

Step 4 Click Next to select the installation folder:
Step 5 Installation Folder Panel. Select an installation folder. By default, 

Gateway.MAP is installed in the Program Files > Telestream > MAP directory. 
Step 6 To restrict use of Ratings Parser and Configurator to the user ID that performed 

the installation, click Just Me. Otherwise, click Everyone.
Step 7 Disk Cost (optional). Click to view details about available disks. Click Next to 

continue to display the Confirm Installation panel.
Step 8 Confirm Installation Panel. Click Next to install the software.

When you click Next the wizard installs the software, and provides a progress bar 
to note installation progress. (Click Cancel to terminate installation.)

Step 9 Installation Progress Panel. As installation progresses, the wizard displays 
a progress panel. When installation is complete, the Wizard displays the 
Installation Complete panel.

Step 10 Installation Complete Panel. Click Close to terminate Setup Wizard.

Configure the Service When installation is complete, open the Services window (Control Panel > 
Administrative Tools > Services) and right-click the Ratings Parser service 
(RatingsParser.MAP) to display its properties. 
General Tab. Set the startup type to Automatic.
Log On Tab. Select This account and select MAPSERVICES or other local or 
domain MAP user with administrative privileges.
Recovery. Set First and second failures to Restart the service; third and 
subsequent failures: set to Restart the computer.
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ATTACHING MAP USB DONGLES

Before you operate MAP in a production environment, you must attach a MAP 
dongle to a USB port of each server that hosts a MAP service – Content, Capture, 
and Factory.
If you install MAP services on a single platform, only one dongle is required. If 
you plan to operate services on separate platforms (e.g., Capture on one and 
Factory on another), you'll need to order a MAP dongle for each MAPreview 
server when you obtain your license.
You always install MAP on servers before putting a dongle in place, and you 
don't need dongles on computers that are only running the MAP management 
console or MAP client programs.

VIEWING MACHINE ID AND LICENSE INFORMATION

To view license information stored in your dongle, or to display the machine ID 
for obtaining a license, run the License Info program.
In Windows Explorer, open Program Files > Telestream > MAP > License (or 
other location where MAP was installed) and run MAP.License.Info.
Figure 3–17.  License Information dialog

When you run License Info, the machine ID is displayed with license details 
stored in the dongle. If no dongle is present on this computer, the phrase No 
license found is displayed in the License ID field.
When you are obtaining a license from Telestream, double-click to select the 
machine ID and copy and paste it into your license request document. If you 

Note
MAP dongles are obtained from Telestream and are contained in the MAP 
product box. You may install and operate MAP in demonstration mode 
without a dongle, but you may not operate MAP in production without a 
dongle. If no dongle is present on a MAPreview server, the Factory and 
Capture services watermark the media they capture or transcode. 
Content.MAP only allows a single concurrent client connection without a 
dongle.
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select the machine ID by clicking and dragging through the text to highlight it, 
you may miss some of the characters at the end of the string.

UPDATING THE MAP DONGLE

To update the MAP dongle from license information provided, copy the dongle 
update file you received from Telestream (MapDongleUpdate.tdu) to the 
MAPreview server you want to update.
Next, run the Telestream Client Dongle Updater application.
In Windows Explorer, open Program Files > Telestream > MAP > License (or 
other location where MAP was installed) and run RemoteUpdateClient.
Figure 3–18.  MAP dongle license data updater

Click Browse and navigate to the folder where the dongle update file 
(MapDongleUpdate.tdu) is stored and select it.
Click on the Perform Update button. When the Success message displays, your 
dongle has been updated and MAP is ready for use.
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INSTALLING MAP EXPLORER

To install MAP Explorer and MAP Player clients (and the necessary 
components), you should have the MAP Installer CD.
MAP Client installer installs or updates the following software:
• Microsoft J# .NET Runtime
• Microsoft .NET Framework
• Microsoft Windows Media Encoder (9 series)
• Microsoft Windows Media Player
• MAP Player
• MAP Explorer (including a Search Results icon on your desktop)

Start the Installer To begin, start the computer and log on with a user ID that has administrative 
privileges. Make sure no other programs are running, and virus-checking 
software has been turned off.

Step 1 Insert the MAP Installer CD to start the MAP Installer Console.
Figure 3–19.  MAP Installer console’s main window

Step 2 On the main console window, click the Clients tab.
Figure 3–20.  MAP client installation options
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Step 3 Click Install MAP Explorer to run the MAP Setup Wizard. If all of the 
supporting software is already installed, the MAP Setup Wizard will display the 
welcome window (Installing MAP Explorer on page 3-25) immediately.

Install Microsoft .NET 
Framework

The MAP Setup Wizard determines if you need to install the current version of 
.NET Framework. If so, the wizard displays the following dialog.

Step 4 Click Yes to install the .NET Framework and follow the installation instructions.
Step 5 When .NET is installed, click Install MAP Explorer in the MAP Installer 

Console again to continue.

Install Windows 
Media Encoder (9 
Series)

The MAP Setup Wizard determines if you need to install the current version of 
Microsoft Windows Media Encoder 9 Series and displays the following dialog:

Step 6 Click Yes to install Windows Media 9 Encoder and follow the instructions.

Step 7 When Windows Media 9 Encoder is installed, click Install MAP Explorer in the 
MAP Installer Console again to continue installation.

Install J# .NET 
Runtime

The MAP Setup Wizard determines if you need to install the current version of 
the J# .NET runtime. If required, the wizard displays the following dialog:

Step 8 Click Yes to install the J# .NET runtime and follow the installation instructions.
Step 9 When installation of J# .NET runtime is complete, click Install MAP Explorer on 

the MAP Installer Console again, to continue installation.

Install Windows 
Media Player

If Windows Media Player is missing or obsolete, the Setup Wizard prompts you 
to download the installer from the Microsoft Web site and install it. 

Note
If you are installing MAP clients on several computers, you may copy the 
installer to a server directory or make the MAP Installer CD network 
accessible and launch it over the network.
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Step 10 Install: When you click Yes, the Windows Media Player 9 page displays. Click 
the link to download and install Windows Media Player 10 on this page. 
(Windows Media Player 9 is no longer available for Windows XP, and Windows 
Media Player is pre-installed on Windows 2003.).

Step 11 After installation, click Install MAP Services in the MAP Installer Console again 
to continue installation.

Install MAP Explorer The MAP Setup Wizard displays the Welcome panel:
Figure 3–21.  MAP Setup Wizard Welcome panel

Step 12 Click Next to view the Telestream MAP license agreement.
Step 13 Telestream License Agreement Panel. After reading the terms of the 

agreement, click I Agree if you agree, and click Next to continue installation.
Step 14 Installation folder and Security Options Panel. Select the installation 

directory path and permissions using these options:
Step 15 Browse to identify and select the folder where you want the programs installed, 

or accept the default directory path.
Step 16 Check Everyone (default) or Just Me to install software with proper permissions. 

If you check Just Me, only the user account performing the installation can run 
this program.

Step 17 Disk Cost (optional). Click to view details about available disks. Click Next to 
display the Confirm Installation panel:

Step 18 Installation Confirmation Panel. Click Next to install the software.
Step 19 Installation Progress Panel. When you click Next the wizard installs the 

software, and provides a progress bar to note installation progress. When 
installation is complete, the wizard displays the Installation Complete panel.

Step 20 Installation Complete Panel. Click Close to terminate the Wizard and re-
start your computer. Eject the MAP CD to perform other installations, or store it 
in a safe place when installation is complete.
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INSTALLING MAP QUICK REVIEW

To install the MAP Quick Review and MAP Player (and necessary components), 
you should have the MAP Installer CD.
The Quick Review installer installs or updates the following software:
• Microsoft J# .NET Runtime
• Microsoft .NET Framework
• Microsoft Windows Media Encoder (9 series)
• Microsoft Windows Media Player
• MAP Player
• MAP Quick Review Client

Start the Installer To begin, start the computer and log on with a user ID that has administrative 
privileges. Make sure no other programs are running and virus-checking is off.

Step 1 Insert the MAP Installer CD to start the MAP Installer Console.
Figure 3–22.  MAP main installer console

Step 2 In the main console window, click the Clients tab.
Figure 3–23.  MAP client installation options

Step 3 Click Install MAP.review to launch the MAP Setup Wizard.
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If all of the supporting software is already installed, the welcome panel displays 
immediately (Installing MAP Quick Review on page 3-28).

Install Microsoft .NET 
Framework

The MAP Setup Wizard determines if you need to install the current version of 
the .NET Framework. If required, the wizard displays the following dialog.

Step 4 Click Yes to install the .NET Framework and follow the installation instructions.
Step 5 When installation of .NET is complete, click Install MAP Quick Review on the 

MAP Installer Console again, to continue installation.

Install Windows 
Media Encoder (9 
Series)

The MAP Setup Wizard determines if you need to install the current version of 
Microsoft Windows Media Encoder 9 Series and displays the following dialog:

Step 6 Click Yes to install Windows Media 9 Encoder and follow the instructions.

Step 7 When Windows Media 9 Encoder is installed, click Install MAP Quick Review 
in the MAP Installer Console again to continue installation.

Install J# .NET 
Runtime

The MAP Setup Wizard determines if you need to install the current J# .NET 
Runtime. If required, the wizard displays the following dialog:

Step 8 Click Yes to install the J# .NET runtime and follow the installation instructions.
Step 9 When installation of J# .NET runtime is complete, click Install MAP Quick 

Review on the MAP Installer Console again, to continue installation.

Install Windows 
Media Player

If Windows Media Player is missing or obsolete, the Setup Wizard prompts you 
to download the installer from the Microsoft Web site and install it. 

Note
If you are installing MAP clients on several computers, you may copy the 
installer to a server directory or make the MAP Installer CD network 
accessible and launch it over the network.
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Step 10 Install: When you click Yes, the Windows Media Player 9 page displays. Click 
the link to download and install Windows Media Player 10 on this page. 
(Windows Media Player 9 is no longer available for Windows XP, and Windows 
Media Player is pre-installed on Windows 2003.).

Step 11 After installation, click Install MAP Services in the MAP Installer Console again 
to continue installation.

Install MAP Quick 
Review

The MAP Setup Wizard displays the Welcome panel:
Figure 3–24.  MAP Setup Wizard Welcome panel

Step 12 Click Next to view the Telestream MAP license agreement.
Step 13 License Agreement Panel. After reading the terms of the agreement, click I 

Agree if you agree, and click Next to continue installation.
The MAP Setup Wizard displays the Select Installation Folder panel:

Step 14 Installation folder and Security Options Panel. Select the installation 
directory path and permissions using these options:
Browse to identify and select the folder where you want the programs installed, 
or accept the default directory path.

Step 15 Check Everyone (default) or Just Me to install software with proper permissions. 
If you check Just Me, only the user account performing the installation can run 
this program.

Step 16 Disk Cost (optional). Click to view details about available disks.
Step 17 Click Next to display the Confirm Installation panel:
Step 18 Installation Confirm Panel. Click Next to install the software.
Step 19 Installation Progress Panel. When you click Next the wizard installs the 

software, and provides a progress bar to note installation progress. When 
installation is complete, the wizard displays the Installation Complete panel.

Step 20 Installation Complete Panel. Click Close to terminate the Wizard and re-
start your computer. Eject the MAP CD to perform other installations, or store it 
in a safe place.
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INSTALLING MAP SEARCH

Install MAP Search on your MAPreview server to allow users to access MAP 
media via a Web browser. To install MAP Search, you should have the MAP 
Installer CD. 

The MAP Search installer installs a Web site in the Web Sites/Default Web Site 
path, called by default, MAPClient. The MAP Web site is contained in a MAP 
DLL. An XML file is also installed, which you use to configure MAP Search.

Start the Installer To begin, start the computer and log on with a user ID that has administrative 
privileges. Make sure no other programs are running, and virus-checking 
software has been turned off.

Step 1 Insert the MAP Installer CD to start the MAP Installer Console.
Figure 3–25.  MAP Installer console’s main window

Step 2 On the main console window, click the Utilities tab.
Figure 3–26.  MAP utilities installation options

Note
You can not install Web Client on a server until IIS and MAP Services (or 
Content.MAP) have been installed, and the server has been restarted.
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Step 3 Click Install Web Client to launch the Wizard.

Install MAP Search The MAP Setup Wizard displays the Welcome panel:
Figure 3–27.  MAP Web Search Setup Wizard Welcome panel

Step 4 Click Next to view the Telestream MAP license agreement.
Step 5 Telestream License Agreement Panel. After reading the terms of the 

agreement, click I Agree if you agree, and click Next to continue installation.
Step 6 Select Virtual Directory Panel. Select the virtual directory and port. By 

default, MAP Web Client is installed in an IIS virtual directory on the local 
machine under Web Sites/Default Web Site/MAPClient. 
This directory is part of the URL you'll provide to anyone accessing your MAP 
content via a Web browser. 

Step 7 Disk Cost (optional). Click to view details about available disks. Click Next to 
continue.

Step 8 Confirm Installation Panel. Click Next to install the software. Click Cancel 
to immediately terminate installation.
Installation Progress Panel. When you click Next the wizard installs the 
software, and provides a progress bar to note installation progress. 
When installation is complete, the wizard displays the Installation Complete 
panel.

Step 9 Installation Complete Panel. Click Close to terminate the Wizard. Eject the 
MAP CD to perform other installations, or store it in a safe place when 
installation is complete.

Configuring MAP 
Search

As part of initial configuration, you must prepare MAP Search for use by end 
users by performing the following tasks: 
1. Provide a URL that users enter in Web browser to access MAP Search
2. Determine which features are available by configuring XML file
3. Configure an XML file that contains your MAPreview servers
4. Provide a list of live feeds, configured in an XML file 

Note
The default port (80) must be changed to the port you specified when you 
installed and configured IIS (recommended: 8000).
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Forming the MAP Search URL
The URL syntax is HTTP://<MAPServerName>:<HTTPPort>/MAPClient/
Search.aspx. <MAPServerName> is the computer name where you installed 
MAP Web Search, and <HTTPPort> is the HTTP port you assigned to IIS; by 
default, 8000. 
For Example: http://MAPServer07:8000/MAPClient/Search.aspx.
Provide this URL to your end users so that they can run MAP Search from their 
computer and access the MAPreview server to search and play media.

Configuring the Feature List for MAP Search
As part of initial configuration, you need to enable (or disable) features that you 
want end users to use in MAP Search, as specified in the web.config file, located 
at C:\Inetpub\wwwroot\WebClientApplication. 
The default web.config file has the following elements:
<appSettings>
<add key="PlayerEnabled" value="false"/>
<add key="LiveFeedsEnabled" value="true"/>

</appSettings>

Open the file, find the appSettings element, and enter true or false in the 
value element for DeliveryEnabled, PlayerEnabled, and LiveFeedsEnabled.
Save the file after editing your settings.
If PlayerEnabled is true, end users can play media in MAP Player.
If LiveFeedsEnabled is true, then end users can display live feeds (as configured 
by you in the livefeeds.xml file) on the Live Feeds tab.

Creating the MAPreview server List
When users connect to a MAPreview server, MAP Search displays the list of 
MAPreview servers that are specified in the ContentServers.xml file, located at 
C:\Inetpub\wwwroot\MAPClient\App_Data.
The default XML file has the following elements:
<?xml version="1.0" encoding="utf-8" ?>
<contentservers>

<server name="MAPreview_Server" uri="MAPreview_Server">
</server>
<server name="Local" uri="localhost">
</server>

</contentservers>

This is an example file with 4 MAPreview servers:
<?xml version="1.0" encoding="utf-8" ?>
<contentservers>

<server name="MAP LIVE>" uri="map-prod"></server>
<server name="MAP Test" uri="map-test"></server>
<server name="MAP USA" uri="map-dom"></server>
<server name="MAP Local" uri="localhost"></server>

</contentservers>

Open the file, create server elements for each MAPreview server you want end 
users to access fie MAP Web Search, and save the file.
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When a user logs onto MAP Search, the MAPreview server list is populated with 
a list of these four MAPreview servers: MAP Production, MAP Test, MAP 
International, and MAP Local. As the user logs on to a given MAPreview server, 
the list of media folders is provided.
If you create a localhost entry, make sure your users know that they can not use it 
unless they are actually running the MAP Web Search app directly on that 
computer.
The localhost reserved machine name can be used anytime the machine name 
in the URL (where MAP Search is running under IIS) is the same as the MAP 
Content server you want to search on.

Creating the Live Feeds List
If you offer live feeds (configured in the web.config file), you need to configure 
the live feeds XML file as well.
When users connect to a MAPreview server, MAP Search also displays the list of 
live feeds that are specified in the LiveFeeds.xml file, located at 
C:\Inetpub\wwwroot\WebClientApplication\App_Data.
The default XML file has the following elements:
<?xml version="1.0" encoding="utf-8" ?>
<livefeeds>

<feed name="None" uri="None"></feed>
<feed name="Channel1" uri="mms://MAPreview_Server/ch1/">
</feed>
<feed name="Channel2" uri="mms://MAPreview_Server/ch2/">
</feed>
<feed name="Channel3" uri="mms://MAPreview_Server/ch3/">
</feed>
<feed name="Channel4" uri="mms://MAPreview_Server/ch4/">
</feed>
<feed name="All" uri="All"></feed>

</livefeeds>

For each feed you provide, enter a friendly name in the name value field of the 
feed element, and enter the URL of the MAPreview server assigned to the card 
port. Save the file after editing, and test it for accuracy.
When a user logs onto MAP Web Search, the live feeds list in the Live Feeds tab 
is populated. Users can select one or more feeds to view and listen as they 
choose.
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RE-INSTALLING ASP.NET FOR IIS
For Windows XP installations only, if you have installed .NET before activating 
IIS, .NET does not register ASP.NET for use with IIS. The symptom of this 
problem is that when you point to your browser to MAP Web Search, the home 
page doesn't display; instead, three lines of text display in the browser.
To re-register ASP.NET on Windows XP servers, follow these steps:

Step 1 Click start > Run to open the Run window.

Step 2 Type cmd and click OK to open the command window.
Step 3 Run Windows Explorer and open the path My Computer\Local Disk (C) \ 

WINDOWS \ Microsoft.NET \ Framework \ <latest version folder if more than 
one> (for example, V1.1.4322). Verify that the program aspnet_regiis.exe is 
located in this directory.

Step 4 In the Command window, type 'cd ' (cd and a space) and then drag the V1.1.4322 
(or latest) folder into the command window and press enter to change directory to 
this folder.

Step 5 Type aspnet_regiis -i and press Enter to install ASP.NET for IIS.
Step 6 Close the Command window.
Step 7 Open your Web browser and enter the URL http://localhost:8000/MAPClient/

Search.aspx (or substitute machine name for localhost when accessing it from 
another computer) to display MAP Web Search’s Web page. If you selected a 
port other than 8000, use it in the URL. If you selected a virtual directory other 
than MAPClient, also use the new name in the URL.
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C     H     A     P     T     E     R 4

MAP Services Configuration
& Administration
Use this chapter to validate your MAP installation and perform basic up and 
running configuration and administration, including initial configuration of each 
MAP service. (MAP services is a general term that describes the three 
independent but inter-related services that work together in MAP – Capture, 
Content, and Factory.) 
How you configure MAP in production is dependent on your server capacity, 
your media capture, production, and publication requirements, and how you plan 
to use MAP services.

Topics Configuring MAP Services on page 4-2
Configuring System Alerts on page 4-5
Configuring and Using MAP EventReader on page 4-8
Using the MAP Management Console on page 4-10
Content.MAP Administration on page 4-11
Creating Media Folders on page 4-12
Setting Media Folder Properties on page 4-13
Capture.MAP Administration on page 4-19
Accessing Captured Media in Content.MAP on page 4-19
Creating Schedules on page 4-24
Creating Segments on page 4-25
Starting a Channel on page 4-28
Factory.MAP Administration on page 4-29
Distributed Factory.MAP Services on page 4-29
Adding and Removing Factory.MAPreview servers on page 4-31
Managing Media Tasks on page 4-32
Creating a Media Portal on page 4-33
Codecs Properties on page 4-37 

Note
Configuration tasks described in these topics is required before end users 
can take the tours in the MAP User’s Guide.
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CONFIGURING MAP SERVICES

Content, Capture, and Factory.MAP services are configured by default to start 
automatically. On occasion, you may need to stop or start a MAP service, and 
you may also need to modify a specific service’s property. 

You configure each MAP service via the service's Properties dialog. You can also 
use the Properties dialog to start and stop the service or you can start and stop the 
service directly in the Service window.

Displaying 
Services

To display the Services window, right-click My Computer and select Manage. In 
the Computer Management window, open Services and Applications > Services.
Or, open Control Panel > Administrative Tools > Services.
Figure 4–1.  Administrative Tools window

Note
You should disable MAP services you do not intend to run on this server to 
improve performance. For example, if you have a dedicated Capture 
server, disable Content.MAP and Factory.MAP. Right-click My Computer > 
Manage. In the Management window, open Services and Applications > 
Services. In Services, right-click the target service and select Properties. 
Set Startup Type to Disabled and click OK.

Tip
Configuration and connection details are available in the Online Help 
System for each MAP service in the MMC.

Double-click the Services icon 
to open the Services window 
and display all services on this 
server
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Double-click the Services icon to open the Services window.
Figure 4–2.  Stop and start services in the Services window

The Services window displays the services currently registered on this system. 
Capture.MAP, Content.MAP, and Factory.MAP are displayed in the list. The 
status column indicates Started if the service is currently running. Startup Type is 
Automatic, Manual, or Disabled.

Starting and 
Stopping a Service

The MAP installer installs all three MAP services. In a single MAPreview server 
installation, you may not be using Capture.MAP, so you should disable it. In a 
distributed MAP installation, be sure to disable services on each MAPreview 
server that are not being used. For example, on a Capture server, turn off Factory 
and Content, and on the Factory and Content server, you might disable 
Capture.MAP, based on your multi-server configuration plan.
To start or stop a service, right-click on it and select Start or Stop from the 
context menu. You can also start and stop a service in the Properties dialog (see 
Setting Service Startup Type, below).

Modifying 
Services Settings

To review or change a service's settings, display the Properties dialog. Make 
changes and click Apply to update the settings, then click OK. To display a 
service’s Properties dialog, double-click its entry in the Services window.) The 
figures following refer to Capture.MAP, but the settings are the same for all three 
MAP services.)

Capture, Content, and 
Factory MAP services 
operate as Windows 
Services.
Right-click a service to 
start or stop a service, or 
display the Properties 
dialog to adjust settings.
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Setting Service 
Startup Type

Use the General tab (Figure 4–3) to change the service startup type, and start or 
stop the service.
Figure 4–3.  Capture.MAP properties

Unless you have a specific startup requirement (especially on a single-server 
MAP system), leave the startup type as Automatic. In cases where a service is not 
needed, or in a multi-server MAP installation, set the startup type accordingly.
In a multi-server installation, you should disable the services that you are not 
going to operate on that server or uninstall them. For example, on a capture 
server, disable Factory and Content services. On the Content server, disable 
Capture service and Factory services.
Automatic. Select to start the service automatically when the server starts.
Manual. Select to prevent the service from running when the server starts, and 
you'll start the service when you need it or when a console is displayed.
Disabled. Select to prevent the service from being started by the system, a user, 
or a dependent system, such as a console.

Stores Credentials MAP services need to be modified to log on as a user that has read/write 
privileges to the stores where media is located and administrative privileges, 
either in a workgroup or domain environment.
On the Log On Tab, check This account and assign the local or domain user 
account MAPSERVICES (or other name you created earlier) and the correct 
password as the user account for this service to log on.
The default Local System account may be insufficient, because it may only 
provide authority to access directories and files on the local server.
MAP user accounts should have permission to access all necessary MAPreview 
servers, and have read and write permissions for each directory or share where 
media is stored.

You can also start and stop a 
service here.

Click here to select the 
service's startup behavior.
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Restart After Failure Use the Recovery tab (Figure 4–4) to set up how Windows should control each 
MAP service after a failure.
Figure 4–4.  Use the Recovery tab for service restart options

You can select options for first, second, and subsequent failures, and other 
settings as required. Telestream recommends setting the first and second failures 
to Restart Service, and subsequent failures to Restart Computer.

CONFIGURING SYSTEM ALERTS

System Alerts are used to monitor and/or report error conditions that may arise 
on a MAP system. It is very important to configure System Alerts so that MAP 
administrators or IT personnel are informed immediately when MAP errors occur 
or when MAP requires immediate attention to solve an eminent problem, such as 
low disk space on a Capture server.
These examples can also be used to create and modify other alerts to meet MAP 
requirements in your installation. 
MAP provides a default set of system alerts that should be modified before 
implementing MAP in production. The following procedure illustrates how to 
modify the default MAPAlert:

Step 1 Open Control Panel > Administrative Tools > Computer Management Window.

Step 2 In the Computer Management window, expand Performance Logs and Alerts.

Specify how the service is 
restarted after a failure by 
selecting options from these 
popup menus
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Step 3 Select Alerts (left panel) and (in the right panel) right-click MAPAlert > 
Properties.
Figure 4–5.  MAP default system alerts

Monitoring MAP Services
The MAPAlert system alert provides four error counters by default. These 
counters monitor for .NET exceptions thrown by the Capture, Factory and 
Content services respectively. 

Step 4 On the General tab, remove counters for services you have disabled on the target 
MAPreview server. Then change the alert limit on each active counter to zero, to 
generate an alert when a service exception is thrown. 

Step 5 On the Action tab, check the options to occurs when an alert is triggered.

Monitoring MAPreview server Storage Space
The fourth counter monitors the total storage space on the target (local) 
MAPreview server. By default it is set to issue an alert when the total available 
storage space is under 5%. Adjust this value to reflect the value limit you want to 
notified of, check the options to occurs when an alert is triggered.

Set Limit value to 0 for 
active MAP services on 
this server.
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Add additional counters, to monitor individual drives or partitions, or other 
options, such as CPU load.
Figure 4–6.  Use the Recovery tab for service restart options

You can select options for first, second, and subsequent failures, and other 
settings as required. Telestream recommends setting the first and second failures 
to Restart Service, and subsequent failures to Restart Computer.

Specify how the service is 
restarted after a failure by 
selecting options from these 
popup menus
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CONFIGURING AND USING MAP EVENTREADER

EventReader provides email alerts when a MAP error occurs. To start 
EventReader, click Start > Programs > Telestream > MAP > EventReader. 
To view logs and their entries, in the system tray, right-click the EventReader 
icon and select Event Viewer.
Figure 4–7.  Use the MAP event log to view MAP errors

For each event entry in the log, a line item displays details. Double-click any 
event to display the event’s properties.
Figure 4–8.  MAP errors generate events, which you can view

Configuring 
EventReader

You can configure EventReader to monitor a specific log for an event type, and 
send an email when it is triggered.
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Step 1 In the system tray, right-click the EventReader icon and select Configure. By 
default the EventReader monitors the MAP (Event) Log for event errors.
Figure 4–9.  Configure EventReader to send email when MAP errors occur

Step 2 Select an event log to monitor (default: MAP Log).

Step 3 Select a type of error to filter from the dropdown list.

Step 4 Provide an email address to be notified (a standard email address, an SMS email 
address, or a mobile phone email address).

Step 5 Enter the Email server name or IP address.

Step 6 Enter the address that will appear as the 'From' address.

Step 7 Enter an authentication account if needed (include domain if needed).

Step 8 Enter an account password if needed.

Step 9 Check Run On Setup and click Apply.
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USING THE MAP MANAGEMENT CONSOLE

The MAP management console provides centralized control over the 
configuration and setup of each Capture, Content, and Factory service running in 
your MAP system. 

Starting the 
Management 
Console

Open the MAP management console(Figure 4–10 on page 4-10):
In MAP Explorer (Media Application Platform (MAP) icon under My Network 
Places highlighted) double-click the Manage services icon
–or–
Click start > All Programs > Telestream > MAP > MAP Management.
The management console displays each Content, Capture, and Factory.MAP 
service it is managing in the tree on the left.
Figure 4–10.  Manage services in Windows management console

By default, the MAP services running on your local computer (in a single-server 
system) are automatically connected and identified as localhost. Open each 
service to display its contents. You can also connect distributed MAP services to 
this console (Adding Distributed Services to the Console on page 5-2).

Note
Examples of using the management console for configuring MAP services 
are located in Chapter 4, Guided Tours on page 4-1. Details about using 
each MAP console are provided in Online Help – select the console icon 
(Capture, Factory, or Content) and click the Help icon in the toolbar.
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CONTENT.MAP ADMINISTRATION

Most Content.MAP administration can be performed by end users directly in 
MAP Explorer. However, the management console may also be used to perform 
many of the same tasks, and must be used when managing distributed 
Content.MAPreview servers. You can also use the console to add top-level media 
folders and establish their properties.

Top-level media folders are published by Content.MAP for access by end users 
using MAP Explorer (a special MAP extension of Windows Explorer), and 
MAP-specific programs including MAP Player, MAP Quick Review, and third-
party media programs.
A MAP media database with a single top-level folder is the simplest way to store 
media in MAP. A single top-level media folder provides end users access to all of 
the media in MAP through a single folder. On each media folder, you can right-
click and select New > Folder to create multiple hierarchical folders for 
organizing media to meet your requirements.
If access to media in your MAP system should be restricted by a person’s or 
organization’s role, by organizational responsibility, or on a project-by-project 
basis, you can create several top-level folders for storing media. To restrict 
access, you use user and group IDs that have been established using Windows 
Users and Groups security to set up credentials and authentication requirements 
on each folder to limit access to content and also to control activities such as 
reading, changing, or deleting media or metadata files.

Note
Before end users can use MAP, at least one top-level media folder must 
be created in the media database. Media folders are directories in MAP for 
acquiring and storing media from three sources: Capture.MAP, media files 
added by end users via drag and drop, and media saved from media 
production and editing programs. 
The media folders (which constitute the design of the media database) 
and their content (media, metadata, and associated data files) are all 
controlled and published by Content.MAP.
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Creating Media 
Folders

To create a top-level media folder, open the Content.MAPreview server icon to 
display the Content.MAP service. 

Open the service to display the Label Designs and Media Folders icons.
Figure 4–11.  Creating new media folder

To add a top-level media folder, right-click the Media Folders icon and select 
New > Folder. Content.MAP creates a new folder in the detail panel on the right, 
under Media Folders (when open) in the directory tree panel on the left.
Right-click the New Folder icon in either panel and select Rename to name this 
folder (the department or media project, for instance).
Figure 4–12.  Top-level folders in the media folders panel

Media folders are organized to facilitate workflow in your environment. For 
example, in a media production environment like a TV station, you might set up 
a media folder for each news cast, and include media folders inside for raw, edits, 
review, and final.

Note
You can also create media folders and set their properties directly in MAP 
Explorer by providing appropriate read, write, change, and delete 
privileges. Performing administrative tasks in MAP Explorer simplifies 
management of MAP services running on a local server.

Note
When you install MAP, the services connect (by default) to the server as 
localhost (the same computer on which the console is running).
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Setting Media 
Folder Properties

Media folder properties allow you to customize individual media folders or 
folder groups. Each media folder can be customized for specific functionality 
based on access, storage, expiration, versioning and metadata requirements.
For each media folder, you create a distinct set of properties which controls 
(among other things) how you access its media, where the folder actually stores 
media, when it expires, if other versions are created, and what kind of metadata is 
extracted. Media folders inherit properties from the parent folder by default, 
although you can override any property. In most cases, you’ll inherit most 
properties, making it easy to set up a new media folder.
The Media Folders directory is the root folder in the media database, and 
provides default property settings for each media folder you create. If you want 
to change a property of all media folders in your MAP system, change the default 
properties of the (root) Media Folders folder. To display a media folder’s 
properties, right-click on the folder and select Properties. Each folder has 
properties displayed in a different tab:
• General (General Media Folder Properties on page 4-13)
• Authentication (Establish Media Folder Security on page 4-14)
• Access (Controlling User and Group Access on page 4-14)
• Storage (Establishing Storage Depots on page 4-15)
• Expiration (Setting Media Deleting Rules on page 4-16)
• Notify (Setting Media Deleting Rules on page 4-16)
• Versions (Creating New Versions on page 4-17)
• Metadata (Specifying Metadata on page 4-18)

General Media Folder 
Properties

Use the General properties tab to create read-only or hidden media folders.
Figure 4–13.  Media folder authentication properties

To make media in a specific folder viewable without allowing modifications to 
metadata for example, check Read Only. You may also have a media folder that 
you want to prevent clients from browsing – check Hidden.

Note
For complete details about configuring each tab’s properties, see the MAP 
User’s Guide.
May 2008 4-13



MAP Services Configuration & Administration 74-0053-01
Establish Media 
Folder Security

The Authentication tab allows you to select an authentication method, and 
optionally, all enclosed sub-folders. By default, each media folder you create 
inherits the properties of its parent. In the case of a top-level folder, 
authentication is set to Anonymous access.
Figure 4–14.  Media folder authentication properties

MAP uses Basic Web server authentication and allows administrators to select 
alternative methods of authentication. MAP supports Anonymous access, Basic 
Authentication in a Workgroup environment, and Windows Authentication 
(challenge/response) based on the user’s current logged on credentials.
By default, Anonymous is checked. To change the authentication method, select 
Use the following permissions and select the authentication method to employ. 
Check Apply to subfolders to apply the authentication method to all sub folders.

Controlling User and 
Group Access

Use the Access tab to specify which users and groups have access to media, and 
what type of access – Read, Write, Delete, and Change, or any combination.
Figure 4–15.  Media folder Access properties

By default, anyone can access a folder’s content via MAP Explorer or other 
client. To enforce security, select Use the following Permissions. Then, click Add 
and select each user or group to check the types of operation the entity is allowed. 
As always, click Apply to subfolders to apply this property to all media folders 
inside this media folder.
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Establishing Storage 
Depots

The Storage tab specifies the physical locations – storage depots – for content 
delivered through drag-n-drop or saved from a 3rd party media program, and for 
newly-created versions (performed automatically, based on Versions settings).
Storage for media should be established on the Content server by creating one or 
more folders, then specifying them as storage depots. Storage depots for captured 
media is established separately, using the Capture.MAP management console on 
the Capture server, and also referenced in this property dialog.
Figure 4–16.  Media folder Storage properties

For each storage depot, two identities may be supplied. The first identity 
(Location) is the physical location in fully-qualified form (file:///C:/
MediaFolder) where the storage location is specified. By default, media is stored 
in Documents and Settings/All Users/Application Data/Content.MAP. You can 
add as many stores as required.
Storage depots are used in parallel; when MAP saves media, it is stored in the 
depot with the largest amount of free space.

Figure 4–17.  Media folder Storage properties and Depot properties

The second identity (Alias) is used to publish and provide access to media from 
external systems including IIS, media servers, or FTP servers, for example. For 
details about setting up an alias, see Creating Aliases for Web Access, on 
page 6-8.

Click Use the following storage 
locations, then click Add to 
specify additional Content.MAP 
storage locations and 
Capture.MAP storage locations 
that should be accessible to 
Content.MAP.

Enter the physical storage 
location here.

If this storage location is used by 
Capture.MAP, check this box.

Enter an alias network 
location here.
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Setting Media 
Deleting Rules

Use the Expiration tab to establish when (or if) media in this folder should be 
automatically deleted.
Figure 4–18.  Media folder Expiration properties

By default, content never expires. If you configure a folder to expire media, 
Content.MAP notifies Archive.MAP when the media expires. Archive.MAP is 
responsible for copying the media onto DVD (or other storage medium) and 
notifying Content.MAP where it is stored for later retrieval. The archiving 
process allows you to automatically age media and move it off of primary storage 
as its value and utilization diminishes. 
When you expire media, be sure to click the Versions tab, and check Create the 
following versions (even if the only version is the Master original) so that you 
can modify the Versions properties (Original, for example). Select the version 
and click Properties, then in the Version tab, check the options for actions you 
want performed when the binder expires.
To make changes to the target media folder’s expiration rules (rather than 
inheriting the parent folder’s expiration rules), check Use the following 
expiration rules; then set the expiration rules you want for this media folder (and 
optionally, its subfolders).
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Setting up 
Notification Rules

Use the Notify tab to set up emails that are automatically generated when new 
versions of media are created (using the Versions tab).
Figure 4–19.  Media folder Expiration properties

To send emails when new versions are created, check Use the following 
Notifiers, then click Add to create a notification.

Creating New 
Versions

Use the Versions tab to automatically create new copies of media placed in this 
folder. Content.MAP sends transcoding jobs to Factory.MAP to produce new 
versions of the master file in this folder, whether it is dropped in manually, saved 
from a 3rd party media program, or created from Capture.MAP.
Figure 4–20.  Media folder Versions properties

You can create one or more versions of media, and each new version may be 
stored in a different location. Versions can be created with QuickTime, Real, 
Windows Media, and MPEG1 System Stream encoders, for example. 
Each version is displayed in the Versions list. Select a version and click 
Properties to display the Properties dialog where you specify individual codec 
parameters, encoders, and filters to be used during transcoding and whether the 
version will be created automatically of rendered upon the user’s request. Details 
about codecs, encoders, and filter settings are located in Online Help.
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To create a version or set of versions that is different from this media folder’s 
parent versions, check Create the following versions. Then, click Add to create 
the versions you want to be created for media ingested into this media folder (and 
optionally, subfolders).

Specifying Metadata Use the Metadata tab (Figure 4–21) to determine which metadata to attach to the 
media in this folder.
Figure 4–21.  Media folder Metadata properties

Metadata includes track metadata such as closed caption, and keyframe, for 
example. You can also include general content information and add values or 
pass them through.
To create metadata that is different from this media folder’s parent metadata, 
check Use the following metadata. Then, click Add to add metadata you want to 
be created for media ingested into this media folder (and optionally, subfolders).
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CAPTURE.MAP ADMINISTRATION

The MAP management console is used to administer Capture.MAP by setting up 
capture devices and channels to digitize and store live feeds based on a schedule.
Since the media you want to view (your competitor’s newscast, for example) is 
broadcast live, you can configure your capture server with a capture card 
connected to an off-air feed, a satellite or cable network, and configure channels 
and schedules to digitize and store each newscast throughout the day.
A channel in MAP is an entity that identifies and controls a media capture device 
that encodes media on a schedule you set up, and stores it automatically.

Accessing 
Captured Media in 
Content.MAP

If you are capturing live media in Capture.MAP, in addition to the required 
Capture.MAP setup tasks below, you need to reference the captured media in 
Content.MAP so that clients (MAP Explorer, MAP Player, etc.) can browse, 
manage and play the media. For example, you can create a media folder in the 
root media folder and name it Live, or Channel 7, etc. In its properties, check use 
the Following storage locations and reference the physical store (and optionally, 
an alias). For details, see (Accessing Captured Media in Content.MAP).

Step 1 Install the capture device(s) and its software on the Capture.MAPreview server, 
according to the manufacturer’s instructions.

Step 2 Restart the server so that it recognizes the hardware. Perform any other 
configuration and set up recommended by the manufacturer.

Step 3 Test the proper operation of the capture card or device, using Windows Media 
Encoder and Windows Media Player to insure proper functionality.

Step 4 After a successful test of the capture device, create and configure a Capture.MAP 
channel to use the device.

Add and Configure a 
Capture Card

To capture live media and save each segment as files in MAP, you need to 
configure the Capture server and set up a channel, including a schedule:

Step 1 Identify a capture server.

Step 2 Specify media stores.

Step 3 Add and configure channels.

Step 4 Create schedules.

When you’ve completed these steps, start the channel(s) so Capture.MAP will 
begin recording and saving segments according to the schedule.

Launch the MAP 
Management Console

Open the MAP management console from start >Programs >Telestream > MAP 
> MAP Management, or when MAP Explorer is active (Windows Explorer with 
Media Application Platform (MAP) icon under My Network Places highlighted) 
double-click the Manage services icon.
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Add a Media Store Before you can begin capturing media, you need a place to save the file as it is 
being recorded. When you install MAP, no capture store is identified. Stores for 
capturing media segments are specific to each server running Capture.MAP. 
In most cases, you should specify the capture store or stores on hard disks 
residing directly on the Capture.MAPreview server. This serves two purposes: 
First, it optimizes the capture of real-time media by writing files directly to a 
local disk. Secondly, it reduces the risk of storage access by eliminating a 
network connection that may fail or slow down due to other network traffic.

Create, Share, and 
Specify a Store

To add a store, first create a folder to store captured media. On the drive where 
you wish to store the media, create a new folder and provide a folder name. 

Next, right-click to select Sharing and Security. 

In the Sharing Tab, click Share this folder. The Share name defaults to the folder 
name, which may be changed. For this tour, leave it the same.
Next, click Permissions, then select Everyone (or a specific set of users for more 
security), and check Allow Full Control.
Click OK to save the settings and dismiss the dialog. The icon for the selected 
folder should display with a hand, indicating sharing is turned on. 

With the folder created and shared, click the Add Store icon in the Stores panel 
on the right. Capture.MAP displays the Browse for Folder dialog.
Figure 4–22.  Browse For Folder dialog

Note
In most cases you should specify the store as a UNC path, even though 
the store is local to the server. This makes the store as universally 
accessible as permitted in a network, and provides a common network 
path for access to the media by all users (local and remote) and preserves 
the application’s ability to access the file in the most efficient manner.

Caution
Drive and folder sharing and its permissions is a complex topic, and 
affects the security of your media. Be sure to work with your security 
administrator to determine who to share directories with. These 
settings are for tour purposes only.

Note
Depending on your Windows configuration, sharing dialogs may vary.
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Navigate to and select the folder (Figure 4–23) where you want media from this 
Capture server to be stored. It may be a local hard drive, network server, RAID, 
SAN, or other storage device.
To specify a UNC path for a local store, navigate through My Network Places > 
Entire Network > Microsoft Windows Network > MyCompanyDomain (or 
MyWorkgroup) > MyCaptureServer > MAPCaptureMedia, where 
MyCompanyDomain, MyCaptureServer, and MyCaptureServer are specific to 
your installation. UNC paths should always be used to eliminate ambiguity when 
accessing or storing media on network servers.
Figure 4–23.  Locate and select the directory

Click OK to continue.
When you create a store, Capture.MAP interrogates the service to determine how 
much space is available on the volume, and reports other details as well. You can 
add as many stores as you need depending on your storage needs.

Add and Configure a 
Channel

A channel in MAP is a logical definition of a specific capture device on a server, 
plus schedules that contain information about when segments are to be captured.

Adding a Channel
To add a new channel, right-click on the icon of the server where the capture 
device is located, and select New > Channel (Figure 4–24). Capture.MAP adds a 
new channel under the server, named New Channel. Expand the server (if it is 
collapsed) to display channels you’ve defined on this capture server.
Figure 4–24.  Adding a channel in MMC
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Configuring a Channel
To configure the channel, right-click the channel icon and select Properties to 
display the Channel Properties dialog. When you select a channel, the channel 
details and a video monitor are displayed in the right frame of the console.

Setting Schedule 
Options

Use the General tab (Figure 4–25) to name the channel and specify how it starts 
(Telestream recommends setting startup to Automatic).
Figure 4–25.  Channel General properties window

You also specify basic information about when the schedule starts, which day the 
week begins (used by the scheduler), what hour the schedule begins (when 
recording a live feed from a different time zone, for example), segment overlap 
time (to insure no loss of media during segment transitions), and schedule 
expiration details.

Specifying Encoder 
and Destination

Use the Capture tab (Figure 4–26) to select the encoder parameters and the media 
folder that will be used to store this media’s information. The media folder is a 
folder you created in Content.MAP as the location for each segment created by 
Capture.MAP according to segments in the schedule.
When a media segment is created, Content.MAP automatically creates a sub-
folder chain in the selected folder: Folder Name\Channel Name\Schedule 
Name\Year\Month\Day\Segment File Name.
Figure 4–26.  Channel Capture properties
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Capture.MAP uses the Windows Media 9 encoder exclusively. Click Modify to 
change the WM9 default encoder settings.
Next, select the channel’s default media folder. This is the media folder that will 
contain all of the information gathered about the captured media. Under Media 
Folder, click Select and browse and select the top level folder. The media folder 
should be selected by navigating through My Network Places > Media 
Application Platform (MAP) so that a UNC path is created. Prior to selecting this 
media folder, you must connect to the target media folder using the Add a Media 
Folder wizard.
As the file for this capture segment is being captured, Capture.MAP will notify 
Content.MAP of the location where the physical media file is stored. 
Content.MAP will create a folder tree under the top level media folder in the 
following format:
TopLevelFolderName

ChannelName
Year

Month
Day

SegmentName

Audio and Video 
Settings

Use the Settings tab (Figure 4–27) to choose your input video and audio input 
devices and configure broadcast settings.
Figure 4–27.  Channel Settings properties

Click in the right column of Audio source and select an audio device.
Click in the right column of Video Source; select a video capture device. 
If the capture device has multiple video input types, set this to the appropriate 
type by expanding Video Source and adjusting the Input value.
Open Broadcast if collapsed, and select the Enabled property. Change its value to 
True so that Capture.MAP can stream the live captured media allowing the user 
to watch the media as it is captured.
If the live stream generated by the Capture.MAP encoder is intended for viewing 
by more than two clients, you should consider controlling the steam via a 
Windows Media Server publishing point. The publishing point is used as the 
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alias to the live stream. For example, you have a channel broadcasting the live 
stream on port 10000. The publishing point is http://MAPCaptureServer or <IP 
Address>:10000.
The encoder process on a MAP Capture server is limited to 5 concurrent 
connections, including any stream connections within MAP services. Managing 
connections to the live streams is best handled using Windows Media Services.

Selecting an 
Automatic Scheduler

Use the Providers tab (Figure 4–28) to choose an automatic scheduler for this 
channel. You can also set up ratings data files and As Run automation logs.
Figure 4–28.  Channel Providers properties

Click to select TV Schedule, and click Configure to select the channel for which 
you want a schedule automatically generated.
Click to select Ratings or As Run, and click Configure to enter the path where the 
ratings files or As Run logs are located.
Refer to [Tour 10] Creating Schedules in Capture.MAP in the Quick Start Guide, 
for a tour about creating schedules and using the Auto Scheduler.
Click OK to update the settings and close the Properties dialog.

Creating 
Schedules

Right-click the new channel and select New > Schedule. The schedule properties 
dialog displays, where you provide an appropriate schedule name and set up 
schedule details.
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Schedule Properties Schedule properties (Figure 4–29) consist only of the schedule name, the type 
(day, week, etc.), and the start and stop times.
Figure 4–29.  Name the schedule, specify the type and time period

For this schedule, select Daily, and change the ending date to one year later than 
the beginning date. Click OK to save and close the dialog.

Creating 
Segments

Next, click the schedule to display the schedule frame (Figure 4–30), where you 
create the segment by identifying the start and stop times.
Figure 4–30.  Create a new segment in the schedule frame

To create a segment schedule, click and drag from 5 PM to 6 PM. It’s OK to be 
approximate—once you create a segment, you can right-click to display the 
properties and adjust the time as appropriate. 

Segment Properties To display the Segment Properties dialog, right-click anywhere in a segment and 
select Properties. Segment properties include General, Capture, and Labels.

Note
The scheduler permits segments as short as five minutes. Short segments 
can be difficult to manipulate or see in the default view. Use the zoom 
feature by right-clicking in the schedule frame to zoom in.
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Setting Segment 
Name and Times

Use the General tab (Figure 4–31) to name the segment – 5oclocknews, for 
example. You can also adjust the start and end times.
Figure 4–31.  Segment properties – General tab

Specifying Encoder 
and Destination

Each segment inherits the encoder and media folder properties from the channel. 
However, a schedule segment can override inherited properties.
Figure 4–32.  Segment properties – Capture tab

Modify these properties on a segment by segment basis if you want them to be 
different than the channel the segment belongs to.
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Setting up Metadata Use the Labels tab (Figure 4–33) to add metadata labels, and to add or make 
changes to the values in each metadata label.
Figure 4–33.  Segment properties – Labels tab

Click OK to save these settings and dismiss the Properties dialog. 
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Starting a Channel With your capture device set up and the segment schedule created, click on the 
channel (Figure 4–34) to display the channel details. (The console reminds you if 
you have made changes to the schedule and haven’t saved them yet—click Save 
to proceed.)
In the details frame, click Start Channel. Capture.MAP starts the channel and 
checks the schedule to begin recording at the correct time. Since your schedule 
indicates recording should start, you’ll see it begin recording, and broadcasting 
the media if Broadcast > Enabled is set to True.
Figure 4–34.  Capture.MAP channel details and video monitor

The channel details frame displays information about capture, system, video and 
audio. To the right is a player window with controls. If you enabled broadcast, 
the media can be displayed in the player window when the play button is clicked. 
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FACTORY.MAP ADMINISTRATION

The MAP management console is used to administer Factory.MAP, which 
involves adding distributed Factory.MAP services (if you have any) to the 
console, and configuring distributed Factory services.
You also use the console to create and manage media portals and their tasks.

Distributed 
Factory.MAP 
Services

MAP can be configured to utilize multiple, distributed Factory servers for 
transcoding or analyzing MAP media. The local MAP Content server distributes 
Factory tasks to connected Factory services based on the current load factor on 
each factory.
The load factor is a numeric value that each Factory server provides to 
Content.MAP when a job is being distributed. Each factory computes its load 
factor by dividing its maximum concurrent process setting (2 by default) by the 
number of jobs it is currently processing. This fractional value represents the load 
for the MAP Factory server.
Content.MAP service distributes the current job to the Factory server with the 
lowest load factor at the time of the query. 

Steps to Configure 
Multiple Factory 
Services

To configure Content.MAP for multiple Factory services, perform these tasks:

Step 1 Install and start Factory.MAP services.

Determine how many factory servers you need. Then, install each Factory service 
and restart the server. Make a list of the name of each Factory server.
For a specific Factory server to properly access and process media files directed 
to it by a Content server, the Factory service must be running under an account 
that has the requisite credentials to access the source media's physical storage 
location.
Telestream recommends that the account specified as the Log On identity for the 
MAP Content service (on the MAP Content server) is also used as the Log on 
Identity for the MAP Factory service on each Factory server you add to the 
Factory.MAP management console for processing tasks.
For example, if the Content service is running under the MyDomain/MAPUser 
account, each MAP Factory service on each MAP Factory server should be 
configured to run under the MyDomain/MAPUser account as well.

Step 2 Add each Factory to the management console.

Note
The multi-factory configuration is stored in the local MAP Content 
server database. Make sure that you are adding Factory services to 
the MAP Management Console locally, or directly, on the MAP Content 
Service that you want to distribute factory tasks.
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For each Factory.MAP you've installed on another server, right-click the 
Factory.MAP icon and select Add Server from the popup menu. The console 
displays the Browse for Computer dialog. Locate the server or enter its name in 
the text field and click OK to connect it to this management console and update 
the local Content Server database.
When you add a Factory, it is displayed in the list under Factory.MAP.

Step 3 Optionally, modify the maximum concurrent processes per factory.

Modifying Maximum 
Concurrent 
Processes

A single server running Content and Factory services should be restricted to two 
concurrent Factory processes. If Content service is heavily utilized (more than 
ten clients are connected, large volumes of media is being ingested and analyzed, 
or there is a heavy transcoding load), it is recommended that the local MAP 
Factory service processes be set to zero and distributed Factory server be used to 
process all Content.MAP requests.
A server running Factory service exclusively can be set to process up to five 
Factory job processes concurrently.
To modify the number of concurrent MAP Factory job processes follow these 
steps on each MAP Factory server.

Step 1 Open the Registry Editor (REGEDIT). Open the Run dialog (Start > Run). Enter 
regedit in the Open text field and click OK.

Step 2 In the Registry Editor Navigate to this key:
HKEY_LOCAL_MACHINE\Software\Telestream\MAP\Factory.

Step 3 Right-click the Factory key and select New > String Value. Enter a new name: 
limit

Step 4 Double-click the limit string to display an Edit String dialog.

Caution
Editing the registry incorrectly may cause your MAP system to fail, 
or your server to stop operating correctly. Back up your registry so 
you can restore it if you make an error. If you are unsure of how to 
back up the registry or perform editing correctly, check with your 
system administrator.
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Step 5 Enter a numeric value that represents the maximum number of concurrent jobs 
for this Factory service. Click OK and close the Registry Editor.

Step 6 Restart the service or reboot the server for changes to take effect.

To illustrate the effect of maximum concurrent processes on the load factor, note 
that a Factory with 8 maximum processes that is currently processing 3 tasks has 
a factor of 3/8, while a Factory with the default 2 maximum processes running a 
single job has a factor of 1/2. So, the factory running 1 job has a lower load factor 
than the Factory running 3.

Adding and 
Removing 
Factory.MAPrevie
w servers

The management console maintains a list of Factory.MAP services to which it is 
connected and is currently monitoring. The management console automatically 
connects to the Factory.MAP service running on the same server, if any. If you 
have installed additional Factory.MAP services on other servers, you can connect 
to them and monitor them from a single console. You can also remove them at 
any time. Disconnecting a Factory.MAP service from a management console 
does not disable or uninstall it, or affect its operation in any way.

Adding a 
Factory.MAPreview 
server

To add a Factory.MAP service you've installed and is operating on another 
server, right-click the Factory.MAP icon and select Add Server from the popup 
menu. The console displays the Browse for Computer dialog. Locate the server 
or enter its name in the text field and click OK to connect it to this management 
console.

Removing a 
Factory.MAPreview 
server

To remove a Factory.MAPreview server, click or open the Factory.MAP icon to 
display the list of servers. Right click on the server icon in the discovery tree 
panel or the details panel and select Delete. The console displays a Confirm 
Server Disconnect dialog. Click Yes to delete it, or No to cancel.
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Managing Media 
Tasks

Click the Media Tasks icon to display a list of tasks operating on media (or other 
files) in binders, plus details about the task. These tasks include rendering new 
media for storage in media folders, and for analyzing and extracting metadata, or 
for indexing text in associated files, for example.

Resume
Select a task from the list and click Resume to re-start a task that had previously 
been paused, which you are ready to start processing again.

Pause
Select a task from the list and click Pause to temporarily halt a tasks that is 
currently being processed.

Retry
Select a task from the list and click Retry to re-submit the task that had 
previously failed, which you are ready to process again.

Table 4–1. Media Tasks Table

Column Description

Name The name of the binder the task is being performed on. 

Task Specific type of task being performed - Analysis, or Render, 
for example. 

Done Displays the approximate percent of completion for this task. 

Rate Displays the approximate transmission speed for delivery 
tasks. 

Remaining Displays the approximate time remaining until completion of 
this task. 

Date Displays the date and time stamp that indicates when this 
task was completed. 

Status Provides information that may help you determine why the 
transcoding request failed. Some failures may be due to 
circumstances external to Factory.MAP. For example, there 
may be an authority or authentication problem when 
accessing the share, or there may be insufficient disk space 
on the volume. In these cases, you may be able to rectify the 
problem, and retry the request. Other times, the failure may 
be due to content in the media file, a missing encoder, an 
encoder assigned to a misnamed file suffix (an MPEG file 
named .wmv, for example) or other media-related problem.
You can optionally delete the request, rectify the problem, 
and resubmit the request manually. To submit a request 
manually, select the media file in the binder in Content.MAP, 
right click and select the request option from the render 
menu.
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Delete
Select a task from the list and click Delete to delete the task from the task queue.

Creating a Media 
Portal

You create a media portal when you want to transcode and deliver media to 
external media system by dragging and dropping media files onto a media portal 
in MAP Explorer.
To create a new media portal, display the management console or the 
Factory.MAP operator console.
In the management console, click the New icon in the Factory.MAP service 
where you want to create the portal.
In the operator console, display the Media Portal tab and click the New icon in 
the toolbar at the bottom.
Factory.MAP displays the Create a Media Portal window. Select an encoder for 
this portal or select Copy to reproduce the original file in the same format. Click 
Next to continue.
Factory.MAP displays the Portal Properties dialog for the new portal. When 
you're done reviewing and updating settings and values in each of the tabs, click 
OK to create the media portal.

Using the Network 
Location Wizard

When you're creating a media portal, click Browse on the media portal's 
Properties dialog, General tab to run the Network Location Wizard. The purpose 
of the wizard is to help you correctly format the fully qualified connection 
scheme for the type of device you're targeting as a destination. The wizard has 
several windows, which vary depending on the type of server you select.

Welcome Window
Select the type of server you're targeting from the dropdown list.
FTP Server
HyperLaunch Receive Server
Local Drives or Network File Shares
Network File Share (Different User Name and Password)
Secure HyperLaunch Receive Server 

Note
When a task is created (or fails), Factory.MAP displays a balloon 
directly above the Factory.MAP icon in the tooltray to alert you of 
information about the task. You can click the balloon to open the 
operator console.

Note
If you click Cancel, Factory.MAP creates the media portal for you with 
default values. You can edit the media portal values by selecting it and 
clicking Properties, or you can delete it by clicking Disconnect if you did 
not intend to create it.
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Click Next to continue. Click the server type you selected from the topics above 
to continue.

FTP Server
Use this server type to connect to a server via FTP.
Name or IP Address. Enter the name or IP address (for example, acmeftp.com, 
or 192.168.10.12). If local, you can click Browse. localhost is specified 
automatically.
Click Next to continue.
Credentials. Enter the user name and password (unless anonymous is selected). 
Check anonymous login for anonymous access and provide your email address in 
the user name by convention. Check passive mode if required for firewall 
compatibility.
Click Next to continue.
Directory. The wizard connects to the server and displays a list of directories. 
Drill down to the target directory and click Finish. Icons in the toolbar permit you 
to (from right to left) go up one level, create a new folder, refresh the list, display 
other views, and go.
The network address is filled in automatically. For example, ftp://
joeuser:qwerty@acmemedia.com/media.
Click Next to finish the wizard and return to the Media Portal Properties dialog.

HyperLaunch Receive Server
Use this server type to connect to a HyperLaunch Receive Server.
Name or IP Address. Use the Network Location Wizard to supply the domain 
name or IP address and assigned port number (default 69 – may be different.
Click Next to continue.
Credentials. Enter the user name and password. Make sure that the user name 
and password are properly formed for the type of authentication you’re using on 
the Windows server hosting the HyperLaunch Receive server. 
In many cases it may be necessary to prepend your domain or workgroup name 
to your user name, separated by a single back slash. For example, 
MyDomain\myusername. The user name and password are authenticated when 
you set up a HyperLaunch Receive portal, and during periodic connection 
checks.
Click Next to continue.
Directory. The wizard connects to the server and displays a list of directories. 
Drill down to the target directory and click Finish. Icons in the toolbar permit you 
to (from right to left) go up one level, create a new folder, refresh the list, display 
other views, and go.
The network address is filled in automatically. 
For example, pmp://acmemedia.com:69/media.
Click Next to finish the wizard and return to the Media Portal Properties dialog.
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Local Drives or Network File Shares
Select this type of server when you want to connect to a local directory or 
network-accessible file server directory using Content.MAP service's user name 
and password. By default, MAP services run under Local System Account. If you 
are targeting a file server, you should change the Content.MAP service properties 
to run under a user name and password that has access to the target file server and 
restart the service.
Name or IP Address. Enter the name or IP address (for example, acmeftp.com, 
or 192.168.10.12) and specify the port number. If local, you can click Browse. 
localhost is specified automatically.
Click Next to continue.
Windows computer name or file server. Enter the name of the server in the 
format \\ServerName (for example, \\MediaServer. To view the servers available 
to you, open Windows Explorer. Right-click My Network Places and select 
Open. In the Task panel, click Entire Network.
To view your local computer, check Browse the drives on this computer.
Click Next to continue.
Browse for a file or folder on this server. The wizard connects to the server (or 
your local computer) and displays a list of directories. Drill down to the target 
directory and click Finish. Icons in the toolbar permit you to (from right to left) 
go up one level, create a new folder, refresh the list, display other views, and go.
The network address is filled in automatically. When connecting to a network 
server, the scheme is: file://netmediasvr/mediadir, for example. When connecting 
to a local directory, the scheme is: file:///C:/ADestination, for example.
Click Next to finish the wizard and return to the Media Portal Properties dialog.

Network File Share (Different User Name and Password)
Select this type of server when you want to connect to a network-accessible file 
server directory using a specific user name and password. By default, MAP 
services run under Local System Account. If you do not want to change the 
Content.MAP service user name and password, you can enter credentials for this 
media portal to use when connecting.
Name or IP Address. Enter the name or IP address (for example, acmeftp.com, 
or 192.168.10.12).
Click Next to continue.
Credentials. Enter the user name and password required to access this network 
server and directory.
Click Next to continue.
Directory. The wizard connects to the server and displays a list of directories. 
Drill down to the target directory and click Finish. Icons in the toolbar permit you 
to (from right to left) go up one level, create a new folder, refresh the list, display 
other views, and go.
The network address is filled in automatically. For example, cifs://
ACMEMEDIA%5cjoeuser:med799guy@mediasvr7/media.
Click Next to finish the wizard and return to the Media Portal Properties dialog.
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Secure HyperLaunch Receive Server
Use this server type to connect to a secure HyperLaunch Receive Server.
Name or IP Address. Enter the name or IP address (for example, 
hyperlaunch.acme.com, or 192.168.10.12:69). The default port (69) may be 
changed – validate the port number before sending. The RSA public key is 
obtained automatically.
Click Next to continue.
Credentials. Enter the user name and password. Make sure that the user name 
and password are properly formed for the type of authentication you’re using on 
the Windows server where HyperLaunch Receive server is installed.
Click Next to continue.
Directory. The wizard connects to the server and displays a list of directories. 
Drill down to the target directory and click Finish. Icons in the toolbar permit you 
to (from right to left) go up one level, create a new folder, refresh the list, display 
other views, and go.
The network address is filled in automatically. 
For example, pmps://acmemedia.com:69/media.
Click Next to finish the wizard and return to the Media Portal Properties dialog.

General Properties To view and update a portal's general properties, click the selected portal and 
click the Properties icon. Click the General tab to display the following settings.

Encoder Properties To view and update a portal's encoder properties, click on the selected portal and 
click the Properties icon. Click on the Encoder tab to display the following 
settings:

Table 4–2. General Properties

Item Description

Name The user name that identifies this portal. When 
you run the Add a media portal wizard in MAP 
Explorer, this is the name displayed in the list of 
available media portals.

Network Address The URL of the destination. You can enter the 
URL manually, or click Browse to allow the 
Network Location Wizard create one for you 
automatically as you locate the destination. 

Table 4–3. Encoder Properties

Item Description

Extension Select the file extension you want to add to the 
media file when it is created.
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CODECS PROPERTIES

To view and update a portal's codec properties, click on the selected portal and 
click the Properties icon. Click on the Codecs tab to display these settings.
Table 4–4. Codecs Properties

Item Description

Codecs In the top list, select one of the audio and/or 
video codecs you want to be employed when this 
media file is created. Do not select more than 
one audio or video codec from the list. 
To actually change the selection of the codec, 
click it once to highlight it. Click it again to turn 
the checkbox on or off.

Codec Settings First, click the codec whose settings you want to 
set or view in the top codec list. The settings for 
this codec are displayed in the properties panel 
directly below. If the settings are inactive (gray 
and non-editable), it is because this codec is 
unchecked in the list above. 
To change settings, click in the right column for 
each parameter, and enter the value or select it 
from the popup list. 
For details on Codec settings, refer to the MAP 
Planning, Installation, and Configuration Guide, 
Appendix C, Media Formats.
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Filters Properties To view and update a portal's filter(s) properties, click on the selected portal and 
click the Properties icon. Click on the Filters tab to display the following settings:

Supported Protocols Factory.MAP provides several schemes you can use to connect to different types 
of shares where you want media delivered. Each scheme has its own format, 
including optional user name and passwords. 
Each scheme follows a general layout: Scheme Name://Authority or Name/Fully 
Qualified Path and Directory or address
The following table describes each protocol and its format.

Table 4–5. Filters Properties

Item Description

Filters In the top list, select the filters you want to be 
employed when this media file is created. To 
actually change the selection of the codec, click it 
once to highlight it. Click it again to turn the 
checkbox on or off.

Filter Settings First, click the filter whose settings you want to set 
or view in the top filter list. The settings for this filter 
are displayed in the properties panel directly below. 
If the settings are inactive (gray and non-editable), 
it is because this filter is unchecked in the list 
above. To change settings, click in the right column 
for each parameter, and enter the value or select it 
from the popup list. For details on Filter settings, 
refer to the MAP Planning, Installation, and 
Configuration Guide, Appendix D, Pre-processing 
Filter Formats.

Table 4–6. Supported Protocols

Protocol Description and Parameters

File Use the File scheme to connect to a local directory 
or network server standard Windows file transfer.
Example: File:///C:/DestinationFolder.

CIFS Use the CIFS scheme to connect to a server via 
CIFS, typically used when requiring a specific user 
name and password.
Example: cifs://
ACMEDIGMEDIA%5cMAPUser@dev/
MediaStorage 

FTP Use the FTP scheme to connect to a server via 
FTP.
Example: ftp://
mediauser:userpswd@168.192.81.40/antfarm or 
ftp://mediauser:userpswd@mediasvr7/antfarm.

HTTP Use the HTTP scheme to connect to a server 
HTTP. Example: http://mediaserver/mediafolder.
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C     H     A     P     T     E     R 5

MAP Administration
This chapter provides MAP administrators step-by-step instructions for 
accomplishing configuration and other administrative tasks.

Topics General MAP Administration
MAP Software Versions on page 5-2
Adding Distributed Services to the Console on page 5-2
Selecting the MAP Service To Manage on page 5-3
Creating MAP S e rvices Alerts on page 5-3
Synchronizing MAPreview servers on page 5-7

Capture.MAP Administration
Capture Service Regular Maintenance on page 5-10
Add a Capture Card on page 5-13
Create and Configure a Channel on page 5-14 
Create and Configure a Schedule on page 5-15
Establishing Multiple Schedules on page 5-16
View Live Streams During Capture on page 5-17
Capturing Ratings Provider Metadata on page 5-18
Setting up As Run Logs on page 5-22
Setting Up a TV Schedule Provider on page 5-23
Converting Speech to Text on page 5-24
Enabling Speech Recognition on page 5-25
Burning in Time Code on page 5-25

Content.MAP Administration
Add a Top-Level Distributed Media Folder on page 5-27
Configuring Media Folder Properties on page 5-28
Create a New Version of Master Media Files on page 5-29
Saving a New Version on External Systems on page 5-29

Factory.MAP Administration
Concurrent Transcoding Jobs on page 5-31
Monitoring and Resubmitting Transcoding Jobs on page 5-32

Using Archive.MAP
Archiving Expired Media on page 5-33
Restoring Archived Media on page 5-33
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GENERAL MAP ADMINISTRATION

Many configuration tasks may be accomplished directly in MAP Explorer, as 
well as in the MAP management console (often referred to simply as MMC), 
especially when you are configuring a local MAP service.
Administration and configuration of distributed MAP services is performed using 
the MAP management console.

MAP SOFTWARE VERSIONS

To determine which MAP software is installed on a given server, go to start > All 
Programs > Telestream > MAP > Version Information.
Figure 5–1.  Add a distributed service to the MAP console

The MAP Software Manifest application displays a list of all MAPreview server 
software installed, and details about the version.

ADDING DISTRIBUTED SERVICES TO THE CONSOLE

The purpose of the MAP management console (often referred to as MMC) is to 
provide the MAP administrator centralized control over the configuration and 
setup of each Capture, Content, and Factory service running in your MAP 
system, no matter where they are on the network.
MAP services that are running on the same server as the console (localhost) are 
automatically connected and ready for administration. In a multi-server 
environment, you can connect distributed MAP services to a single MAP 
management console for administration, or you may connect some services to 
one console, and other services to another console.
For example, you have installed two Factory.MAP services, two Content.MAP 
services, and four Capture.MAP services, for a total of eight servers.
In one scenario, you connect all of the MAP services to a single MAP 
management console for unified access by a single administrator. In another 
scenario, you connect the Factory.MAP and Content.MAP services to one 
console, and the Capture.MAP services to a separate console on two different 
servers.
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If you are administering Capture.MAP (or other service) from a computer that is 
different from the server that the service is running on you need to add the service 
to the console.
To connect all of your services to a single console, follow these steps:

Step 1 First, identify each Capture, Content, and Factory.MAP service you’ve installed.

Step 2 Next, identify the server you want to perform MAP management from.
Figure 5–2.  Add a distributed service to the MAP console

Step 3 Right-click on Capture.MAP and select Add Server to display the Browse for 
Computer window.

Step 4 Next navigate to the server that is running the Capture, Content, or Factory.MAP 
service you want to add. You can add as many services as you wish. In this way 
you can control and configure all of your services from one MAP management 
console. Click OK to add it. (Local services are connected by default, and named 
localhost.)

SELECTING THE MAP SERVICE TO MANAGE

When all of your MAP services are connected to a single Management Console, 
you can open the console, open a specific service type (Capture, for instance), 
view a list of all Capture services, and select the one you want to manage.

CREATING MAP S E RVICES ALERTS

You can create alerts in Windows to monitor and report on error conditions that 
may arise with MAP services. You can also create alerts to monitor performance 
of each MAP service – Content, Factory, and Capture.MAP, and HyperLaunch 
services as well. 
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Use this section to set up alerts to quickly and efficiently notify operations 
personnel of potential problems or failures in MAP services, and for all 
automatic recovery from failures.

You can create alerts that monitor a wide range of metrics, including runtime 
errors, disk space, and others. For example, you can create an alert that monitors 
Capture.MAP and notifies you via email that disk space on the capture server is 
running low.

Network Message 
Alert Action

To create a network message alert action when .NET exception occur, follow 
these steps (Windows Messaging Service must be enabled):

Step 1 Display the Computer Management console: open Control Panel > 
Administrative Tools > Computer Management.

Step 2 In the Computer Management console (left panel), expand System Tools > 
Performance Logs and Alerts.
Figure 5–3.  Use Computer Management to create alerts

Note
Alerts are processed by the Messenger service. By default, the 
Messenger service is disabled in Windows XP. To enable Messenger, 
open Control Panel > Administrative Tools > Services. Right-click 
Messenger in the services list and select Properties. On the General tab, 
change Startup type to Automatic and click Apply. Next, click Start to start 
the Messenger service. When it starts, close the dialog.

Note
Details about creating alerts is available directly from the Microsoft Web 
site at www.microsoft.com.
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Step 3 Right-click the Alerts icon and select New Alert Settings to name the alert you’re 
about to create. Enter the name for the alert and click OK. 
Figure 5–4.  Name the new alert

Step 4 The console displays the property dialog for the new alert. Click Add to display 
the Add Counters window.
Figure 5–5.  Set up the alert counters

Step 5 Complete this window by selecting where the counters are located, which 
counters to use, and which instance (service) to monitor. Click Add to close the 
window and add the counter.
Figure 5–6.  Provide a comment for the alert
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Step 6 Enter a comment, and specify the threshold for the alert to operate – in this 
example, when a CLR (Common Language Runtime) error occurs (value is over 
0), tested every 5 minutes for the Capture service.

Step 7 Click Action to display the Action tab.
Figure 5–7.  Use the Action tab to specify what action to take

Step 8 Check the options to occur when an alert is triggered. For example, you can 
check Send a network message and enter the computer name (or multiple 
computer names, separated by a semicolon. When you’ve configured the alert, 
click Apply or OK to implement the alert. The alert is displayed in the details 
panel on the right.
Figure 5–8.  Performance MMC displays alerts you’ve created

Right-click the alert to view or modify its properties.

Enabling an Email 
Alert Action

Telestream has provided a sample email alert script, designed to deliver an email 
when an Alert is triggered. To use it, first create an alert, under the General tab of 
the MAPAlert properties dialog. Next, update the email script and update the 
Action tab to specify the email script.

Step 1 Click the following link and download the EMAIL script files into your \Program 
Files\Telestream\MAP folder: 
http://www.telestream.net/products/map_alerts/AlertEmail.zip
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Open the zip file and put the CMD and WSF file in the Program 
Files\Telestream\map folder.

Step 2 Modify these lines of the sendemail.wsf file with your email parameters:
Flds(cdoSMTPServer) = "MAIL.SERVER.NET" – enter your mail server's fully 
qualified URL or IP address.
Flds(cdoSendUserName) = "USER_Domain\USER_Name" – enter user name.
Flds(cdoSendPassword) = "Password" – enter your password.
To = "mail_recipient@your_mail_domain.net" – enter the "To" email address
.From = "map_alert@your_mail_domain.net" – enter the "From" email address.
Subject = "MAP System Performance Alert" – enter the subject text.

Step 3 Click the Action tab of the MAPAlert properties dialog.
Figure 5–9.  Update the Action tab to execute the send alert command

Step 4 Check Run this program, then point to the send alert command:
C:\Program Files\Telestream\map\sendalert.cmd.

There are no command line arguments for this program. Notice that this alert also 
logs an entry in the event log, and sends a network message to a workstation.

Setting the Alert 
Schedule

To set the schedule, click the Schedule tab and click At in the Start scan section 
to start the Alert immediately. In Stop Scan, select After, with default 1 day. 
Check Start a new scan, to repeat the schedule after each scan.

SYNCHRONIZING MAPREVIEW SERVERS

There are several ways of providing accurate time coding or to synchronize time 
code on multiple concurrent capture channels (on the same or different 
Capture.MAPreview servers). If permitted, you can enable Internet time 
synchronization on each Capture.MAPreview server. You should also enable 
time synchronization on your other MAPreview servers (Content, Factory, and 
Archive) to accurately date and time stamp all of the files as they are created in 
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your MAP system. If your domain or user profile prohibits using an Internet 
Time server, the Internet Time tab does not display in the Date and Time 
properties – see your network administrator for assistance.
To enable Internet time synchronization, right-click on the time in the tool tray 
and select Adjust Date/Time. Windows displays the Date and Time Properties 
window.
Figure 5–10.  Synchronize your server with an Internet time server

Click the Internet Time tab, and check automatically synchronize with an Internet 
time server. Select a server from the Server popup list. Click OK to save the 
settings and close the window.
This feature operates only when the computer is connected to the Internet.

Check here to synchronize 
your MAPreview server 
with an Internet Time 
Server.
Select a Time Server from 
the Server popup.
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CAPTURE.MAP ADMINISTRATION

Administration of Capture.MAP involves installing capture cards, adding or 
modifying channels that control each capture card in a server, and other tasks. It 
also involves configuring each channel by setting up schedules and segments 
within a schedule, or using the Automatic Scheduler.
A MAP Capture server is capable of capturing a maximum of four simultaneous 
feeds with a maximum frame size of 320x240, up to approximately 750Kbps 
with sufficient CPU overhead. Encoding is primarily performed in software and 
utilizes a great deal of the overall CPU with four concurrent capture sessions 
consuming greater then 50% of the overall CPU. 
Capturing at bit rates higher than 750kbps, using frame sizes larger than 
320x240, or applying the MAP Capture overlap* feature on all four (4) channels 
may push CPU utilization to or over 100%. In these situations the operating 
system will likely become unstable, increasing the risk of a server failure.
Excessive CPU utilization may cause timer-sensitive, low-level operations to 
fail. Three factors influence how much CPU load your server will experience 
during capture: the frame size, bit rate and number of concurrent captures. 
To avoid CPU overload when capturing four live feeds with segment overlap:
• Minimize the overlap period to 3 seconds and use staggered segmented 

schedules where only one channel is in an overlap period at any one time (All 
channels will always start and end on day transitions)

• Use smaller frame sizes such as 160 X 120
• Reduce the number of live feeds being captured to less than four (4).
You must specify one (or more) store locations where captured media is saved. 
When MAP saves media, it is stored in the depot with the largest amount of free 
space among the specified stores.
Administration is performed in the management console. Display the console and 
open the service to display the servers. Select a service to display the stores.
The frame on the left is used to display capture servers (computers that have 
capture devices you’re obtaining media from), and channels (logical media feeds 
from the physical capture devices).
The right frame is the Stores frame. It is used to display the physical storage 
location (a folder on a local drive) that you have identified as a valid location for 
media being captured from this server. 
Before you select and set up a server and a channel to capture media, you should 
determine where you want to store the media files once they are captured.

* Enabling overlap recording (using Simulstream) will affect MAP’s ability to capture four simultaneous live feeds 
without reaching critical CPU levels.

Note
Capture.MAP should run on correctly-configured servers (Windows OS 
and Network Configuration on page 3-7). If Capture.MAP is on a 
dedicated server, disable Factory and Content.MAP services.
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CAPTURE SERVICE REGULAR MAINTENANCE

Several factors affect optimum performance of Capture.MAP. Performing regular 
maintenance ensures that media capture continues uninterrupted, even during 
heavy CPU utilization.
During the normal course of operation, performance of the Capture server is 
likely to degrade over time and become more likely to fail, primarily due to RAM 
usage, disk fragmentation, virus scans and software updates that can disrupt 
operations. Establishing a regular, periodic maintenance schedule and planning 
virus scans and Windows updates under your control increases the likelihood of 
trouble-free operation. 

Restart Your 
Server Regularly

You should stop all capture activity and restart your MAP Capture server at least 
once every 3 months. Restarting the Capture server not only restarts 
Capture.MAP, it restarts Windows. Over time, software components may allow 
low-level memory leaks, leading the component to consume increasingly large 
amounts of memory either in Windows or on your capture card operating system, 
reducing available memory and potentially destabilizing the Capture server. 
Rebooting the server frees unnecessary memory allocations, and improves 
capture card and platform stability, reducing risk of failure. 
Restart Schedule. If your capture server is operating under a light operational 
load (it is operating with a single capture card, or less than a full day of 
recording), you may reboot the server every six weeks. However, as you increase 
work load by adding more capture cards or you increase segment recording up to 
24 hours per day, you should consider rebooting on a more frequent basis, as 
frequently as every 2 weeks. 
After you’ve established a regular restart schedule, if your Capture server 
becomes inoperative between restarts, consider shortening the time between 
restarts to increase server stability.

Defragment Server 
Hard Drives

You should defragment your hard drive periodically, and you should not allow 
drive utilization to exceed 80%. How often you defragment depends on how 
heavily you utilize your Capture server. Defragmentation is performed using the 
Windows Disk Defragmentation utility.
Analyze Disk Fragmentation. You should always defragment your hard 
drive when fragmentation is greater than 70% or when you plan to restart the 
server, once per quarter, for example. You can determine the percent of 
fragmentation by running Analyze in the Windows Disk Defragmenter.
To run the Disk Defragmenter, right-click start > Explore to display the Windows 
Explorer. 

Note
You should never access the MAP Capture server via Windows Remote 
Desktop Connection. Doing so causes the Osprey audio driver to bind to 
the remote session and cause the Capture service encoder to fail.
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Open My Computer, and right-click the drive you’re checking for fragmentation. 
Select Properties, and click on the Tools tab. 
Click Defragment Now to display the Disk Defragmenter window.
Figure 5–11.  Disk Defragmentation utility

To analyze your drive, click Analyze (or click Action > Analyze). 
After the analysis is complete, click View Report to display the results. 
Figure 5–12.  Disk defragmentation report

In the Volume Information text box, scroll down to display Volume 
fragmentation. If the value displayed for File fragmentation exceeds 40%, you 
should defragment the drive by clicking Defragment directly on the Analysis 
Report or Disk Defragmenter window. 
The time required for defragmentation depends primarily on the amount of data 
on the drive, and is typically about 1 minute per gigabyte (GB) of data. For 
example, defragmenting 60 GB of data will take about an hour to complete.
Defragmentation can be performed during capture, but it may push CPU 
utilization beyond the recommended 85% limit. CPU utilization during 
defragmentation is about 10-15%, but often exceeds 60% during certain 
operations. If you can’t maintain CPU utilization to a safe level, take the Capture 
server offline and record your media on a backup Capture server or other system 
until defragmentation is complete and your Capture server is running again.

Click Analyze to 
determine how 
fragmented the files on 
your drive are.
Click View Report to 
display the results after 
the Analyze utility has 
been run.
Click Defragment to 
defragment your drive.

Scroll down to display Volume 
fragmentation. 
If the value displayed for File 
fragmentation exceeds 40%, you 
should defragment the drive 
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Virus Scans and 
Software Updates

Virus scans and Windows software updates may also impair normal operation of 
your Capture server.
Virus Scans. Running virus scans increases CPU utilization. If you are using 
virus protection on your Capture server, make sure that if scans run during 
segment capture, CPU utilization does not increase above 85%. Alternatively, 
schedule the virus scan to run during a time when the Capture server is not 
recording segments.
If you decide not to run virus software on your Capture server, you should 
consider isolating the Capture server from the corporate network on its own 
network, or completely firewall the server from the Internet to reduce risk of 
virus infection.
Windows Software Updates. Telestream recommends disabling automatic 
updates, or scheduling updates at a time when media recording is idle. File 
downloads that occur during software updates can push CPU utilization above 
the recommended 85% limit, and can also cause an automatic system reboot or 
other unintended change in Windows that may render some component of your 
Capture server inoperative, leading to potential media loss.
To display your Automatic Updates window, open the Control Panel > Security 
Center and click Automatic Updates to display the Automatic Updates window.
Figure 5–13.  Automatic updates recommended settings

If your Capture server is connected to the Internet, Telestream recommends 
configuring automatic updates to notify you of updates without downloading or 
installing them. This setting provides notice of updates, while permitting you to 
schedule the updates to fit the segment recording schedule you’ve set up.
If your Capture server is not connected to the Internet, Telestream recommends 
turning off automatic updates, and periodically performing updates according to 
your own IT policy.

Backup System 
Alternatives 
During 
Maintenance

If your operational requirements require continuous recording, consider the 
following alternatives as backup systems during the time your Capture server is 
offline for periodic maintenance.
Backup MAP Capture Server. Install a second, identically-configured MAP 
Capture server. When you plan to perform scheduled maintenance on your MAP 
Capture server, switch your media feeds to the backup capture server and begin 

Telestream recommends configuring 
automatic updates to notify you of updates 
without downloading or installing them, or 
disabling updates and performing updates 
when no capture is taking place.
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recording segments on it during the time your capture server is offline for 
maintenance.

Backup VCR Capture System. Install a VCR for each channel you require 
recording. When you plan to perform scheduled maintenance on your MAP 
Capture server, switch your media feeds to VCR and record segments on it 
during the time your capture server is offline for maintenance.
This method works well when you are restarting your server, updating Windows, 
performing virus scans or other operations that have a short duration. For 
defragmenting operations, this VCR capture method may be inadequate. After 
restarting and bringing the Capture server online, digitize the media segments 
(using Windows media encoder and an Osprey card, for example) you captured 
on VHS tape. Next, add the segments to the MAP media database, storing them 
in the channel/year/month/day folder where the segment gap is located. MAP 
will extract metadata as usual.

ADD A CAPTURE CARD

To capture live media and save each segment as files in MAP, you need to install 
a capture card and set up a channel for the card, including a schedule. 
Here are the steps to follow:

Step 1 Install a capture card (one or more).

Step 2 Add a store (one or more).

Step 3 Create and configure channels – maximum 4 simultaneous channels.

Step 4 Create schedules.
When you’ve completed these steps, start the channel and Capture.MAP will 
begin recording and saving segments according to the schedule.
Installing, configuring, and verifying the proper functioning of a capture device 
is a pre-requisite for capturing live media in Capture.MAP. 

Install & Configure 
Capture Card

Set up a capture card with these steps:

Step 1 Install the capture device(s) and its drivers and other required software on the 
Capture.MAPreview server, according to the manufacturer’s instructions.

Step 2 Restart the server so that it recognizes the hardware. Perform any other 
configuration and set up recommended by the manufacturer.

Note
A backup Capture server typically stores media directly on a local drive. In 
this case, the server must always remain online even though 
Capture.MAP has been disabled after performing backup capture 
services, because media is now stored on this server.
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Step 3 Connect the capture card to the video and audio sources using highest quality 
cables.

Step 4 Test the proper operation of the capture card or device, using Windows Media 
Encoder and Windows Media Player to insure proper functionality.

Step 5 Install Simulstream drivers, if applicable, and modify the Simulstream properties 
as required.

Step 6 After successfully testing the capture device, create and configure a 
Capture.MAP channel to use the device.

Add a Store To add a store, follow these steps:

Step 1 In MAP management console, open the Capture.MAP icon.

Step 2 Select the Capture.MAP service you’re configuring with the new card.

Step 3 Click Add Store (in the toolbar above the detail frame on the right).

Step 4 Select a storage location – it may local or on a network server (which may 
require proper authentication for this user account).
When you’ve selected it, Capture.MAP tests access and displays it in the list of 
stores. Status should display OK (far right column).

CREATE AND CONFIGURE A CHANNEL

To create and configure a channel, follow these steps:

Step 1 Right-click the Capture.MAP service and select New > Channel.

Step 2 Right-click the New Channel icon and display the Properties dialog.

Step 3 In the General tab, change the name of the channel to an appropriate name: 
KABC, for example.

Step 4 Establish the startup type (usually Automatic) and other schedule details.

Step 5 In the Capture tab, click Modify (under Media Encoder) to display the Encoder 
Properties dialog where you configure codecs and filters. Click the Codecs tab 
and then select the codec to display its property sheet directly below. Make 
changes as required and click OK. Set up filters in the same manner.

Step 6 Create a URL folder path where the media binders are created and stored as the 
media is captured. If Content.MAP is on a separate server, you first need to make 
a connect to the target (usually root) media folder, then connect to the target in 
My Network Places > Media Access Platform (MAP).

Note
Channel Properties details are located in Online Help, by clicking the Help 
icon in the MAP management console toolbar.
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Step 7 Click Browse (under Media Folder) to specify which media folder the media 
binders are to be stored in. Typically you’ll select the store you just created for 
this Capture.MAP.

Step 8 In the Settings tab, specify video and audio sources (capture cards) installed in 
the server and set Broadcast to true to view it in the channel monitor window.

Step 9 In the Providers tab, select an automatic schedule and configure it if you have the 
optional Internet-based schedule subscription service. You may leave this blank 
and create your own schedule. (For information about Telestream’s subscription 
service, contact your Telestream sales representative or your Telestream dealer.)
The Automatic Scheduler automatically generate 24x7 capture schedules via 
Internet programming services by region and station.

Step 10 Click OK to update and close the Channel Properties dialog. 

CREATE AND CONFIGURE A SCHEDULE

To create and configure a schedule (in MAP management console, selected 
capture server and channel), follow these steps:

Step 1 Right-click the channel you’re configuring and select New > Schedule.

Step 2 Open the channel and select the schedule to display schedule details.

Step 3 Click and drag vertically through the time frame to create a new segment. 

Step 4 Right-click in the new segment and select Properties to display the Segment 
Properties dialog. 

Step 5 In the General tab, name the segment to an appropriate name: AMNews, for 
example.

Step 6 Adjust the start and end times as necessary.

Step 7 In the Capture tab, under Media Encoder, select Inherit encoder from channel or 
select Specify an Encoder for this Segment and then set up the encoder 
parameters (see steps you used when you configured the channel, previously).
Also, you can inherit the media folder (where the media is to be stored) or you 
can specify a different media folder for this segment.

Step 8 In the Labels tab, add the metadata labels you want for this segment. Select each 
one and set up the values.

Step 9 Click OK to update these segment properties and close the dialog.

Note
Segment properties are inherited from the parent channel, unless 
specifically modified in the Segment Properties dialog. 
Schedule and Segment Properties details are located in Online Help, by 
clicking the Help icon in the MAP management console toolbar.
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Now you can click on the channel you’ve configured and click Start Channel to 
begin recording segments according to the media specifications you’ve 
established and the schedule you’ve created.

ESTABLISHING MULTIPLE SCHEDULES

You can create multiple schedules on a single channel. When you create multiple 
schedules, they follow a specific order based on type. They are listed here in 
order of priority (high to low):

— Exactly
— Yearly
— Monthly
— Weekly
— Daily

If you create two schedules that have overlapping (conflicting) segments, then 
the higher order schedule will prevail. 
For example, you’ve created a daily schedule and a monthly schedule, with a 
conflicting capture segment. The segment in the monthly schedule will get 
recorded, the daily one will not.

Schedule Types MAP allows you to create different types of schedules, to make capturing 
segments easy. Each schedule type has certain operating characteristics, and also 
has an order of other schedules it overrides when there is a segment conflict.
You can create multiple schedules of various types to record everything you want 
to record automatically. In a typical recording environment, you might have a 
combination of daily schedules, along with a weekly schedule for recording 
special Sunday and Saturday programs, and then a monthly schedule for special 
first day of the month programs. 
You might also add a yearly schedule for New Years day, or alternatively, one or 
more Exactly schedules for capturing holiday and other special day events.

Daily Schedule Create a schedule of type daily when you want it to run each 24-hour day and 
record the segments you’ve specified. Typically, you’ll set up daily schedules and 
select a long period of time—an entire year, or perhaps a decade or more to run 
permanently from a practical perspective. 
You might create a daily schedule when you use automatic schedules as a backup 
schedule. In case the automatic schedule (exactly) is not created because the 
Internet service is temporarily unavailable, the daily schedule will run in its 
place.

Weekly Schedule Create a weekly schedule and select the day of the week by selecting the date 
form the calendar. For example, you may select a weekly schedule to start on 
Sunday and end on Sunday, for capturing special Sunday programming 
segments. 
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If you create a daily schedule and a Weekly schedule with Sunday as the only day 
in the weekly schedule, the Sunday segments will record instead of the daily 
segments only on Sunday.

Monthly Schedule Create a monthly schedule and select the days. For example, you can select the 
first day of the month as a start and end day for special segments.

Yearly Schedule You might create a yearly schedule for Thanksgiving, to capture special 
programming on that day. It will override daily, weekly and monthly schedules if 
there is a segment conflict.

Exactly Schedule You can create a one time schedule that will override any other schedules you 
have. For example, there might be a rocket launch, or a presidential State of the 
Union speech that you want to record in a few days. 
Automatic schedules are exactly schedules, and are created at the end of the day 
immediately preceding the current schedule day.

Never Schedule If you have created a schedule but want to suspend it, just click Never. You can 
turn it back on later by returning it to the type you originally specified.

VIEW LIVE STREAMS DURING CAPTURE

You can only view media in MAP management console when an actual segment 
is recording.
To view live streams that you’re capturing, follow these steps:

Step 1 Launch MAP management console.

Step 2 Open the channel that you’re recording (the channel must be started).

Step 3 Right-click the channel and select Properties.

Step 4 In the Properties dialog, click the Settings tab.

Step 5 Open the broadcast property and set Enabled to True.

Step 6 Click OK to update and save the properties.

Step 7 In the Channel details frame on the right, click the play button in the media 
controller.
You can only view media in MAP management console when an actual segment 
is recording.
To view each channel, launch multiple copies of MAP management console and 
select the channel you want to view. Now you can arrange each MAP 
management console on your desktop to show all capture card media 
simultaneously.
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CAPTURING RATINGS PROVIDER METADATA

The ratings provider is channel-specific, and identifies the folder where Ratings 
XML files are stored. To incorporate ratings metadata with captured media, you 
create a ratings configuration file (.ini) (using the Ratings Configurator or 
manually – Configuring Ratings INI Files, following). The INI file you create 
specifies the source ratings spreadsheet folder and file, and specifies each 
channel for which ratings should be extracted, and finally, each XML file that 
should be generated by demographic criteria you specify (males 18-29, for 
example), and the server and directory where the generated ratings XML files 
should be saved.
The MAP Ratings service generates the specified XML files by channel and 
demographic. When the Ratings service identifies new ratings spreadsheets that 
have been placed in its monitored folder (up to 7 days old), it generates the 
specified ratings XML files. When Capture.MAP identifies the new ratings XML 
files generated by the Ratings service, it processes them by updating the binders 
of media it captured earlier (usually the previous day, or last business day and 
weekend days if the ratings spreadsheets were not processed over the weekend) 
to update the track data for each binder where there is a match. For details on 
installing and configuring the MAP Ratings service, see Installing MAP Ratings 
Parser and Configurator on page 3-21.
After media is captured by Capture.MAP, the Ratings Parser reviews each new 
media binder and matches it with ratings in each XML file by time, date, and 
channel. When the ratings data from each XML file that matches media has been 
updated in the ratings metadata tracks on a binder, MAP users can view ratings 
information in Player.MAP or in Explorer.MAP. The entire process may take a 
few hours to complete after the ratings XML files have been generated by the 
Ratings Parser.

Configuring 
Ratings INI Files

Before you can extract metadata from the source ratings file for metadata 
creation, you need to configure the ratings INI file (see sample, Sample Ratings 
INI File on page 5-21). You can configure the file with the Ratings Configurator, 
or edit the file manually using a text editor. 
When you’re done, click Finished to update and close the INI file.
Move the configuration file to the Capture.MAPreview server, and identify it to 
the Ratings property in the channel you want to capture (see Capture.MAP online 
help in the MMC).

Using the Ratings 
Configurator

Use the Ratings Configurator to set up your INI file to correctly identify details 
about where data exists in the ratings spreadsheet you use for input, and where 
input and output files are located.
When you create demographics and channels (stations), you are setting up a two-
dimensional matrix that the Ratings parser will use to create XML ratings files. 
For example, if you create two demographic tabs – Households and Persons 25-
54 – and create two channels (stations) – Fox News and CNN – the Ratings 
Parser will generate four XML files for each day media is captured:
• Households, FOX
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• Households, CNN
• Persons 25-54 FOX
• Persons 25-54 CNN.
Figure 5–14.  Using the Ratings Configurator to set up an INI file

On the main window, provide details in each field, then configure the 
demographics and channels (stations), then click Finished.
File Date Location. Specify the cell (Z1, for example) on the first worksheet 
in the spreadsheet which specifies the date for which the ratings are valid. The 
Ratings Parser uses this information to correctly match the ratings to the captured 
media file.
Data Start Location. Specify the row number(6, for example) where the first 
repetitive ratings data displays, under the station column headings.
Data End Location. Specify the row number(101, for example) where the last 
repetitive ratings data displays, under the station column headings
File location/name. Use this field only if the spreadsheet is named the same 
every day. Provide the fully-qualified UNC path to the directory where the input 
spreadsheet is dropped.
Monitor this folder. Use this field when you want the Ratings Parser to 
monitor this directory automatically process the spreadsheet when it is dropped 
in the directory each day, and the name of the spreadsheet changes. Browse to the 
server and directory and select it. The path must be in UNC format, and the 
Ratings Parser service must have correct credentials and access to this directory.
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Configure Demographics
Click Configure Demographics on the main window to display the Add 
demographic window.
Figure 5–15.  Setting up demographics in Ratings Configurator

Use this window to create demographic tabs for each worksheet you want to 
extract ratings from.
Demographic Tab Name. Enter the name of the worksheet displayed in the 
tab at the bottom of the spreadsheet. The name must match exactly. 
Add. Click Add to add a new demographic tab (from text currently displayed in 
the Demographic Tab Name field) to the INI file.
Remove. Select a demographic tab and click Remove to permanently remove it 
from the INI file.
Click Done when complete to return to the main window.

Configure Channels (Stations)
Click Configure Channels on the main window to display the Add Channel 
window.
Figure 5–16.  Setting up channels in Ratings Configurator

Use this window to create channels (stations) for each station you want to extract 
ratings metadata. In most cases, the columns are sequential in groups of 3 (C, D, 
E, and F, G, H, for example).
Channel Column Location. Enter the column ID (C, for example) that 
contains the channel/station name.
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Rating Column Location. Enter the column ID (D, for example) that 
contains the rating value.
Share Column Location. Enter the column ID (E, for example) that contains 
the share percent.
Output File Location. Click Browse to locate and select the server, volume 
and path to the directory where you want the output XML ratings files stored. For 
example: \\MAP-capture1\ratings\FOX.
After you have correctly entered the data for this channel, you can add it.
Add. Click Add to add a new channel (from text currently displayed in the fields 
above) to the INI file.
Remove. Select a channel tab and click Remove to permanently remove it from 
the INI file.
Click Done when complete to return to the main window.

Sample Ratings INI 
File

This sample INI file provides information about correct formatting for the 
Ratings Parser. This sample is located at Program Files > Telestream > MAP > 
Ratings > RatingsConfig.ini. 

;Tab names as they appear in the spreadsheet.
[Tabs]
Tab1=Persons 12-24 (1)
Tab2=Persons 25-49 (1)
Tab3=Households (1)
;The column letter for each channel.
[Channels]
Channel1=C
;The column letter for each rating.
[Ratings]
Rating1=D
;The column letter for each share.
[Shares]
Share1=E
;Cell number where ratings data starts.(Usually 6)
[Datastart]
Cell=6
;Cell number where ratings data ends. (Usually 101)
[DataEnd]
Cell=101
;Fully qualified path of ratings spreadsheet.
[Inputfile]
Location=
;Directories for each channels output data (must end 
with a "\").
[OutputFile]

Channel1=\\MAP-Capture1\ratings\FOX\
;Row & column containing file date from first tab.
[Filedate]
Location=X1
[Monitor]
Location=\\MAP-Admin\ratings_ss\
Configuring Ratings Properties
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Configuring 
Capture.MAP for 
Ratings Metadata

To configure a Ratings provider’s properties on a channel, follow these steps.

Step 1 Right-click the channel and select Properties.

Step 2 Click the Providers Tab. Click Ratings in the table and click Properties and open 
the Ratings node if not already open.

Step 3 Complete these fields:
Folder. Enter the local folder or network path that contains the ratings XML 
files generated by the Ratings Parser in UNC path format.
To specify a UNC path, navigate to the ratings XML files folder using Windows 
Explorer. Go to My Network Places > Entire Network > Microsoft Windows 
Network > MyCompanyDomain, where MyCompanyDomain. Drill down to the 
folder where your ratings XML files are located. Open the directory, and then 
copy the UNC path from the Address field in Windows Explorer and paste it into 
the Folder field.
Format. Default: Ratings (no other choices are available).

SETTING UP AS RUN LOGS

You can provide the data in as run logs for MAP users when they are viewing 
captured media in Player.MAP and MAP Explorer.
You can provide as run logs in Harris, Omnibus, or other proprietary formats. 

Note
The Omnibus As-Run provider defaults to North American month-date-
year date coding (MM/DD/YY). To support international date coding (DD/
MM/YY) a registry entry must be added. Add a string value and name it 
‘DateFormat’ under the 
HKEY_LOCAL_MACHINE\SOFTWARE\Telestream\MAP\Capture\Provid
er key. Set the value to ‘dd/MM/yy’.
To display the As Run provider properties, right-click the channel and 
select Properties. Click the Providers Tab. Click As Run in the table and 
click Properties. Open the Ratings node if not already open.
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Step 1 Right-click the channel and select Properties.

Step 2 Click the Providers Tab. Click As Run in the table and click Properties and open 
the Ratings node if not already open.

Step 3 Complete these fields:
Folder. Enter the local folder or network path of the directory where the as run 
logs are located, in UNC format.
To specify a UNC path, navigate to the As Run logs folder using Windows 
Explorer. Go to My Network Places > Entire Network > Microsoft Windows 
Network > MyCompanyDomain, where MyCompanyDomain. Drill down to the 
folder where the As Run files are located. Open the directory, and then copy the 
UNC path from the Address field in Windows Explorer and paste it into the 
Folder field.
Format. To specify the format of as run logs, select Harris or Omnibus.

SETTING UP A TV SCHEDULE PROVIDER

Instead of manually creating a capture schedule, you can use an Electronic 
Programming Guide (EPG) from Tribune to automatically populate your Today 
schedule. The benefit of using an EPG is that the schedule requires no manual 
configuration, it provides accurate recording times and related metadata.

Step 1 To display the TV Schedule provider properties, right-click the channel and 
select Properties. 

Step 2 Click the Providers Tab. Click TV Schedule in the table and click Properties. 
Open the TV Station node if not already open.

Note
If you have not purchased an EPG, the EPG data provided in the TV 
Schedule Provider Wizard is for demo purposes only and may not include 
your region. MAP supports daily downloads of EPG schedules for most 
North American channels direct from Tribune Media services. To enable 
this service contact Telestream Sales.
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Step 3 Complete these fields:
Call Sign. Enter the call sign of the station you’re capturing.
Location. Default: United States. Select the location of the station from the list.

Step 4 Click Configure to display the TV Schedule Provider wizard welcome window, 
and click Next to start.

Step 5 Select the country where the TV station is located and click Next,.

Step 6 In TV station list, select the station whose schedule you want to use for this 
channel and click Finish.
Capture.MAP will retrieve programming information for this station from the 
scheduling service and automatically create a 24-hour Exact schedule for this 
channel, and will continually make a new schedule near the end of each day for 
the next day’s programming.

CONVERTING SPEECH TO TEXT

You can use Microsoft speech recognition to process the audio channel of media 
and save the resulting text as temporal metadata. This feature is useful when 
closed captioning is not provided in-stream, and you need to have temporal text 
metadata generated from the audio signal directly.

To enable MAP to perform speech-to-text conversion of new media as it is 
captured, follow these steps:

Step 1 Display the properties dialog of the target media folder.

Step 2 In the Metadata tab, click Add. (If inactive, click Use the following metadata to 
override the parent folder’s metadata list.)

Step 3 Select Speech Recognition from the Select Metadata Design window and click 
OK.

Note
Text extraction from speech requires Microsoft Recognition Engine. See 
Enabling Speech Recognition, on page 5-25.
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Step 4 In the Speech Recognition Properties window, set Enable Speech Recognition to 
True and click OK. Optionally check Apply to all sub-folders. Click OK to close 
the Properties window.

Step 5 If you want to extract speech from media, right-click the media and select 
Analyze. After Factory.MAP performs the analysis, you can display the resulting 
text metadata in MAP Explorer by selecting the media and selecting text from the 
context menu in the temporal metadata frame at the bottom of the window.

ENABLING SPEECH RECOGNITION

When you assign a Speech Recognition metadata label to a media folder, MAP 
utilizes the Microsoft Speech Recognition engine to convert audio to speech and 
save it as text. 
To enable speech recognition text extraction, the Microsoft Speech Recognition 
Engine must be installed and enabled.

Step 1 Determine if the engine is installed. Open Control Panel > Add or Remove 
Programs. Look for Microsoft Speech Recognition Engine, version 5 or later. If it 
is not listed, download and install it from the Microsoft Web site and proceed.

Step 2 Open the Control Panel and display the Speech control panel. In the Speech 
Recognition tab, ensure that Microsoft English Recognizer is selected from the 
Language dropdown menu.

BURNING IN TIME CODE

When you capture media, you can set up the Capture Overlay filter to burn in the 
time code with an option date stamp as the media is digitized.

To enable the Capture Overlay filter, follow these steps:

Step 1 Open the management console and select the channel on which you want to burn 
in the time code.

Step 2 Right-click on the selected channel to display the Properties window.

Note
If you have upgraded MAP from a previous version, you can not enable 
the Capture Overlay filter on existing channels.
Create a new channel with identical settings, then delete the old one. 
Follow these steps to enable the Capture Overlay filter.
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Step 3 Display the Capture tab and click the Modify button to display the Encoder 
Properties window. 
Figure 5–17.  Use Filters tab to burn in time code

Step 4 On the Filters tab, select optional date burn-in, select a point size for the font, and 
adjust the position of both time code and date. 

Step 5 Click OK to update the channel, and close all of the windows.
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CONTENT.MAP ADMINISTRATION

Content.MAP administration is performed in the MAP management console, and 
involves setting up media folders in the MAP media database, based on your 
capture and usage requirements.
The configuration and administration of Content.MAP is critical to the operation 
of MAP. The heart of MAP is the MAP Content database. The Content database 
is controlled through the Content.MAP service and is responsible for the 
behavior of MAP media folders. The MAP content database is a hierarchical 
organization of media folders. 
Behavior is controlled by folder properties MAP administrators or users set, that 
apply rules and actions whenever media assets are ingested or when an action is 
requested through a MAP client. Content.MAP tracks media, metadata and other 
files associated with each MAP media asset in a virtual hierarchal folder 
structure. Media folders contain properties governing their behavior. These 
properties consist of authentication rules, user access rules, storage depot 
locations, metadata rules, notification rules and binder expiration rules. These 
properties may be inherited from parent folders, or they may vary from folder to 
folder allowing for different behavior based on organizational needs. 
Within a media folder an associated group of data (parent media asset, transcoded 
child media assets, track and label metadata, documents files and their respective 
network locations) are collectively known as a MAP binder. MAP binders are 
indexed to provide searching for any element that is associated with its Parent 
asset. Content.MAP creates new media folders and binders, and provides client 
access to existing ones. 
The Content service requires access to the all local and network storage locations 
containing media that is associated with a MAP binder, whether they are 
established through the Capture service or Content service.
It is important that all MAPreview servers and clients have proper access to all 
shared media locations, physical and/or virtual. It is also important to have all 
communications ports and protocols are opened and enabled in order to allow 
MAP services and clients to communicate properly. Work with your local IT staff 
to determine the level of authentication needed to access shared storage locations 
and to assure that all communications ports and methods are opened across your 
network.

ADD A TOP-LEVEL DISTRIBUTED MEDIA FOLDER

Creating a top-level media folder on a distributed Content.MAPreview server can 
only be performed in the management console. 

Note
You can also perform many local Content.MAP functions directly—and 
more conveniently—in MAP Explorer, including creating and deleting 
media folders and setting their properties.
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To add a new top-level media folder, follow these steps:

Step 1 Launch MAP management console and open the Content.MAP icon.

Step 2 Open the Content.MAP service where you want to add a top-level folder.

Step 3 Open the Media Folders icon to display the existing media folder structure.

Step 4 Right-click and select New > Folder. Content.MAP creates the folder and 
displays it directly under the Media Folders icon in alphabetic order. Rename the 
folder as appropriate.
Each media folder you create (regardless of the level) inherits its parent folder’s 
properties by default. A top-level media folder inherits the properties of the root 
media folder (always shown as Media Folders in Content.MAP management 
console). 
To view or change properties on a selected folder (and its children, optionally), 
right-click and select Properties on the media folder in the management console 
or MAP Explorer.

CONFIGURING MEDIA FOLDER PROPERTIES

In either the Content.MAP management console or in MAP Explorer, right-click 
the media folder you’re configuring and select Properties. 

Step 1 In the Authentication tab, determine if you want to inherit authentication method 
from the parent media folder or specify unique methods for this (and optionally, 
all sub-folders) media folder.

Step 2 In the Access tab, determine if you want to inherit access permissions from the 
parent folder or specify special permissions for this (and optionally, all sub 
folders) folder.

Step 3 In the Storage tab, determine if you want to use the storage locations from the 
parent folder or specify another storage location for this (and optionally, all sub 
folders) folder.

Step 4 In the Expiration tab, determine if you want to inherit expiration rules from the 
parent folder or specify when media expires for this (and optionally, all sub 
folders) folder. When media expires, it is moved to off-server archive locations, 
for later retrieval as necessary. Expiration rules are very dependent on your 
media production—ongoing, or project-oriented.

Step 5 In the Version tab, determine if you want to inherit new version rules from the 
parent folder or specify specific versions for this (and optionally, sub-folders) 

Note
Media Folder Properties details are located in Online Help, by clicking the 
Help icon in the MAP management console toolbar or clicking Help in 
MAP Explorer.
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folder. A version is a new media file and associated metadata, based on how you 
configure transcoding. 

Step 6 In the Metadata tab, determine if you want to inherit metadata rules from the 
parent folder or specify unique metadata for this (and optionally, all sub folders) 
folder.

CREATE A NEW VERSION OF MASTER MEDIA FILES

To create a new version of media when you drop in (or save in) MAP, follow 
these steps:

Step 1 Run MAP management console and open the Content.MAP icon to display one 
or more Content.MAP services you’re managing. 

Step 2 Open the selected Content.MAP service and open the media folders until you 
locate the folder you want to modify.

Step 3 Right-click the media folder to display the Versions properties dialog. 

Step 4 Click Create the following versions.

Step 5 Click Add and follow the instructions to select an encoder and then set up its 
properties.

Step 6 In the Version tab, determine where to save the new version of the media, and 
details about when to create it, where or not it displays in Explorer, and whether 
you want the media to expire.

Step 7 In the Encoder, Codecs, and Filter tabs, set up all of your transcoding 
information.

Step 8 Click OK to update the MAP system and close the dialog.

SAVING A NEW VERSION ON EXTERNAL SYSTEMS

To save a new version of media that Factory.MAP has transcoded onto a system 
outside of MAP (FTP server, on-air server, or a Windows server via 
HyperLaunch, for example), follow these steps:

Step 1 Display the properties dialog of the media folder where the original media is to 
be stored.

Note
Version Properties details are available in Online Help, by clicking the 
Help icon in the MAP management console toolbar.
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Step 2 Click the Version tab and select the version you want to save on the external 
system. (If you can’t select a version, it is because Inherit from parent folder is 
enabled, and the versions listed—if any—are owned by the parent.)

Step 3 Click Properties to display the selected version’s Properties window. In the 
Version tab, select Deliver to this media portal and enter the location in a fully-
formed format. (See Appendix C, Destinations on page C-1). 
It is best to use the Browse button, which displays the Network Location wizard 
and creates a properly-formed location automatically as you select the type of 
server and navigate to the destination (see [Tour 17] Creating a Media Portal, on 
page 5-31).

EXPORTING BINDERS TO ANOTHER MAP SYSTEMS

You can copy a media binder from one MAPreview server directly to another 
MAPreview server via HyperLaunch directly in MAP Explorer, provided that the 
target MAPreview server has HyperLaunch Receive Server operating (see 
Configuring HyperLaunch Receive Server on page 6-12).
To copy a media binder from one MAP system to another, use these steps:

Step 1 Open the media folder where the media binder is located.

Step 2 Right-click the binder and select Export > Browse from the context menu.

Step 3 MAP displays the MAP Network Location Wizard. (See Using the Network 
Location Wizard on page 5-33 for details.)

Step 4 In the Welcome window, select HyperLaunch Receive Server and click Next. 
(Other servers are not enabled in this version of MAP and will cause an error.)

Step 5 In the HyperLaunch Receive server window, enter the name or the IP address of 
the HyperLaunch Receive server on the target MAP system, and click Next.

Step 6 In the Account window, enter the user name and password and click Next.

Step 7 MAP connects to the HyperLaunch Receive Server and displays the directory. 
Browse to and select the destination media folder on this MAPreview server, and 
click Finish to transfer the binder.
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FACTORY.MAP ADMINISTRATION

Factory.MAP usually performs its tasks of extracting metadata and transcoding 
media transparently to media producers or end users. As a MAP administrator, 
you can monitor Factory.MAP jobs using the Factory.MAP operator console.

CONCURRENT TRANSCODING JOBS

Each Factory.MAP service by default can process two transcoding job 
simultaneously. Telestream recommends setting the transcoding limit to match 
the number of processors on the server, then experimenting with performance. 
If you set the limit too high, you may cause inefficiencies by adding unnecessary 
context-swapping overhead. A higher number may be appropriate for many small 
jobs; a lower number is indicated when you have fewer, larger jobs (involving 
input clips that are a few minutes in duration or longer).
To change the number of simultaneous transcoding jobs, follow these 
instructions: 

Step 1 Click Start > Run to display the Run window.

Step 2 Type regedit and click OK to display the Registry Editor window.
Figure 5–18.  Registry Editor Window in Windows

Caution
Editing the Windows registry incorrectly may cause Factory.MAP to 
fail, or your server to stop operating. Make a backup of your registry 
to ensure that you can restore it if you make an error. If you are 
unsure of how to back up the registry, or perform editing correctly, 
check with your systems administrator.
As an added precaution, Telestream recommends creating a restore 
point in case you need to recover your system. To manually create a 
restore point, click start > All Programs > Accessories > System 
Tools > System Restore. In the System Restore dialog, click Create a 
Restore point and click Next. Enter a name and click Create.
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The directory is displayed in the left frame; the entries for the selected folder are 
displayed in the right editor frame. 

Step 3 To create an entry, right-click in the editor frame to display the New menu. Select 
the type of entry to create from the dropdown menu. 
To edit an entry, double-click the entry. Use the editor window to name it and 
provide the appropriate value for your system. 
For more information on using the Registry Editor, see your operating system 
manual.

MONITORING AND RESUBMITTING TRANSCODING JOBS

Use the Factory.MAP operator console to monitor transcoding jobs. To display 
the console, right-click on the Factory.MAP icon (a red wrench) in the tooltray 
and select Show or just double-click the icon. 
The Factory.MAP console has two tabs: Active and Failed. The Active tab 
displays a list of transcoding jobs it is currently processing, along with details 
about each job. You can click any job in progress to pause it, resume it, or delete 
it. If you have more than one Factory.MAP service running in your MAP 
installation, select the Factory.MAPreview server from the popup list at the 
bottom left corner to monitor it.
The Failed tab displays jobs that did not complete normally. For jobs that have 
failed select Retry or Delete, after you’ve reviewed and fixed the failure reason.

Note
All MAP registry entries are stored in the path 
HKEY_LOCAL_MACHINE\SOFTWARE\Telestream\MAP. Each time you 
make changes to the MAP registry entries, you must stop and restart the 
affected service for the changes to take effect. In this case, restart 
Factory.MAP.
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USING ARCHIVE.MAP
Archive.MAP is an application which provides support for archiving media 
stored in your MAP media database, including associated metadata and the 
media files. Archival is an ongoing process based on the rules set up within 
media folders via the Expiration tab in the Properties folder. The default device 
for MAP archive is DVD. Additional archive methods are available based on 
Microsoft’s Removable Storage Manager.
Two tours in the Quick Start Guide describe how to archive and restore media.

ARCHIVING EXPIRED MEDIA

Archive.MAP will advise you via a popup from the tooltray that media is ready 
to archive and you should insert a disk (DVD or CD).

Step 1 In your toolbar, right-click on the Archive.MAP icon (disk icon) and select Show 
to display the Archive.MAP operator console.
The Archive Requests tab displays a list of all binders that are ready for 
archiving. Binders are processed serially in a First-In, First-Out (FIFO) fashion. 
The Drives tab (below) lists each drive that can be used to archive media. 

Step 2 Select the drive that is to be used for archive (if using CD-W or DVD insert a 
writable CD-ROM or DVD making sure your CD/DVD device can write the 
appropriate volume. If the disk is not formatted for ISO 9660, make sure you do 
so before beginning the archive).

Step 3 With the drive highlighted select Start Archive. 
Archiving will continue and will archive media to the selected drive until Stop is 
selected. If you leave the Archive service on, all archive requests will be 
automatically archived.

RESTORING ARCHIVED MEDIA

Over time, your MAP system will have media stored in its default store and 
media stored on archive volumes, which is only available for access when it has 
been placed back on the default store. 
When a MAP consumer selects archived media and attempts to update metadata 
or play the media, Content.MAP sends a Restore message to Archive.MAP and 
advises the end user that the message has been sent.
Archive.MAP then notifies the MAP administrator via a popup to insert the 
appropriate archive volume. When you receive the notification, follow these 
steps to restore the requested media:

Step 1 Right-click Archive.MAP in the tooltray and select Show to display the console. 
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C     H     A     P     T     E     R 6

Web Access, HyperLaunch
Receive Server, Gateway
This chapter provides MAP administrators step-by-step instructions for 
configuring MAP for publishing MAP media via IIS, Windows Media Server and 
SharePoint, and for configuring and managing HyperLaunch Receive Server and 
Gateway.MAP. 

Topics Configuring MAP for Web Access
Configure Window Media Service and Virtual Directories (page 6-2)
Configure Window Media Service and Virtual Directories (page 6-2)
Install MAP Web Search on IIS Server (page 6-5)
Configuring Content.MAP for IIS Access (page 6-6)
Creating Aliases for Web Access (page 6-8)
Configuring MAP for Access via Web Browser (page 6-10)

Using HyperLaunch Receive Server
Configuring HyperLaunch Receive Server (page 6-12)
Monitoring a HyperLaunch Receive Server (page 6-14)

Configuring and Using Gateway.MAP
Using the Gateway.MAP Console (page 6-16)
Creating a ClipMail Account (page 6-18)
Setting up a ClipMail Address for Sending Media via Gateway.MAP 
(page 6-20)
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CONFIGURING MAP FOR WEB ACCESS

You can use IIS, WMS, and other Web-based publishing systems to publish MAP 
media. Installing and configuring Web and media server systems is beyond the 
scope of this guide. If you plan to use IIS, you should install and configure 
Microsoft IIS before proceeding. If you plan to use WMS, install and configure 
Windows Media Service before proceeding.
To provide Web browsers access to media in MAP media folders, you must 
perform these tasks:

Set up virtual directories in IIS or publishing points in WMS
Install MAP Web Search
Configure Content.MAP for Web access to media
Configure Capture.MAP (if using it) for Web access to media.

CONFIGURE WINDOW MEDIA SERVICE AND VIRTUAL DIRECTORIES

To permit Web browsers to view media from MAP using Windows Media 
Service, you create publishing points in WMS that identify the Content.MAP and 
Capture.MAP media folders you want published. Then, you configure each 
storage depot assigned to media folders with an alias, so that WMS can deliver 
the actual media when it is played.
On a single MAP system with capturing enabled, you may be using the same 
physical store for both manually saved media and captured media. However, you 
may set up different storage depots – or series of storage depots – one series for 
manually saved media, and another series for captured media.
For each storage depot you’ve created, you provide a separate publishing point in 
WMS. For example, if you provide three storage depots in series to allow for 
growth of media in Content.MAP or Capture.MAP, you must provide a separate 
publishing point for each one.

Create a WMS 
Publishing Point

To create a publishing point in WMS, follow these steps.

Step 1 Open Control Panel > Administrative Tools > Computer Management.

Step 2 In the Computer Management Window, expand Services and Applications > 
Windows Media Services > [YourWindowsMediaServerName].

Step 3 Right-click Publishing Points and select Add Publishing Point (Wizard) to run 
the Publishing Point Wizard.

Step 4 When the Welcome window displays, click Next to continue.

Step 5 Publishing Point Name. Enter the display name for this publishing point. 
Typically, you should name the publishing point in a descriptive manner. For 
example, Capture1Media. Click Next to continue.
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Step 6 Content Type. Select the type of media you’re publishing – check Files, and 
click Next to continue.

Step 7 Publishing Point Type. Check On Demand Publishing Point and click Next.

Step 8 Directory Location. Browse to the physical folder of the storage depot if the 
media is local.
If the storage depot is on a server, use Windows Explorer to navigate to the 
location. Then, copy and paste the UNC path into this field.

Step 9 Content Playback. Leave both options unchecked and click Next.

Step 10 Unicast Logging. Check this option if you want to enable logging. Click Next.

Step 11 Publishing Point Summary. Review your settings, make changes as necessary, 
and click Next to create the publishing point.

Step 12 Uncheck After the Wizard finishes and click Finish to create the publishing point.

Step 13 Next, test a media file in the publishing point you just created. Select the 
publishing point, click the Source tab and play a media file or playlist to make 
sure that you can access and play the media.

CONFIGURE IIS AND VIRTUAL DIRECTORIES

If you’re running MAP and IIS on the same server, Telestream recommends you 
install IIS before installing MAP. 

Make sure that the port you assign to IIS is the same port you use when you 
install MAP Web Search.
Next, create virtual folders in IIS that identify the Content.MAP, Factory.MAP, 
and Capture.MAP media folders you want published, and then configure each 
storage depot assigned to media folders with an alias, so that IIS can deliver the 
actual media when it is played.

Note
On Windows XP only, if you install MAP services before installing IIS, you 
need to re-register ASP.NET for use with IIS. See Re-installing ASP.NET 
for IIS on page 3-35.
If IIS is already installed for port 80, change the port by running the IIS 
management console. Open the local computer, and the Web Sites folder. 
Select Properties on the Default Web site and update the port number 
(suggested 8000) and click OK. You can not use port 80 with MAP, 
because MAP services use port 80 to interoperate.
Restart IIS to take effect.
On Windows 2003,when you install IIS, you must check ASP.NET or it will 
not be installed. In Add/Remove Programs, open Add/Remove Windows 
Components. In Windows Components Wizard, select Application Server 
then click Details and check ASP.NET and continue to install.
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On a single MAP system with capturing enabled, you may be using the same 
physical store for both manually saved media and captured media. However, you 
may set up different storage depots – or series of storage depots – one series for 
manually saved media, and another series for captured media.
For each storage depot you’ve created, you provide an alias in IIS. For example, 
if you provide three storage depots in series to allow for growth of media in 
Content.MAP or Capture.MAP, you must provide a separate virtual directory for 
each one.
The virtual directories are used as alias locations for MAP media. After you 
create a virtual directory in IIS, connect the virtual directory’s alias path to the 
MAP storage depot, as described in Creating Aliases for Web Access on page 
6-8.

Create a Virtual 
Directory in IIS

To create a virtual directory in IIS, follow these steps.

Step 1 Click start > Administrative Tools > Internet Information Services to launch the 
IIS management console.

Step 2 On the MAPreview server, open Web Sites and Default Web Site (or other Web 
site as appropriate).

Step 3 Right-click the Default Web Site icon and select New > Virtual Directory to run 
the Virtual Directory Creation Wizard.

Step 4 Click Next to continue.

Step 5 Enter the name of the alias. Telestream recommends naming virtual directories 
the same as the storage depot where the media is stored. If there is more than one 
Content.MAP storage depot, you might name them content1, content2, and 
content3, for example. For storage depots used in Capture.MAP, you might name 
them capture1, capture2, and capture3.

Step 6 Click Next to display the Web Site Content Directory frame.

Step 7 Browse to the physical folder of the storage depot, where the media is located.

Step 8 Click Next to display Access Permissions frame. Don’t change these settings.
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Step 9 Click Next and click Finish to create the virtual directory.
Figure 6–1.  IIS virtual directories correspond to MAP stores

These virtual directories are used as aliases in Content.MAP to connect IIS to the 
actual media store via the alias.
Figure 6–2.  Configure virtual directories with a UNC path

Make sure that the Network Directory is a UNC path to the physical media. The 
Application name is the virtual directory.
For Capture.MAP stores, make sure they are read-only. Check Read directly 
under Network Directory.

INSTALL MAP WEB SEARCH ON IIS SERVER

After installing and configuring IIS, install MAP Web Search on the MAPreview 
server. For installation instructions, see Installing MAP Search on page 3-31.

Add virtual 
directories for 
each storage 
depot in 
Content & 
Capture.MAP.
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CONFIGURING CONTENT.MAP FOR IIS ACCESS

To provide IIS access to MAP media, you configure the Content.MAP service 
that owns the media.

Provide 
Credentials

If the media is stored physically on network servers other than the 
Content.MAPreview server, the service must log in with proper credentials to 
access the target media. 
To display the service properties, open Control Panel > Administrative Tools > 
Services. Right-click Content.MAP and Select properties.
Figure 6–3.  Specify an account for media access credentials

On the Log On Tab, click This Account and provide an account and password 
with proper credentials to access the media. For more details, see your network 
administrator. See Stores Credentials on page 4-4.

Referencing Media 
Folder Stores

Content.MAP must also reference the storage depots as a UNC path (regardless 
of whether the media is local or on a network server) to provide an unambiguous 
identity for IIS.
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Run the MAP management console and open Content.MAP. Select the target 
Content.MAP service if more than one is installed.
Figure 6–4.  Select the media folder in the management console

For each media folder you’re providing Web access to:
Right-click to display the properties dialog, display the Storage tab and select the 
storage location for media that Content.MAP will use.
Figure 6–5.  Display media folder properties and click Storage

Specifying 
Capture Stores as 
UNC Paths

Capture.MAP must also reference the storage depots as a UNC path (regardless 
of whether the media is local or on a network server) to provide an unambiguous 
identity for IIS. If you have already added one or more network capture stores for 
this media folder, verify that the store location is specified in UNC path format 
(\\map4cap\Capture, for example). Verify that the stores listed are in UNC path 
format, and their status is OK.
For each network store is not in UNC path format, note the server and directory. 
Then, delete the store and click Add Store. Browse to My Network Places, then 
locate the server and navigate to the target directory and click OK. The store is 
now referenced in UNC path format.

Storage depots being used by the 
Content.MAP service.
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Adding a Store in 
UNC Path Format

To add a network capture store in UNC path format, click Add. Browse to My 
Network Places, then locate the server and navigate to the target directory and 
click OK. The store is now referenced in UNC path format

CREATING ALIASES FOR WEB ACCESS

When you have enabled Web access (by enabling IIS and installing MAP Web 
Search) to your MAP system, you must supply an alias to the media so it can be 
played.
To provide media access via a Web browser, you must supply an alias so IIS can 
locate it. If you only have media that has been dropped in or saved from 3rd party 
programs, or if you are capturing media and storing it in the same physical store 
as dropped in/saved media, then you only have to create one virtual directory in 
IIS to provide Web access.
However, if you have a separate storage depot for dropped in/saved media, and 
another for captured media, you must create two virtual directories in IIS, and 
add the captured media store to the list of storage depots in Content.MAP, and 
supply the proper alias. 

To supply an alias to a storage depot, select the depot after creating it and click 
Properties.
Figure 6–6.  Use Depot Properties to permit access via a Web browser or 
streaming server

In the alias location field, enter the URL of the virtual directory you created in 
the IIS management console to point to the same directory. The form is http:// 
<MAPServerName | localhost: <IIS Port Number> / VirtualDirectory. For 
example, http://mapserver4:8000/content1.

Note
When creating an alias for manually saved media, do not check Storage 
depot is read-only. However, when creating an alias for captured media, 
you should check Storage depot is read-only.

UNC path to physical storage 
location - storage depot.

Web alias associated with this 
storage location.
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Alternately, click Browse to run the Network Location Wizard, locate the virtual 
directory and generate the path for you.
Figure 6–7.  The Network Location wizard finds destinations

Select the type of location from the popup – in this case, a Web Server because 
you’re attaching to the virtual directory in IIS.
Click Next to identify the server.
Figure 6–8.  Identify the server destination and port

Enter the name or IP address of the Web server—it is the same MAPreview 
server where your Content.MAP service is running. If you’re running locally, 
you can enter localhost. Next, enter the IP address of the IIS server (default 
8000).
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Click Next to continue.
Figure 6–9.  Enter user info or check Use anonymous access

Enter the user name and password and domain of the user used to run IIS, if 
you’re not using anonymous access. Click Next.
Figure 6–10.  Select the directory for media delivery

IIS does not report virtual folders. You can identify the Web server and port, then 
manually enter the folder (/content/, for example—be sure to supply leading and 
trailing slash marks. Click the green GO button or press enter, and IIS will 
display the actual directory to indicate your path is correct. Click Finish to insert 
the path you just created.
Click OK to update and dismiss the window. 

CONFIGURING MAP FOR ACCESS VIA WEB BROWSER

To use a Web browser for MAP access, you should have activated and configured 
IIS and installed MAP Web Search (Installing MAP Search on page 3-31). You 
also need to configure MAP to allow IIS access to the media (Create a WMS 
Publishing Point on page 6-2).
To access your MAP system from the Web browser, you need to know the 
following information:
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Your MAPreview server name or IP address, or localhost when connecting 
on same computer.
The port your IIS Web server is listening on (recommended port is 8000)
The name of the virtual MAP Web folder in IIS (default: WebClient)

The form of the URL for accessing MAP is:
http://<MAPServer Name | IP Address> : <Port Number> / <MAP Web Folder>
For example, to access the MAP system using a browser running directly on the 
MAPreview server, you’d enter this URL:
http://localhost:8000/WebClient
To access the MAP system from another computer in the network:
http://MAPServer:8000/WebClient. 

If the URL is not found, make sure the IIS system is running and retry.

Note
If 2 or 3 lines of text display when you log in, the administrator may not 
have installed ASP.NET correctly. See Re-installing ASP.NET for IIS on 
page 3-35.
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USING HYPERLAUNCH RECEIVE SERVER

HyperLaunch is Telestream’s patent-pending high-performance, fault-tolerant 
protocol for guaranteed, secure delivery of digital media and associated 
documents anywhere in the world from remote or portable locations.
HyperLaunch Receive Server improves Internet delivery of media by 
automatically recovering from network interruptions and failures, relocation of 
mobile MAPreview servers, and enhancing throughput.
HyperLaunch builds on IP and TCP to establish logical sessions between 
communicating applications and accomplish high-performance, guaranteed, 
secure media delivery.

CONFIGURING HYPERLAUNCH RECEIVE SERVER

Before you can send media files or MAP binders to a HyperLaunch Receive 
Server you need to configure it, following these steps.

Step 1 If the HyperLaunch Receive Server console isn’t open from the previous task, 
open it now.

Step 2 Open Receive.MAP and right-click on localhost; select Properties to display the 
properties window.
Figure 6–11.  HyperLaunch Receive Server properties

Set up the following values:

Receive Settings
Receive Path. Click Browse to select the fully-qualified path where incoming 
media or binders are to be saved. 
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Port. The UDP port default value is 8090. May be changed — be sure to advise 
users if you change this value.

Sessions Settings
Maximum Concurrent Sessions. Select Unlimited, or select Limited to, and 
limit the maximum number of sessions to a specific amount (usually based on 
file size, typical usage, and bandwidth). 
Time-out. Specify the number of hours that a session can be kept alive.
Figure 6–12.  Use the Security tab to save the security key

When your server is started, Windows creates an RSA public/private security 
key. The public portion of the key is displayed in the Security tab. Each time the 
machine is started, the keys are regenerated, but remain the same as long as the 
machine name does not change.

Click Save to save the key as an XML file (required only in HyperLaunch 
Receive Server versions older than Version 1.1) so that you can provide it to 
MAP users to gain access to the HyperLaunch Receive Server. 

Note
A component of the key is based on the server’s name. If you change the 
name of the server, previously distributed keys will be obsolete.

Caution
Distribution of the public key — and storage of it on your MAPreview 
servers — is completely external to MAP. You must ensure the safety of 
the key during transmission and storage on both the sending and 
receiving computers to guarantee the integrity of your server via 
HyperLaunch.
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MONITORING A HYPERLAUNCH RECEIVE SERVER

HyperLaunch (and Secure HyperLaunch) is on optional durable, secure, high-
performance digital media transport protocol integrated into MAP and 
FlipFactory. To deliver media and related documents to a Windows server via 
HyperLaunch, HyperLaunch Receive Server must be installed and configured on 
a Windows server (Installing Gateway.MAP on page 3-19).
After installing HyperLaunch Receive Server, you can monitor its status and 
current connections.

Launch the 
Management 
Console

If you added HyperLaunch Receive Server to an existing console, open it. If you 
saved it as a separate console in its default location, click start > All Programs > 
Administrative Tools > HyperLaunch Receive Server). 
Open the Receive.MAP icon. If the localhost entry does not display (unavailable) 
the service is running. If localhost displays (unavailable), open the Windows 
services window (Control Panel > Administrative Tools > Services and start the 
HyperLaunch Receive service. 

Monitor Current 
Sessions

Open localhost to display current sessions.
Figure 6–13.  Use the console to monitor sessions

Start HyperLaunch 
Receive Server

By default, HyperLaunch Receive Server is set to automatically start each time 
the server starts. To start it immediately after installation:
Restart the server
–or–
Open Control Panel > Administrative Tools > Services to display the Services 
window. Right-click on HyperLaunch Receive Server, select Start and close the 
windows after HyperLaunch has started.

Add HyperLaunch 
Receive Server to 
MMC

To configure and monitor HyperLaunch Receive Server, Telestream provides a 
Microsoft Management Console (MMC) snap-in, like MAP services. You can 
install the snap-in in a new console or add it to an existing console.
To add the snap-in to a console, follow these steps.

Step 1 Click start > Run... and enter mmc in the Open dropdown menu in the Run 
window.
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Step 2 Click OK to start Microsoft Management Console.

Step 3 To add a snap-in to an existing console (your MAP console for example), click 
File > Open and select the console. (The MAP console is located at C:\\Program 
Files\Telestream\MAP\MAP.msc if you are installing on a MAPreview server.)

Step 4 To create a new console, click File > New.

Step 5 With the console window displayed, click File > Add/Remove Snap-in and click 
Add. From the list of snap-ins, select HyperLaunch Receive Server and click 
Add. When the snap-in has been added, click Close. 

Step 6 Click OK to close the Add/Remove Snap-in window. 
When the snap-in has been installed, the console displays HyperLaunch Receive 
Service, with one server—localhost. If the service is not running, localhost 
displays an error message in parentheses: (unavailable).
Figure 6–14.  Configure and monitor HyperLaunch Receive Server in MMC

Save the console (File > Save). If the console is new, provide the console a name 
— HyperLaunch, for example. By default, consoles (with the .msc suffix) are 
stored with Window’s other administrative tools. 

Run the HyperLaunch 
Receive Server 
Console

To use the console you just created, click Start > All Programs > Administrative 
Tools > HyperLaunch Receive Server.
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CONFIGURING AND USING GATEWAY.MAP
Gateway.MAP allows media to be remotely delivered into a MAP Content 
database from Telestream ClipMail appliances, and monitored network or local 
folders. When you install Gateway.MAP on a server in your environment and 
configure it with accounts associated with a specific media folder, remote users 
can deliver media directly to a MAP media folder via network or local folders, 
ClipMail, or FTP from anywhere in the world.
Gateway.MAP is used to ingest media from a remote ClipMail, an FTP folder, 
and network or local folders. Third-party encoder products (hardware or 
software) can deliver their encoded files to a Gateway.MAP monitored folder for 
ingest directly into MAP.

USING THE GATEWAY.MAP CONSOLE

The Gateway.MAP console is accessed by double-clicking the minimized 
console in the task bar, or by right-clicking the Gateway.MAP icon in the toolbar 
and selecting show, or just by double-clicking the icon.
The Gateway.MAP console has three tabs: Accounts, ClipMail Status, and Folder 
Monitor Status. 
Figure 6–15.  Gateway.MAP console – Accounts tab

The Accounts tab displays your current Gateway.MAP accounts and the media 
folder they represent. Click New to create a new account, or select and existing 
account to display its properties, or to delete it.
Figure 6–16.  Gateway.MAP console – ClipMail Status tab
6-16 May 2008



74-0053-01 Web Access, HyperLaunch Receive Server, Gateway
The ClipMail Status tab lists file transfer tasks in order of processing, plus details 
about the task. When files are being ingested from a ClipMail the respective task 
is displayed with it current status. Select a task to delete it. 
Figure 6–17.  Gateway.MAP console – Folder Monitor Status tab

The Folder Monitor Status tabs lists file transfer tasks in order of processing, plus 
details about the task. When files are being ingested from a monitored folder the 
respective task is displayed with it current status. Select a task to delete it.
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CREATING A CLIPMAIL ACCOUNT

To create a new account to receive media from ClipMail, follow these steps:

Step 1 Display the Gateway.MAP console and display the Accounts tab.

Step 2 Click the New icon at the bottom to display the Account Properties dialog.

Step 3 Select the ClipMail tab.
Figure 6–18.  ClipMail Account Properties dialog

Step 4 In the Gateway Account Name field, enter an appropriate name. This is the name 
that is displayed in the list, and provided to the ClipMail user for creating a 
ClipMail address.

Step 5 Click Browse and navigate to the MAP media folder you want to select as the 
destination folder and click OK.

Step 6 Document the Gateway account name for use by your ClipMail users (Creating a 
ClipMail Account on page 6-18).

Step 7 Close the dialog.
6-18 May 2008



74-0053-01 Web Access, HyperLaunch Receive Server, Gateway
CREATING A FOLDER MONITOR ACCOUNT

To create a new account to monitor a network or local folder, follow these steps:

Step 1 Display the Gateway.MAP console and display the Accounts tab.

Step 2 Click the New icon at the bottom to display the Account Properties dialog.

Step 3 Select the Folder Monitor tab.
Figure 6–19.  Folder Monitor Account Properties dialog

Step 4 Click Browse and navigate to the local or network folder you want to select as 
the source (monitored) folder and click OK.

Step 5 Click Browse and navigate to the MAP media folder you want to select as the 
destination folder and click OK.

Step 6 Select the appropriate action (file match patterns, look in subfolders, delete from 
folder and recover media) to take in this folder when media arrives. 

Step 7 Click OK to close the dialog.
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SETTING UP A CLIPMAIL ADDRESS FOR 
SENDING MEDIA VIA GATEWAY.MAP

To create a ClipMail address for a MAP media folder, follow these steps:

Step 1 On the ClipMail appliance click Set Up on the Address Tab, or click the Send To 
button to display the Edit Address screen.
Figure 6–20.  Setting up a gateway address in ClipMail

Step 2 In the ClipMail field, enter this string: 
<accountname>@Gateway.MAP@<MAPreview server DNS name or IP 
Address>. 
For example, GatewayAcct@Gateway.MAP@map.grokmedia.com, or 
GatewayAcct@Gateway.MAP@192.168.127.100
where accountname is the name you provided for the Gateway.MAP account (the 
name in ClipMail is case-sensitive), @Gateway.MAP is a constant which must be 
in each address, and @DNS name or IP address is the MAPreview server’s fully-
qualified DNS name or IP address.

Step 3 Click Done to save the address.
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MAP System Planning Guide
This chapter provides the information you need to plan, implement, and 
configure a MAP installation. In this chapter, you’ll also review the hardware and 
software platform requirements for MAP services and client programs, so that 
you can audit your systems and upgrade or purchase systems configured to meet 
your specific MAP system requirements. 

SYSTEM PLANNING

Configuring a multi-server MAP or MAPreview system is a straightforward 
process. To determine how to configure a system you'll need to determine:
• Number of live channels you plan to capture
• Desired bit rate, frame size, and frame rate for the captured material
• Length of time the capture segments are required to be online
• Storage requirements for captured media, manually or automatic file ingest 

and transcoded media files
• Transcoding and analysis needs (may require additional Factory server)
• How many concurrent clients will be accessing the system
• How to configure MAP for your network.
With these specifications and plans, you'll be able to provide Telestream the 
information we will need to configure a system that will meet your needs or 
configure your own MAP system.

Single Server 
Drive & Partition 
Requirements

You should configure a MAPreview server that is intended to run all MAP 
services with at least 2 hard drives, or with a single hard drive or RAID with 2 or 
more partitions. The OS and MAP drive/partition should be at least 50GB and 
allocated exclusively to MAP services and related MAP software, and the MAP 
database.
The other drives or partitions should be sized according to media capture 
requirements and exclusively allocated to captured media.

Note
If you plan to capture one or two channels, store 200GB (or less) of media 
in MAP and have five or less MAP clients connected concurrently, 
consider installing MAP on a single computer (and skip this chapter).
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MAP Capture 
Server 
Requirements

You should configure each Capture server with at least 2 hard drives, or with a 
single hard drive or RAID with 2 or more partitions. The OS and MAP drive/
partition should be at least 20GB so that you can install Windows, and also install 
MAP services on the OS/MAP drive. 
The other drives or partitions should be sized according to media capture 
requirements and exclusively allocated to captured media.
A MAP Capture server is capable of capturing four simultaneous feeds, frame 
size of 320 x 240 up to approximately 1Mbps with sufficient CPU overhead. 
Encoding is primarily done in software and utilizes a great deal of the overall 
CPU with four concurrent capture sessions consuming greater then 50% of the 
CPU.
Capturing at bit rates higher than 1Mbps, using frame sizes larger than 320 x 240 
or applying the MAP Capture overlap feature (using Simulstream) on all four 
channels may push the CPU utilization to or over 100%. In these situations the 
OS may become unstable, increasing the risk of an encoder failure. This situation 
could cause timer-sensitive, low-level operations to fail and should be avoided. 
Three factors influence how much CPU load your server will experience during 
capture: the frame size, bit rate and number of concurrent captures. 
Standard MAP Capture servers are equipped with Dual 3.0Ghz Xeon CPUs, 
800Mhz FSB, 1GB RAM and 500GB internal RAID-5 storage.
To avoid CPU overload when capturing four (4) live feeds and segment overlap 
you can:
• Minimize the overlap period to <=3 seconds and use staggered segmented 

schedules where only one channel is in an overlap period at any one time (All 
channels will always start and end on day transitions)

• Use smaller frame sizes such as 160 X 120
• Reduce the number of live feeds being captured to less than four (4).
To determine platform requirements for live feed captures, you will need to 
determine the number of live feeds (channels) you plan to capture concurrently 
and there respective frame size/bit rate. 
As a general rule, each Capture server can handle up to four (4) CIF, 30fps, up to 
1Mbps encodes or two (2) full frame, 30fps, up to 4Mbps encodes.

Media Storage 
Requirements

When you capture live media, flip into other media formats or acquire existing 
media files from media applications or systems, MAPreview stores them in the 
MAP media database, under control of the Content service. The physical 
locations for these files can be a local to the Capture or Content server or can be 
any other network accessible storage location(s).
Three factors determine how much storage space your daily media capture or 
acquisition requires: 
• the number of channels you capture or pre-existing media files you acquire
• the bit rate of the captured media files (directly related to the size)
• the length of time that these files will need to remain in online storage prior to 

archive or automatic deletion.
When specifying stores for Capture servers, you should stored the captured 
media files locally on the server. A Capture server from Telestream has 500GB of 
media storage space (larger storage capacity is available as optional upgrades). 
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For each Capture server, determine the storage requirements by multiplying the 
number of live feeds that will be captured times the value representing the daily 
storage requirements (see chart below) for any given bit rate times the desire 
length of time the media needs to be online.

If you plan on transcoding the captured media files to other formats or adding 
media to the MAP Content media database via other means, take this into 
account when determining the required amount of storage. Generally, files added 
to the media database by means other than a Capture server are stored in a 
separate storage location – a local drive or server.
To estimate your ongoing disk space requirements, multiply the total volume 
requirements for additional media file category by the number of days you plan 
to keep the media online in the MAP media database. These file generally are 
store in local storage on the MAP Content server but can be stored anywhere 
within your network. Determine where these media files will be stored and take 
this into account when determining your storage needs.

MAP Content and 
Factory Server 
Requirements

You should configure a MAPreview server that is intended to run all MAP 
services with at least 2 hard drives, or with a single hard drive or RAID with 2 or 
more partitions. The OS and MAP drive/partition should be at least 50GB and 
allocated exclusively to MAP services and related MAP software, and the MAP 
database.

Note
Telestream has made it easy to calculate storage needs. Go to http://
www.telestream.net/calculator/mapcalculator.htm and plug in your 
numbers.

Table 7–1. Daily Media Capture Space Requirements

Low Res 
(200 kbps)

Medium Res
(500 kbps)

Med. Hi Res
(750 kbps)

Hi Res
(1 mbps)

2.2 GB 5.4 GB 8.1 GB 10.8 GB

Note
When calculating storage requirements for a capture server, be sure to 
take into account the repeated writing and deleting of media files in 
storage depots, leading to disk fragmentation. The negative effects of 
fragmentation are multiplied as the disk is filled to 70% capacity or more.
Effects include degraded OS performance and if left unchecked, can 
render the OS unresponsive. It is considered good practice to maintain 
50% available storage. Multiply your net storage requirements by 1.5 to 
determine gross storage requirements. 
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The other drives or partitions should be sized according to media capture 
requirements and exclusively allocated to captured media.
CPU usage on your MAP Content server is generally a function of concurrent 
client connections (searches for media content) and the Factory service 
analyzing/transcoding media files. During peak usage you may encounter times 
when the Content service is using significant CPU resources (during searches, for 
example) and the Factory service is consuming significant CPU resources 
analyzing and/or transcoding jobs. 
As a general rule of thumb, a server running both the Content and Factory service 
can operate efficiently with 10 concurrent clients and with up to 8 channels being 
concurrently analyzed. Use the following guidelines to determine your 
requirements.
Additional Factory servers can be utilized to process a greater number of 
captured channels and/or additional transcoding needs. 
• Systems with 8 or fewer live capture feeds, 10 or fewer concurrent clients 

licenses and little or no transcoding can safely run both the Content and Fac-
tory services on a single server [Dual Xeon 3.0Ghz (or higher), 2GB RAM 
(or more)]

• Systems with greater than 8 and less than 21 live feeds, between 10 and 20 
concurrent client licenses and up to medium transcoding needs should sepa-
rate the Content service and Factory service on separate servers [Dual Xeon 
3.0Ghz (or higher), 2GB RAM (or more)]

• Systems requiring additional transcoding and/or more than 20 live feeds will 
need to add Content and Factory servers where appropriate.
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Upgrading, Repairing, and
Uninstalling MAP
Use this chapter to upgrade, repair, or uninstall MAP services, utility, and client 
applications.

Topics Upgrading a MAP System on page 8-2
Repairing a MAP System on page 8-2
Uninstalling MAP Services on page 8-3
Uninstalling MAP Player, Explorer, and Quick Review on page 8-3
Uninstalling Gateway.MAP on page 8-3
Uninstalling MAP Web Search on page 8-3
Uninstalling HyperLaunch Receive Server on page 8-3
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UPGRADING A MAP SYSTEM

To upgrade MAP services from a previous version, follow these steps.

Step 1 Notify each MAP Explorer user to document their connected media folders and 
media portals.

Step 2 When you upgrade to a new MAP version, the connections to media folders and 
media portals are removed.

Step 3 Close any applications that are accessing MAP services including MAP Explorer, 
MAP Quick Review, and MAP Player, plus third party media applications and 
Web clients that may be connected.

Step 4 Perform a backup to archive all user data, including the MAP Content database 
and any media directories.

Step 5 If you’re upgrading from any MAP version less than 2.0.1, remove USB dongles 
from your MAPreview servers during the upgrade. If you don’t, Windows may 
notify you of a device conflict. If you are upgrading from version 2.0.1 or later, 
you do not need to remove the dongles.

Step 6 Uninstall all MAP services you plan to upgrade.

Step 7 Restart your server.

Step 8 Perform an installation of the new version of MAP following the instructions 
found in Installing MAP Services on page 3-14.

Step 9 Replace the dongles on your MAPreview servers and restart your server.

REPAIRING A MAP SYSTEM

To repair a MAP system, uninstall and re-install the software, following the 
directions in Installing MAP Services, Clients, & Utilities on page 3-1.

Note
When you upgrade MAP, all of the media folder connections displayed 
under My Network Places > Media Application Platform are removed. 
Review the connections before installing and make a list so that you can 
re-create them after upgrading.

Note
Do not use the Repair button on the MAP installer – it is inoperative.
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UNINSTALLING MAP SERVICES

To uninstall MAP services, follow these steps:
Open Control Panel > Add or Remove Programs and click MAP. 
Windows removes all MAP components—you can not uninstall a portion of 
MAP. All MAP services are uninstalled, and MAP Explorer, MAP Quick 
Review, MAP Player, and Archive and Factory operator consoles are uninstalled.
If you have uninstalled MAP Services, you should uninstall Gateway.MAP if it is 
on the same server before restarting the server, because MAP Services 
components are required for Gateway.MAP.

UNINSTALLING MAP PLAYER, EXPLORER, AND QUICK REVIEW

When you uninstall MAP Explorer or Quick Review, MAP Player is also 
uninstalled. MAP Explorer and Quick Review both use MAP Player. 
Therefore, you should not remove either MAP Explorer or Quick Review 
individually, without removing the other client. If you are using either MAP 
Explorer or Quick Review on a computer and the other client is also installed but 
unneeded, leave it installed. 
To uninstall MAP Explorer, open Control Panel > Add/Remove Programs and 
select MAP Explorer.
To uninstall MAP Quick Review, open Control Panel > Add or Remove 
Programs and select MAP Quick Review.

UNINSTALLING GATEWAY.MAP
To uninstall Gateway.MAP, open Control Panel > Add or Remove Programs and 
select Gateway.MAP.
If you uninstalled MAP Services, you should uninstall Gateway.MAP before 
restarting the server, because Gateway.MAP requires MAP Services components.

UNINSTALLING MAP WEB SEARCH

To uninstall MAP Web Search, open Control Panel > Add or Remove Programs 
and select MAP Web Search.

UNINSTALLING HYPERLAUNCH RECEIVE SERVER

To uninstall HyperLaunch Receive Server, open Control Panel > Add or Remove 
Programs and select HyperLaunch Receive Server.
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Troubleshooting MAP
Use this appendix to identify the symptom you’re experiencing with MAP. 
Follow the suggestions in the Action section to identify and solve the potential 
problem. If you are not able to solve the problem using these suggestions, contact 
Telestream Technical Support for assistance (Support and Information on page 
About-1).

Topics Content.MAP Issues (page A-1)
Capture.MAP Issues (page A-2)
MAP Player Issues (page A-3)
General MAP Services Issues (page A-4)
MAP Explorer Issues (page A-5)
Web Browser Issues (page A-6)

CONTENT.MAP ISSUES

Symptom. When I try to save a media file from a media editing program, or save 
a business document from a personal productivity program (MS Word, for 
example), I can’t open the Media Application Platform entity in the Save or Save 
As dialog. What’s happening?
Action. Content.MAP only communicates with media applications on port 80. If 
the Content.MAP service was installed to use another port (port 8000, for 
example) in order to enable use of MAP with Web browsers via IIS, users must 
save their media in a Windows directory and then drag and drop (or copy and 
paste) the media in manually, via MAP Explorer.
Also, users must save their business documents in a Windows directory and then 
drag and drop (or copy and paste) the files in manually, via MAP Explorer.
Symptom. I have enabled Speech Recognition metadata (using the Metadata tab 
in a media folder’s property window). However, new media (or analyzed existing 
media) does not produce the text. Why not?
Action. The Speech Recognition Engine from Microsoft is not installed, or is not 
enabled on your server. See Enabling Speech Recognition on page 5-25.
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CAPTURE.MAP ISSUES

Symptom. Media I’ve captured is watermarked with “demo produced by 
Telestream, Inc.”.
Action. The Capture server that captured the media does not have a Telestream 
dongle. Obtain the license dongle from Telestream or plug it in to the server and 
restart the Capture.MAP service (or just restart the server) to continue. See 
Attaching MAP USB Dongles on page 3-23.

Action. The Telestream dongle. is plugged in and the red light is lit, but the 
license may have expired. Run the License Info program to determine if the 
license is expired. Contact Telestream to update the license. See Viewing 
Machine ID and License Information on page 3-23. With the new license file 
from Telestream, update the dongle (Updating the MAP Dongle on page 3-23) 
and restart the server.
Symptom. The Capture Service is not capturing media, even though the schedule 
appears to be set correctly.
Action. Make sure that the assigned stores have ample disk space available.
Verify that the Capture service is running.
Verify the service authentication settings.
Make sure you’ve defined the Capture.MAP storage depot and content location 
correctly. (see Add a Media Store on page 4-20).

Symptom. The capture bit rate is always 100 kbps.
Action. The default encoder is Windows Media at 100 kbps. Display Channel 
properties Capture tab. Click Modify > Codecs and modify the Windows Media 
V9 CBR codec to reflect the desired capture bit rate.

Symptom. The channel I’ve configured for a capture card won’t start.
Action. Make sure you have specified a storage location. Use the MAP 
management console to perform this task (see Add a Media Store on page 4-20).
You may not have a valid schedule. Review the schedule and make sure it 
includes the present time, or the time you plan it to start and stop.
The channel may be set to Disabled. Open the channel properties dialog and 
check the Startup type setting in the General tab.
If Broadcast is set to True, you must have a network connection to view the live 
capture.

Symptom. I can’t see any video in the Channel Details frame of the MAP 
management console.
Action. Broadcast is set to False in Channel Properties. Open the properties 
window for the channel in question, and click the Settings tab. Change the 
Broadcast: Enabled tag to True.
Click the Play button in the control frame below the video frame.
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A video source may not be present, or it may not be selected. Verify that media is 
present on the physical connection to the capture card.
Verify proper operation of the capture card using Windows Media Encoder.
If Broadcast is set to True, you must have a network connection to view the live 
capture.

Symptom. I can’t see metadata on a segment I’ve just captured.
Action. Verify that the media folder where the segment is stored includes 
metadata in the folder properties. Label metadata is passed through and saved in 
the media binder immediately when the segment starts, so that you can actually 
search on it while encoding takes place. Track metadata is automatically 
extracted and also saved in the binder. Track metadata is available at the 
conclusion of the encoding of the segment.
The input video may not have VITC for close caption extraction.

Symptom. I can’t hear audio when I am capturing a segment.
Action. Verify that input audio is present and being produced by playing the 
same media input source through Windows Media Encoder. 
Use a different media source to verify that the speakers are working properly.
Check the input source against a monitor, without running it through the capture 
card.
Make sure your PC has a sound card and playback audio device and it is 
operating correctly.

MAP PLAYER ISSUES

Symptom. I can’t launch MAP Player.
Action. In MAP Explorer, highlight a binder in a media folder. Then, right-click 
to select MAP Player.

Symptom. MAP Player doesn’t display any video frames when I click the Play 
icon in the video controller.
Symptom. MAP Player doesn’t play in reverse or I can’t single-step backwards 
in the media.
Action. See the release notes document on the installation CD.
Turn off hardware acceleration on the video card and retry.
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With a media file open, right-click in the video panel and select Options. On the 
Performance tab, click Advanced. Deselect Use video mixing renderer under 
Video Acceleration, and try again. 

Symptom. I can’t trim media in MAP Player.
Action. Only WM9 file formats support mark in / mark out, and Save as to 
another file features.
Verify the playback format.

Symptom. I can’t hear audio when playing media in MAP Player.
Action. Verify that input audio is present and being produced by playing the 
same media input source through Windows Media Encoder. 
Use a different media source to verify that your speakers are working properly.
Make sure your PC has a sound card and playback audio device and it is 
operating correctly.

GENERAL MAP SERVICES ISSUES

Symptom. I’m trying to manage a MAP service in MAP management console, 
but when I open the service, the components display the Unavailable message.
Action. The service you’re attempting to monitor or update is not running. The 
service has been stopped. Restart the service (open Control Panel > 
Administrative Tools > Services) and check the settings in the services properties 
(see Modifying MAP Services Settings on page 47). Normally, services are set to 
start automatically when the server restarts.
The server where the service is located is not accessible (there may be a network 
problem). See your network administrator.
Restart the service that is unavailable, then close and re-open MAP management 
console.

Symptom. MAP Services show as “Unavailable” in the Management Console.
Action. Stop and restart the service.
Reboot the server.
Double check your service authentication settings and make sure you’re logged 
in correctly.

Note
Disabling Use video mixing renderer may prevent you from using the 
single frame back feature and playing media in reverse. However, 
disabling the video mixing renderer may also cause video display to fail 
entirely, in which case you should enable the video mixing renderer. Right-
click in the media panel and select Options to display the Options dialog. 
Display the Performance tab and click Advanced. In the Video Accelerator 
Settings window, under the video acceleration section check Use video 
mixing renderer, and Use overlays directly below. Click OK.
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Symptom. MAP Services are not accessible.
Action. Install MAP Services and indicate they can be used by “Everyone” as 
recommended. 
If you have installed MAP Services and specified the Just Me option, make sure 
you’re logged in with the same user ID that was logged in when installation was 
performed.

Symptom. MAP Management Console won’t launch.
Action. Check the operating system—you may have installed a service on a 
Windows 2000 platform. Telestream recommends you run MAP services on 
Windows XP Professional or Windows Server 2003, and does not support other 
operating systems.

MAP EXPLORER ISSUES

Symptom. I am searching the MAP media folders and I can’t find anything.
Action. Broaden your search by moving higher up in the media folder 
organization.
Make sure you are connected to the top level media folder that contains the 
media you’re searching for in its folder, or a folder inside the top level folder.
If you are searching close caption metadata, don’t select Is Exactly in the search 
criteria.
Browse the media folder in MAP Explorer to make sure the media you’re 
searching for exists in the location you’re searching.

Symptom. I captured a media segment, but I can’t find it.
Action. Run Windows Explorer. Open Media Application Platform under My 
Network Places and run the Add Content.MAP Network Place Wizard. Browse 
to the folder where Capture.MAP stored the segment and connect to it.

Symptom. I can’t see the media in my media folders.
Action. You may be viewing the media folders using the MAP management 
console, which does not display media. To view media, use MAP Explorer or 
other MAP client application.

Symptom. The capture device is not working in Capture.MAP.
Action. Before assigning a capture device to a channel in Capture.MAP, verify 
that the device works in Windows Media Encoder using the proper software from 
the manufacturer. If it does not work, you must solve the problem outside of 
MAP.

Symptom. I am conducting a search in MAP Explorer. I click Search, but the 
Search Results window doesn’t display.
Action. You probably conducted a previous search, and if you have several 
windows open on your desktop, the Search window is open, but obscured by 
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other windows. Look for the window yourself, or click on the Windows Explorer 
tab in the toolbar and select Search Results to bring it to the front.

Symptom. I am conducting a fragment search in MAP Explorer. I’m sure the file 
with this criteria exists, but it doesn’t get listed in results.
Action. If the term or fragment you’re searching for is not at the beginning, use 
an asterisk as the leading search character. For example, *ech finds all files that 
have the string ‘ech’ in it.

WEB BROWSER ISSUES

Symptom. I am using a Web browser to search for media. The resulting media is 
represented by the universal No Access icon and I can’t play it.
Action. Your MAP administrator has not supplied an alias to the media you 
found, or the credential supplied do not provide proper authentication. In the 
Content.MAP management console or MAP Explorer, select the media folder 
that you want to provide Web access to (or the single top-level folder, called 
Media Folders, to provide Web access to all media) and display Properties. 
In the Storage tab, select each storage depot where the media is located and click 
Properties to add an alias for the IIS Web server (see Creating Aliases for Web 
Access on page 6-8). The alias is a URL, in the form http://domain | IP 
address:PortNo if not 80/IISVirtualDirectoryName; for example: http://
mapserver4:8000/content1.

Symptom. I am using a Web browser to access my MAP system. When I try to 
log on to my MAP site (http://MAPServerMachineName:8000/WebClient) 
(where MAPreview server is the actual name, 8000 is the actual port IIS is set to, 
and WebClient is the actual name of the virtual MAP directory, I get about 3 rows 
of text information—no Web page is displayed.
Action. Your ASP.NET is not properly registered with IIS, because .NET was 
installed before IIS was activated. To solve the problem, re-register ASP.NET 
with IIS by following the steps outlined in Re-installing ASP.NET for IIS, on 
page 44.

Symptom. I am attempting to use Content.MAP management console (Media 
folder Properties > Storage) to provide an alias to my MAP content so that it can 
be played via a Web browser. However, when I click Browse to find the Alias 
location, no folder displays.
Action. The folder you need to supply is a Virtual Folder in IIS. However, IIS 
does not report virtual folders. You can identify the Web server and port, then 
manually enter the folder (/content/, for example—be sure to supply leading and 
trailing slash marks. Click the green GO button or press Enter, and IIS will 
display the actual directory to indicate your path is correct. The form for alias 
location is 
http://<IISServerName>:<PortNumber>/<VirtualFolderName>. For example, 
http://grok:8000/content.
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Media Formats
This appendix provides movie, video, and audio codec specifications provided in 
each media format. The media formats are organized alphabetically within each 
technology group. 
MAP provides codes that allow you to transcode media into the following media 
formats: 

Miscellaneous 
Formats

Copy—Duplicate Original Format (page B-2)

Streaming Media 
Formats

QuickTime Media Format (page B-2)
Real Networks Media Format (page B-8)
Windows Media Format (page B-11)

Professional Video 
Media Formats

AVI Media Format (page B-14)
MPEG1 System Stream Media Format (page B-17)
MPEG2 Program Stream Media Format (page B-18)

Note
When Generate Timecode Track is available and enabled, the time code 
may be supplied via a time code metadata label).
For example, if the Vertical Blanking Process/Analyze filter is enabled, the 
time code is extracted from the video file and placed in the time code 
metadata label. The time code metadata is then used to populate the time 
code track.
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COPY—DUPLICATE ORIGINAL FORMAT

This media format entry duplicates the original file in its original media format, 
copying it to the location specified. Copy is used to preserve the original file for 
further processing, often after metadata has been generated on a previous 
transcode and for archiving purposes.
There are no parameters for the Copy format.

QUICKTIME MEDIA FORMAT

MAP uses the Basic Sorenson codec by default. If the Sorenson codec is to be 
used for professional work, Telestream recommends that you replace this codec 
with the Sorenson Professional codec. The Professional codec may be obtained 
directly from Sorenson at www.sorenson.com. 

Movie Codecs

Note
Some optional codecs are only available when installed on the 
Factory.MAPreview server by you, the customer, including FMA, 
FlexVideo and QDesigns Pro Audio.

Table B–1. DV Standard Definition NTSC

Value Specification

Frame Size Width: 720 pixels
Height: 480 pixels

Video Frame Rate (fps) 29.97

Audio Channel 2 Channel 16 bit Stereo at 44.1Khz

Audio Sample Rate 44.1 | 48 KHz

Audio Sample Size 16 bits

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).
B-2 May 2008



74-0053-01 Media Formats
Video Codecs

Table B–2. DV Standard Definition PAL Codec

Value Specification

Frame Size Width: 720 pixels
Height: 576 pixels

Video Frame Rate (fps) 25

Audio Channel 2 (stereo)

Audio Sample Rate 44.1 | 48 KHz

Audio Sample Size 16 bits

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–3. Avid (ABVB, NuVista, Meridien Interlaced/Progressive) Codec

Value Specification

Codec Profile AVR1 through AVR 5; AVR1e through AVR6e; 
AVR25, AVR26, AVR27

Video Profile NTSC | PAL

Frame Size NTSC: 720 X 480 pixels
PAL: 720 X 576 pixels

Frame Rate (fps) NTSC: 29.97 fps
PAL: 25 fps

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–4. Cinewave 8Bit YUV Codec

Value Specification

Video Profile NTSC | PAL

Frame Size NTSC: 720 X 480 pixels
PAL: 720 X 576 pixels
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Frame Rate NTSC: 29.97 fps
PAL: 25 fps

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–4. Cinewave 8Bit YUV Codec

Value Specification

Table B–5. FlexVideo Codec (installed by customer)

Value Specification

Frame Size Width: 32 to 2,048 pixels
Height: 32 to 2,048 pixels

Quality 1 to 100 percent

Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–6. FMA Movie Codec (installed by customer)

Value Specification

Frame Size Width: 32 to 2,048 pixels
Height: 32 to 2,048 pixels

Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 100 percent

Storage Profile Standard | QualityFirst | FramerateFirst | TextBrowse | SmallView | Original

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).
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* QuickTime Motion JPEG B format is used when delivering to a Media 
100 non-linear editor.

Table B–7. Motion JPEG B Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 576 pixels

Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 100 percent

Number of Fields 1 | 2

Field Dominance Check to set field dominance to even

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–8. QuickTime Movie Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 576 pixels

Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 100 percent

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–9. Photo-JPEG Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 576 pixels

Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 100 percent
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Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–9. Photo-JPEG Codec

Value Specification

Table B–10.Radius Cinepak Codec

Value Specification

Video Bit Rate (bps) 10240 to 1,024,000

Frame Size Width: 80 to 640 pixels
Height: 60 to 480 pixels

Video Frame Rate 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Keyframe Spacing 1 to 300 frames

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–11.Sorenson Video 2 (Basic and Pro) Codec

Value Specification

Video Bit Rate (bps) 10,240 to 3,456,000

Frame Size Width: 80 to 720 pixels
Height: 60 to 576 pixels

Video Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Keyframe Spacing 1 to 300 frames

Fast Start Check to enable FastStart switch for progressive download

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).
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Audio Codecs

Table B–12.Sorenson Video 3 (Basic and Pro) Codec

Value Specification

Video Bit Rate (bps) 16,384 to 3,457,024 (in 4,096 (4K) increments)

Frame Size Width: 80 to 720 pixels
Height: 60 to 576 pixels

Video Frame Rate (fps) 5 to 30 fps, selectable: 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Keyframe Spacing 1 to 300 frames

Bi-directional Frames Check to enable difference frames, based on previous and next frame.

Quick Compress Check to cause the codec to speed compression by about 20%, sacrificing 
little quality. Otherwise, the codec compresses in real time, at the rate of 
1.2/1 (1.2 seconds of compress time per 1 second of video).

Automatic Keyframes Check to detect the difference between frames (Automatic Key Frames). 
When the difference reaches the specified frequency threshold (1 to 100), 
a new keyframe is inserted.

Single Pass VBR Check to enable VBR encoding in a single pass

Media Key Check to use a media key. Media Keys are a QuickTime feature that allows 
you to lock movies—viewers must enter the media key (password) in their 
QuickTime Settings control frame before the protected video is displayed

Video Depth Millions of Colors (24 bit) | Millions of Colors+ (32 bit)

Fast Start Check to allow the QuickTime Plug-in to play media as it downloads in the 
viewer’s browser. 

Generate Timecode Track Check to populate with a time code value (may be supplied via time code 
metadata label).

Table B–13.Raw PCM Audio Codec

Value Specification

Audio Channels 1 (Mono) | 2 (Stereo)

Audio Sample Rate (Hz) 8000 | 11025 | 16000 | 22050 | 24000 | 32000 | 44100 | 48000

Audio Sample Size 8 bit | 16bit
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REAL NETWORKS MEDIA FORMAT

Movie Codecs

Table B–14.QDesign Music 2 Audio (Basic and Pro) Codec

Value Specification

Audio Bit Rate (bps) Basic: 8000 to 48000 bps, selectable:
8000 | 10000 | 12000 | 16000 | 20000 | 24000 | 32000 | 40000 | 48000
Pro: 8000 to 128000 bps, selectable:
8000 | 10000 | 12000 | 16000 | 20000 | 24000 | 32000 | 40000 | 48000 | 
56000 | 64000 | 80000 | 96000 | 112000 | 128000

Audio Channels 1 (Mono) | 2 (Stereo)

Audio Sample Rate (Hz) 8000 | 11025 | 16000 | 22050 | 24000 | 32000 | 44100 | 48000

Audio Sample Size 8 bit | 16bit

Table B–15.Single Bit Rate (HTTP or download) Codec

Value Specification

Frame Size Width: 80 to 640 pixels
Height: 60 to 480 pixels

Video Codecs 
   RealVideo (V5)
   RealVideo G2 (V6)
   RealVideo G2 w/SVT (V7)
   RealVideo 8.0
   RealVideo 9.0

Video Bit Rate: 1,000 to 5,000,000 bps
Maximum Frame Rate: 1 to 30 fps
Keyframe Spacing: 1,000 to 30,000
VBR Encoding: Check to enable VBR encoding. When enabled, select 
latency from 1,000 msec to 30,000 msec.
Loss Protection: Check to make media more resilient to lossy 
environments.

Audio Codec RealAudio | RealAudio V8 | Sony ATRAC3 (see below)

Video Quality Normal. Recommended for mixed content clips to balance video motion 
and image clarity.
Sharp image. Recommended for high action clips to enhance overall 
image clarity.
Slideshow. With this option, video appears as a series of still photos and 
provides best overall image clarity.
Smooth motion. Recommended for clips that contain limited action 
(newscasts or interviews) to enhance video motion.
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Audio Content Stereo music
Voice only
Voice with background music
Music

Mobile Play Check to allow media to be downloaded by mobile players.

RealPlayer Record Check RealPlayer Record to allow users to record the playback of your 
RealMedia clip onto their computer. When this clip is played, the user may 
click the Record button to save the clip. Deselect to disable the Record 
button.

Audio Codec:
   RealAudio
   RealAudio V8
   Sony ATRAC3

RealAudio:
Voice: 
5 Kbps, 8 kHz | 6.5 Kbps, 8 kHz | 8.5 Kbps, 8 kHz | 16 Kbps, 16 kHz | 32 
Kbps, 22 kHz | 64 Kbps, 44 kHz 
Mono: 
6 Kbps, 8 kHz | 8 Kbps, 8 kHz | 1 Kbps, 11 kHz | 16 Kbps 16 kHz | 
20 Kbps, 22 kHz | 20 Kbps, 44 kHz (High Response) | 
32 Kbps, 44 kHz | 32 Kbps, 44 kHz (High Response) | 
44 Kbps, 44 kHz | 64 Kbps, 44 kHz 
Stereo: 
20 Kbps, 11 kHz | 32 Kbps, 22 kHz | 44 Kbps, 22 kHz | 
64 Kbps, 44 kHz | 96 Kbps, 44 kHz
RealAudio V8 Stereo:
12 Kbps | 16 Kbps | 20 Kbps | 20 Kbps (High Response) | 32 Kbps | 
32 Kbps (High Response) | 44 Kbps | 44 Kbps (High Response)

Table B–15.Single Bit Rate (HTTP or download) Codec

Value Specification

Table B–16.SureStream (Real Server) Codec

Value Specification

Frame Size Width: 80 to 640 pixels
Height: 60 to 480 pixels

Standard Profiles
(Click arrow to display details 
and edit)

28K Modems | 56K Modems | 
Single ISDN |Dual ISDN |
DSL/Cable Modem | Corporate LAN |
DSL/Cable Modem 1 | DSL/Cable Modem 2 |
DSL/Cable Modem 3
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Video Codecs 
   RealVideo G2 (V6)
   RealVideo G2 with SVT (V7)
   RealVideo 8.0
   RealVideo 9.0

Video Bit Rate: 1,000 to 5,000,000 bps
Maximum Frame Rate: 1 to 30 fps
Keyframe Spacing: 1,000 to 30,000
VBR Encoding: Check to enable VBR encoding. When enabled, select 
latency from 1,000 msec to 30,000 msec.
Loss Protection: Check to make this video more resilient to lossy 
environments.

Audio Codec:
   RealAudio
   RealAudio V8
   Sony ATRAC3

RealAudio:
Voice:
5 Kbps, 8 kHz | 6.5 Kbps, 8 kHz | 8.5 Kbps, 8 kHz | 16 Kbps, 16 kHz |
32 Kbps, 22 kHz | 64 Kbps, 44 kHz 
Mono:
6 Kbps, 8 kHz | 8 Kbps, 8 kHz | 11 Kbps, 11 kHz | 16 Kbps16 kHz |
20 Kbps, 22 kHz | 20 Kbps, 44 kHz (High Response) | 
32 Kbps, 44 kHz | 32 Kbps, 44 kHz (High Response | 
44 Kbps, 44 kHz | 64 Kbps, 44 kHz |
Stereo:
20 Kbps, 11 kHz | 32 Kbps, 22 kHz | 44 Kbps, 22 kHz | 
64 Kbps, 44 kHz | 96 Kbps, 44 kHz
RealAudio V8 Stereo:
12 Kbps | 16 Kbps | 20 Kbps | 20 Kbps (High Response) | 
32 Kbps | 32 Kbps (High Response) | 44 Kbps | 
44 Kbps (High Response)

Video Quality Normal. Recommended for mixed content clips to balance video motion 
and image clarity.
Sharp image. Recommended for high action clips to enhance overall 
image clarity.
Slideshow. With this option, video appears as a series of still photos and 
provides best overall image clarity.
Smooth motion. Recommended for clips that contain limited action 
(newscasts or interviews) to enhance video motion.

Audio Content Stereo music
Voice only
Voice with background music
Music

Table B–16.SureStream (Real Server) Codec

Value Specification
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WINDOWS MEDIA FORMAT

Movie Codecs

Audio Codec Voice:
5 Kbps, 8 kHz | 6.5 Kbps, 8 kHz | 
8.5 Kbps, 8 kHz | 16 Kbps, 16 kHz | 
32 Kbps, 22 kHz | 64 Kbps, 44 kHz | 
Mono:
6 Kbps, 8 kHz | 8 Kbps, 8 kHz | 11 Kbps, 11 kHz | 16 Kbps16 kHz | 
20 Kbps, 22 kHz | 20 Kbps, 44 kHz 9High Response | 
32 Kbps, 44 kHz | 32 Kbps, 44 kHz (High Response) | 
44 Kbps, 44 kHz | 64 Kbps, 44 kHz | 
Stereo:
20 Kbps, 11 kHz | 32 Kbps, 22 kHz | 44 Kbps, 22 kHz | 
64 Kbps, 44 kHz | 96 Kbps, 44 kHz

Mobile Play Check to allow media to be downloaded by mobile players

RealPlayer Record Check RealPlayer Record to allow users to record the playback of your 
RealMedia clip onto their computer. When this clip is played, the user may 
click the Record button to save the clip. Deselect to disable the Record 
button.

Table B–16.SureStream (Real Server) Codec

Value Specification

Table B–17.Single Rate (HTTP or Download) Codec

Value Specification

Frame size Width: 16 to 720 pixels
Height: 16 to 608 pixels

Video Codecs:
Windows Media Video V9
Windows Media Video V8
Windows Media Video V7
Microsoft MPEG-4 V3
ISO MPEG-4 V1

Video Bit Rate: 1,000 to 5,000,000 bps
Maximum Frame Rate: 1 to 30 fps
Keyframe Spacing: 1 to 300 frames
Video Quality: 0 (smoother motion) to 100 (sharper image)

Audio Codecs:

ACELP Mono:
5 Kbps, 8 KHz | 6.5 Kbps, 8 KHz | 8.5 Kbps, 8 KHz | 16 Kbps, 16 KHz
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Windows Media
Audio V9, V8, V7

Mono:
5 Kbps, 8 KHz | 6 Kbps, 8 KHz | 8 Kbps, 8 KHz | 8 Kbps, 11 KHz | 
10 Kbps, 11 KHz | 10 Kbps, 16 KHz | 12 Kbps, 16 KHz | 
16 Kbps, 16 KHz | 16 Kbps, 22 KHz | 20 Kbps, 22 KHz | 
20 Kbps, 32 KHz | 32 Kbps, 44 KHz | 
Stereo:
12 Kbps, 8 KHz | 16 Kbps, 16 KHz | 20 Kbps, 16 KHz | 
20 Kbps, 22 KHz | 22 Kbps, 22 KHz | 32 Kbps, 22 KHz | 
32 Kbps, 32 KHz | 40 Kbps, 32 KHz | 48 Kbps, 32 KHz | 
64 Kbps, 44 KHz | 80 Kbps, 44 KHz | 96 Kbps, 44 KHz | 
128 Kbps, 44 KHz | 160 Kbps, 44 KHz | 192 Kbps, 44 KHz | 
128 Kbps, 48 KHz | 160 Kbps, 48 KHz

Windows Media Audio
V9 Professional

Stereo:
128 Kbps, 44 KHz | 192 Kbps, 44 KHz | 256 Kbps, 44 kHz | 
384 Kbps, 44 kHz | 440 Kbps, 44 kHz | 128 Kbps, 48 KHz | 
160 Kbps, 48 KHz | 256 Kbps, 48 kHz | 384 Kbps, 48 kHz | 
440 Kbps, 48 kHz

Table B–17.Single Rate (HTTP or Download) Codec

Value Specification

Table B–18.Multiple Rate (Windows Media Server) Codec

Value Specification

Frame size Width: 16 to 720 pixels
Height: 16 to 608 pixels

Video Streams 1 through 5

Video Codecs:
Windows Media Video V9
Windows Media Video V8
Windows Media Video V7
Microsoft MPEG-4 V3
ISO MPEG-4 V1

Video Bit Rate: 1,000 to 5,000,000 bps
Maximum Frame Rate: 1 to 30 fps
Keyframe Spacing: 1 to 300 frames
Video Quality: 0 (smoother motion) to 100 (sharper image)

Audio Codecs

ACELP Mono:
5 Kbps, 8 KHz | 6.5 Kbps, 8 KHz | 8.5 Kbps, 8 KHz | 
16 Kbps, 16 KHz
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Windows Media
Audio V9, V8, V7

Mono:
5 Kbps, 8 KHz | 6 Kbps, 8 KHz | 8 Kbps, 8 KHz | 8 Kbps, 11 KHz | 
10 Kbps, 11 KHz | 10 Kbps, 16 KHz | 12 Kbps, 16 KHz | 
16 Kbps, 16 KHz | 16 Kbps, 22 KHz | 20 Kbps, 22 KHz | 
20 Kbps, 32 KHz | 32 Kbps, 44 KHz | 
Stereo:
12 Kbps, 8 KHz | 16 Kbps, 16 KHz | 20 Kbps, 16 KHz | 
20 Kbps, 22 KHz | 22 Kbps, 22 KHz | 32 Kbps, 22 KHz | 
32 Kbps, 32 KHz | 40 Kbps, 32 KHz | 48 Kbps, 32 KHz | 
64 Kbps, 44 KHz | 80 Kbps, 44 KHz | 96 Kbps, 44 KHz | 
128 Kbps, 44 KHz | 160 Kbps, 44 KHz | 192 Kbps, 44 KHz | 
128 Kbps, 48 KHz | 160 Kbps, 48 KHz

Windows Media Audio
V9 Professional

Stereo:
128 Kbps, 44 KHz | 192 Kbps, 44 KHz | 256 Kbps, 44 kHz | 
384 Kbps, 44 kHz | 440 Kbps, 44 kHz | 128 Kbps, 48 KHz | 
160 Kbps, 48 KHz | 256 Kbps, 48 kHz | 384 Kbps, 48 kHz | 
440 Kbps, 48 kHz

Table B–18.Multiple Rate (Windows Media Server) Codec

Value Specification

Table B–19.Single Rate Quality VBR Codec

Value Specification

Frame size Width: 16 to 720 pixels
Height: 16 to 608 pixels

Video Streams 1 through 5

Video Codecs:
Windows Media Video V9
Windows Media Video V8
Windows Media Video V7

Video Bit Rate: 4,000 to 20,000,000 bps
Maximum Frame Rate: 1 to 72 fps
Keyframe Spacing: 1 to 300 frames
Video Quality: 0 (smoother motion) to 100 (sharper image)

Audio Codecs
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AVI MEDIA FORMAT

Video Codecs DivX Pro Codec (Version 5.x): This is a user-installable MPEG4 codec. When 
installed and selected (specifications and download from www.divx.com), it 
allows you to check supported bit rates.

Windows Media
Audio V9, V8, V7

Mono:
5 Kbps, 8 KHz | 6 Kbps, 8 KHz | 8 Kbps, 8 KHz | 8 Kbps, 11 KHz Mono | 10 
Kbps, 11 KHz | 10 Kbps, 16 KHz | 12 Kbps, 16 KHz | 
16 Kbps, 16 KHz | 16 Kbps, 22 KHz | 20 Kbps, 22 KHz | 
20 Kbps, 32 KHz | 32 Kbps, 44 KHz | 
Stereo:
12 Kbps, 8 KHz | 16 Kbps, 16 KHz | 20 Kbps, 16 KHz | 
20 Kbps, 22 KHz | 22 Kbps, 22 KHz | 32 Kbps, 22 KHz | 
32 Kbps, 32 KHz | 40 Kbps, 32 KHz | 48 Kbps, 32 KHz | 
64 Kbps, 44 KHz | 80 Kbps, 44 KHz | 96 Kbps, 44 KHz | 
128 Kbps, 44 KHz | 160 Kbps, 44 KHz | 192 Kbps, 44 KHz | 
128 Kbps, 48 KHz | 160 Kbps, 48 KHz

Windows Media Audio
V9 Professional

Stereo:
128 Kbps, 44 KHz | 192 Kbps, 44 KHz | 256 Kbps, 44 kHz | 
384 Kbps, 44 kHz | 440 Kbps, 44 kHz | 128 Kbps, 48 KHz | 
160 Kbps, 48 KHz | 256 Kbps, 48 kHz | 384 Kbps, 48 kHz | 
440 Kbps, 48 kHz

Table B–19.Single Rate Quality VBR Codec

Value Specification

Table B–20.DivX Pro Codec

Value Specification

Frame Size Width: Max. 1920 pixels
Height: Max. 1088 pixels

Table B–21.Uncompressed AVI Video Stream Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 480 pixels

Video Frame Rate (fps) 1 to 30 selectable: 1 | 3 | 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30
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Table B–22.Microsoft Video 1 Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 480 pixels

Video Frame Rate (fps) 1 to 30 selectable: 1 | 3 | 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 10,000

Table B–23.Cinepak by Radius Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 480 pixels

Video Frame Rate (fps) 1 to 30 selectable: 1 | 3 | 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 10,000

Table B–24.Intel Indeo Video 4.5 Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 480 pixels

Video Frame Rate (fps) 1 to 30 selectable: 1 | 3 | 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 10,000

Table B–25.Indeo Video 5.10 Codec

Value Specification

Frame Size Width: 80 to 720 pixels
Height: 60 to 480 pixels

Video Frame Rate (fps) 1 to 30 selectable: 1 | 3 | 5 | 8 | 10 | 12 | 15 | 24 | 25 | 29.97 | 30

Quality 1 to 10,000
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Audio Codecs
Table B–26.Uncompressed AVI Audio Stream Codec

Value Specification

Audio Channels 1 (mono) | 2 (stereo)

Audio Sample Rate (Hz) 8,000 | 11,025 | 16,000 | 22,050 | 32,000 | 44,100 | 48,000

Table B–27.Microsoft IMA ADPCM Codec

Value Specification

Sample Rate 44.1 kHz, 4 bit stereo

Table B–28.Microsoft ADPCM Codec

Value Specification

Sample Rate 44.1 kHz, 4 bit stereo

Table B–29.Microsoft CCITT G.711 A-law and u-law Codec

Value Specification

Sample Rate 44.1 kHz, 8 bit, Stereo

Table B–30.Voxware Audio Codec

Value Specification

Audio Profile
(check to enable)

Mono:
AC06V2, 6.0 kbps, 8 kHz | AC08V1, 8.0 kbps, 8 kHz |
AC10V1, 10.0 kbps, 11 kHz | AC16V1, 16.0 kbps, 16 kHz |
AC24V1, 24.0 kbps, 22 kHz, Non-File Only | 
AC24V1, 24.0 kbps, 22 kHz | AC32V2, 32.0 kbps, 44 kHz |
AC40V2, 40.1 kbps, 44 kHz | AC48V2, 48.1 kbps, 44 kHz
Stereo:
ACS12V2, 12.0 kbps, 8 kHz | ACS16V2, 16.0 kbps, 8 kHz |
ACS20V2, 20.0 kbps, 11 kHz | ACS32V2, 32.0 kbps, 16 kHz |
ACS48V2, 48.1 kbps, 22 kHz | ACS64V2, 64.1.0 kbps, 44 kHz |
ACS80V2, 80.3 kbps, 44 kHz | ACS96V2, 96.1 kbps, 44 kHz
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MPEG1 SYSTEM STREAM MEDIA FORMAT

If time code information has been inserted in a metadata label and decoded from 
the input file, the time code is inserted in the first GOP header so the time code is 
passed through from the input into the output file.

Video Codecs

Table B–31.Fraunhofer IIS MPEG Layer-3 (advanced) Codec

Value Specification

Audio Profile
(check to enable)

Mono:
24 kBit, 22,050 Hz | 20 kBit, 11,025 Hz | 18 kBit, 11,025 Hz | 
16 kBit, 11,025 Hz | 8 kBit, 11,025 Hz
Stereo:
56 kBit, 22,050 Hz | 48 kBit, 22,050 Hz | 40 kBit, 22,050 Hz | 
32 kBit, 11,025 Hz | 24 kBit, 11,025 Hz | 20 kBit, 11,025 Hz | 
18 kBit, 11,025 Hz | 32 kBit, 22,050 Hz 

Table B–32.MPEG1 Constrained Parameters (CPB) Codec

Value Specification

Video Bit Rate 192 Kbps to 6 Mbps

File Extension mpg | mpe | mp1 Default: mpg.

GOP Structure Select from available GOP structure frames

Video Profiles: NTSC (352 x 240 x 29.97 fps)
NTSC (320 x 240 x 29.97 fps)
NTSC (176 x 120 x 29.97 fps)
NTSC 16:9 (320 x 176 x 29.97 fps)
PAL (352 x 288 x 25 fps)
PAL (384 x 288 x 25 fps)
PAL (176 x 144 x 25 fps)
PAL 16:9 (320 x 176 x 25 fps)

Enable GOP Timecode Check to enable. If time code information has been inserted in a metadata 
label and decoded from the input file, the time code is inserted in the GOP 
header of the output file.

Motion Estimation Factor Select 1 to 100:
1—Lowest Quality/Faster Encode
100—Highest Quality/Slower Encode
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Audio Codec

MPEG2 PROGRAM STREAM MEDIA FORMAT

If time code information has been inserted in a metadata label and decoded from 
the input file, the time code is inserted in the first GOP header so the time code is 
passed through from the input into the output file.

Table B–33.MPEG1 Variable Bit rate (VBR) Codec

Value Specification

Video Bit Rate 192 Kbps to 5.9996 Mbps

GOP Structure Select from available GOP structure frames

File Extension mpg | mpe | mp1

Video Profiles: NTSC(352 x 240 x 29.97 fps)
NTSC(320 x 240 x 29.97 fps) 
NTSC(176 x 120 x 29.97 fps) 
NTSC 16:9(320 x 176 x 29.97 fps)
PAL (352 x 288 x 25 fps) 
PAL (384 x 288 x 25 fps)
PAL (176 x 144 x 25 fps) 
PAL 16:9 (320 x 176 x 25 fps)

Enable GOP Timecode Check to enable. If time code information has been inserted in a metadata 
label and decoded from the input file, the time code is inserted in the GOP 
header of the output file.

Motion Estimation Factor 1 to 100:
1—Low Quality/Faster Encode
100—High Quality/Slower Encode

Table B–34.MPEG1 Layer 2 Codec

Value Specification

Audio Sample Rate (kbps) 44.1 | 48

Audio Profiles
(Audio Bit Rate & Audio 
Channels)

Mono (Kbps): 32 | 48 | 56 | 64 | 80 | 96 | 112 | 128 | 160 | 192
Stereo (Kbps): 64 | 96 | 112 | 128 | 160 | 192 | 224 | 256 | 320 | 384
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Video Codecs

Audio Codec

Table B–35.MPEG2 4:2:0 ML@MP Constant Bit Rate (CBR) Codec

Value Specification

Video Bit Rate 400 Kbps to 15 Mbps

File Extension Default: mpg

GOP Structure Select from available GOP structure frames

Video Profiles: NTSC (352 x 480 x 29.97 fps)
NTSC (544 x 480 x 29.97 fps)
NTSC (704 x 480 x 29.97 fps)
NTSC (720 x 480 x 29.97 fps)
PAL (352 x 576 x 25 fps)
PAL (544 x 576 x 25 fps)
PAL (704 x 576 x 25 fps)
PAL (720 x 576 x 25 fps)

Motion Estimation Factor Select 1 to 100 (default: 80):
1—Lowest Quality/Faster Encode
100—Highest Quality/Slower Encode

Table B–36.MPEG1 Layer 2 Codec

Value Specification

Audio Sample Rate (kbps) 44.1 | 48

Channels 2 (stereo)

Audio Profiles Mono (Kbps): 32 | 48 | 56 | 64 | 80 | 96 | 112 | 128 | 160 | 192 | 
Stereo (Kbps): 64 | 96 | 112 | 128 | 160 | 192 | 224 | 256 | 320 | 384 
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Destinations
MAP uses destinations to deliver new versions of media it has created as a result 
of a master media file being saved in a media folder where versions are specified. 

Destinations FTP Server (page C-2)
HyperLaunch Receive Server (page C-3)
HyperLaunch Receive Server (Secure) (page C-3)
Local Drive or Network Share (page C-4)
Network File Share (Specific User Name) (page C-4) 

Note
Use the Network Location Wizard to easily create the fully-qualified path to 
a destination. See Using the Network Location Wizard on page 5-33.
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FTP SERVER

Specify the FTP Server destination to send media files via FTP to the server you 
identify.

TCP/IP Port. The port number used to connect to the server. Default 21.
After you connect, you can browse to and select the default path to the 
destination folder. 

Table C–1. FTP Server Destination Parameters 

Parameter Description

Server Identity The DNS or IP address of the FTP server

User Name A valid user name permitted connection to the server

Password The password required to connect to the server

Anonymous Login Check to enable anonymous login, if permitted on this server

Passive Mode Check to enable for firewall compatibility.
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HYPERLAUNCH RECEIVE SERVER

Specify the HyperLaunch Receive Server destination to send media files via 
HyperLaunch to the server you identify.

HYPERLAUNCH RECEIVE SERVER (SECURE)
Specify the secure HyperLaunch Receive Server destination to send media files 
via Secure HyperLaunch to the server you identify.

Table C–2. HyperLaunch Server Destination Parameters

Parameter Description

Server Identity DNS name or IP address

Browse When checked, sets server identity to localhost.

UDP Port Default: 69, settable by server administrator

User Name A valid user name permitted connection to the server

Password The password required to connect to the server

Table C–3. Secure HyperLaunch Server Destination Parameters

Parameter Description

Server Identity DNS name or IP address

Browse When checked, sets server identity to localhost.

UDP Port Default: 69, settable by user

User Name A valid user name permitted connection to the server

Password The password required to connect to the server

Public Security Key Paste in the public security key for this server, provided to you by the 
server administrator.

User Name User name that provides proper authentication for access to this server

Password Associated password to authenticate the user name
May 2008



Destinations 74-0053-01
LOCAL DRIVE OR NETWORK SHARE

The Local Folder or Network Share destination delivers the media to a folder on 
the local MAPreview server or a network share accessible by MAP services with 
user name and password.

Browse to the desired destination folder. 

NETWORK FILE SHARE (SPECIFIC USER NAME)
The Network File Share destination delivers the output media file to a shared 
folder on your network that requires a specific user name and password, distinct 
from the user name and password used by Factory.MAP service.
The Network Share destination uses Windows networking.

Table C–4. Local Drive or Network Share Destination Parameters 

Parameter Description

Windows Computer Name localhost for local drive, or Windows computer name for network share.

Browse When checked, sets server identity to localhost

Note
The service must be running under an account that has sufficient 
privileges to access the target server on the local network. The Network 
Share destination uses Windows networking.

Table C–5. Network File Share (Specific User Name) Destination Parameters 

Parameter Description

Windows Computer Name localhost for local drive, or Windows computer name for network share

User Name A valid user name permitted connection to the server

Password The password required to connect to the server
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destination C-4

M

machine ID, for obtaining license 3-23
MAP

architecture and inter-operation 1-3
basic configuration tasks 4-1
components of, generally 1-10
configuring for Web access 6-10
dongle, updating 3-24
hardware requirements 3-3
installation. See installing. 2-2, 3-2
ports used 1-4
restart settings 4-5
roles in 1-2
service alerts, creating 5-3
software requirements 3-4
software versions, determining 5-2
supporting software 3-5
system alerts, configuring 4-5
using HyperLaunch Receive Server with 6-12
Web Client Service, requires IIS 3-6

MAP dongle, required for operating MAP 2-3
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MAP Explorer
generally 1-14
installing 3-25

MAP management console
using 4-10

MAP Quick Review
installing 3-28

MAP Seach
configuring for live feeds 3-34

MAP Search
default URL 1-16
enabling features 3-33
generally 1-16
installing 3-31
listing servers in 3-33
URL required for access 3-33

MAP services
connecting to management console 5-3
volume partitioning requirements 2-1, 3-1

MAP services, managing 4-2
MAPreview

multi-server planning 7-1
repairing 8-2
uninstalling 8-3
upgrading 8-2

MAPreview server
unpacking, locating, installing 2-2

MAPreview, pre-installed, configuring, generally 2-1
media

archiving 5-33
automatically creating different versions 5-29
restoring 5-33
restoring with Archive.MAP 5-33
watermarked, no dongle A-1

Media 100 NLE
QuickTime Motion JPEG B use when delivering 

to B-5
media folder

access properties 4-14
Access properties of 4-14
accessing from Web browser 6-10
authentication properties 4-14
Authentication properties of 4-14
creating 4-12
expiration properties 4-16
Expiration properties of 4-16
General properties of 4-13
metadata properties 4-18

Metadata properties of 4-18
Notify properties of 4-17
properties, configuring 5-28
properties, generally 4-13
storage properties 4-15
Storage properties of 4-15
versions properties 4-17
Versions properties of 4-17

media formats
supported in MAP B-1

Media Player
version 9 or 10 compatible 3-4

media portal
General properties of 4-36

media portal, creating 4-33
media portals

defined 1-12
media versions, creating new 4-17
media, accessing by clients 1-5
metadata

can't view after capture A-3
Metadata properties

of media folder 4-18
metadata, setting up for channel 4-27
Microsoft Recognition Engine 5-24
monitor accounts, in Gateway.MAP 6-19
movie codecs

specifications B-1
MPEG1 System Stream Media

specifications B-17
MPEG2 Program Stream Media

specifications B-18

N

network configuration, tasks when installing 3-7
Network File Share

destination C-4
Network file share (different user name and password), 

configuring 4-35
Network Location Wizard 4-33, 6-9
Notify properties

of media folder 4-17

O

Omnibus, As Run logs, using 5-22
operating temperatures 2-2
Osprey 440, supported by MAP 1-11
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Osprey audio driver, binds on remote sessions 5-10

P

physical stores
accessing media via 1-6

Pipeline
adding to LAN 2-3, 2-4

Pipeline SC
locating for operation 2-2

Player.MAP
generally 1-14

playlists 1-10
ports used in MAP 1-4
protocols, supported 4-38
publishing point

playlist for 1-10
publishing point, creating for WMS 6-2

Q

Quick Review
generally 1-15

QuickTime B-5
fast start option B-7
installing 3-5, 3-18
media key feature utilized B-7
Motion JPEG B format used with Media 100 B-5
movie Codec specifications B-5

QuickTime 7, not compatible with MAP 3-5
QuickTime Media

specifications B-2

R

ratings
capturing metadata, generally 5-18
configuring Capture.MAP to extract 5-22
INI files for 5-18

Ratings Configurator, using 5-18
Ratings Parser

generally 1-12
Real Networks Media

specifications B-8
Registry Editor, using to update entries 5-31
RemoteUpdateClient, using to update dongle 3-24
restart, settings recommended for MAP services 4-5
roles in MAP 1-2
RSA key, using with HyperLaunch Receive Server 6-13

S

schedule
creating and configuring 5-15
daily 5-16
exactly 5-17
monthly 5-17
never 5-17
types of 5-16
weekly 5-16
yearly 5-17

schedule, setting for channel 4-22
Secure HyperLaunch Receive Server

destination C-3
segment

Capture properties of 4-26
General properties of 4-26
Labels properties of 4-26

server side playlists 1-10
service

marked unavailable A-4
not accessible A-5

service alerts, creating 5-3
Services window

using to start and stop MAP services 4-3
Settings tab A-2
speech recognition, enabling 5-25
startup type, setting for MAP services 4-4
storage depot

creating 4-20
physical and alias locations, generally 1-8

Storage properties
of media folder 4-15

store
adding to Capture.MAP 5-14

streaming media 1-6
streaming media server 1-8
support 1-1
surge protector, recommended 2-3
system alerts, configuring 4-5

T

technical support 1-1
Telestream

contacting 1-1
International 1-1
Web site 1-1

temperature, operating requirements for 2-2
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time code, burning in 5-25
transcoding 1-11
transcoding jobs

resubmitting 5-32
transcoding, maximum concurrent setting 5-31
troubleshooting

generally A-1
TV schedule provider, setting up 5-23

U

user accounts, required for MAP 3-7

V

Versions properties
of media folder 4-17

versions, of MAP, determining 5-2
video

can't view during capture A-2
codecs supported B-1
input, setting in Capture Settings 4-23

video codecs
specification B-1

virtual directories, configuring for IIS 6-3
virtual store

accessing media via 1-6

W

watermark
in media A-2

watermark,placed on media if no dongle present 3-23
Web access

creating aliases for 6-8
Web browser

using to access MAP 6-10
Web Client Service

requires IIS 3-6
Web Server (IIS), considerations 1-8
web site, Telestream 1-1
web.config file, configuring features with 3-33
WebDAV, generally in MAP 1-5
Window Media Service, configuring for MAP 6-2
Windows Media

specifications B-11
Windows Media 9 3-11

installing 3-5
Windows Media Encoder A-3, A-4, A-5

use to verify capture card A-3

Windows media Encoder 9 Series 3-5
Windows registry

cautions when editing 5-31
Windows Remote Desktop Connection, do not use with 

Capture.MAP servers 5-10
WMS 1-8

X

XML
ratings files 5-18
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